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The National Institute of Standards and Technology (NIST) uses its best efforts to deliver a high-quality 
copy of the Mass Spectral Libraries and to verify that the data contained therein have been selected on 
the basis of sound scientific judgment. However, NIST makes no warranties to that effect; and NIST 
shall not be liable for any damage that may result from errors or omissions in the Mass Spectral Libraries. 
 
Distribution of the NIST\EPA\NIH EI Library includes the current versions of MS Search, MS Interpreter, 
and Lib2NIST and the NIST Automated Mass spectral Identification System (AMDIS) program. 
Distribution of the NIST Tandem Library includes the current versions of MS Search, MS Interpreter, 
and Lib2NIST. 
 
Use of any NIST Mass Spectral Library is limited to a single computer accessible by no more than a 
single user at any one time. There is no restriction as to multiple copies in the same or multiple formats 
on the same single-user computer or to backup copies which are for management purposes and not for 
use on any other computer. In the event of an upgrade from a previous version of any Mass Spectral 
Library, that previous version of that Library may not be installed on another computer and used in the 
same time period as the upgrade. The previous version may continue to be used on the same single-
user computer on which the upgrade is installed. Both the EI and Tandem Library can be used on the 
same computer with a single version of MS Search. A separate License is required for both to be used 
on separate computers beginning with NIST 26. 
 
© 1987, 1988, 1990, 1992, 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2005, 2008, 2011, 
2014, 2017, 2020, 2023, 2026 copyright by the U.S. Secretary of Commerce on behalf of the United 
States of America. All Rights Reserved.  
 
No part of these Mass Spectral Libraries may be reproduced, stored in a retrieval system, or transmitted, 
in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the 
prior written permission of the distributor. Portions of this program are also copyrighted by Microsoft 
Corp. and © 1984–1996 FairCom Corporation. 

 
 

Microsoft is a registered trademark of Microsoft Corporation, and Windows is a trademark of Microsoft 
Corporation. ISIS is a trademark of MDL Information Systems, Inc. "FairCom" and "c-tree Plus" are 
trademarks of FairCom Corporation and are registered in the United States and other countries. All 
Rights Reserved. 
 
Certain trade names and company products are mentioned in the text to specify 
adequately the computer products and equipment needed to use this software. 
In no case does such identification imply endorsement by the National Institute 
of Standards and Technology of these computer products and equipment, nor 
does it imply that the products are necessarily the best available for the purpose. 
 
A License to either of the NIST Libraries is only available through Authorized NIST Distributors. A current list of 
these Distributors can be found at: https://chemdata.nist.gov/dokuwiki/doku.php?id=chemdata:distributors. 

Users of any previous version of a NIST Library can purchase an upgrade to that Library license through one of 
these Distributors. Each Distributor sets their own price.  
 

https://chemdata.nist.gov/dokuwiki/doku.php?id=chemdata:distributors
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New Features in NIST 26 Libraries & the MS Search Program 
NIST 26 Libraries 

The 2026 version of the NIST /EPA/NIH Electron Ionization (EI) Library includes two main mass spectral 
libraries, along with a database of GC methods and retention indices. In addition, the Tandem Library 
contains three separate libraries. 

Contents of the NIST 26 Mass Spectral Libraries* 
Library Name Library Description Library Contents 

mainlib Main EI MS Library 382,180 compounds, 10.1% increase 

replib Replicate spectra Library 49,095 Alternate spectra of compounds 
in mainlib, 9% increase 

nist_ri Retention Index/GC Method 
Library 

527K values for 216K compounds 
(188,198 in mainlib) 

hr_nist_msms Accurate-mass Tandem Library 
of small molecules 

2,639,049 Accurate-mass Tandem 
spectra for 66,782 compounds 

lr_nist_msms Low-resolution Tandem Library 
of small molecules 

573,673 Low-resolution Tandem 
spectra for 66,566 compounds 

apci_msms_nist Library for ‘Extractables and 
Leachables’ 

6,403 Accurate-mass Tandem spectra 
for 623 compounds 

* The spectra from the former biopep_msms_nist library (available in previous releases) were reorganized 
into the hr_nist_msms and lr_nist_msms libraries with the NIST 23 release and continue to be organized 
this way. 

Overview: 

• The first two libraries (mainlib and replib) include EI spectra with corresponding chemical structures and 
metadata.  

• The nist_ri database provides GC methods and gas-phase retention indices.  
• The remaining three libraries contain Tandem (MS/MS) spectra with molecular structures and acquisition 

details. 

Since the 2020 release, all libraries have expanded at a rate comparable to the growth observed in NIST 23. The 
NIST/EPA/NIH EI Library has increased by 35,079 Compounds, with a proportional increase in the GC 
Method/Retention Index Database. The Tandem Library has had a significant increase in coverage, now including 
68,635 compounds, including 3.2 million spectra (low- and high-resolution) derived from 567K precursor ions in both 
negative and positive modes. 

As was the case with the previous last three releases, most new spectra were 
measured at NIST based on their analytical importance and then evaluated by at 
least two evaluators with the aid of newly developed software. 

There is an increased display of chirality in the structures. Over the last several 
releases of the NIST Libraries, more structures have been provided with chirality. 
Increased chirality also brought about the introduction of the cross-double bond 
used for the representation of unspecific E/Z configurations (see figure at left). 

What's New in MS Search Program v.4.0 
The following features are added to the current version 4.0 (2026), distributed with NIST 26. 

• Chromatogram tab view has been added allowing for the processing of GC/MS, or LC-MS/MS [DDA (Dynamic 
Data Acquisition, aka Data Dependent Analysis)] data files including automatic deconvolution and identification, 
based on comparison of components with the NIST Libraries using AMDIS for GC/MS and the NIST 
Mspepsearch for LC-MS/MS. Multiple controls are available to filter identifications to focus on the most relevant 
results. Each hit is identified in the chromatographic display and provided with a range of relevant data. 

• Chromatogram Analysis values include Purity, multiple score types, signal to noise, relative abundance, and 
agreement with isotope abundances (Tandem only). 
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• In addition to the devolution of LC-MS data, the chromatogram tab view can perform deconvolution, 
conventional identification, and the hybrid search, simultaneously. 

• The Hybrid Search has been updated to report the most chemical difference between the searched spectrum 
and each library compound (dForm) along with relative likelihood of each dForm. 

• For the Hybrid Search (EI Only), the Retention Index (semi-standard non-polar columns) differences between 
the searched spectrum and library compound are estimated (dRI) as well as the differences in observed and 
estimated retention index values (ddRI). 

• Retention Index (EI only) differences and their resulting score corrections are computed for each library Hit, 
using AIRI estimates for library compounds without experimental values. 

• When searching an individual EI spectrum that is of a TMS derivative, the search can be constrained to reject 
compounds containing OH or NH with no TMS derivatization, reject all TMS derivatized compounds, or not to 
filter TMS derivatives. 

• Addition of the XICanalyzer program for use with Tandem Spectrum Type in Chromatogram tab view.  

• Redesigned dialog boxes making the ability to change various display aspects easier. These too are Spectrum 
Type Specific. 

• A number of NEW column Headers have been added to the Hit List windows. 

• A Show Structure option has been added to the View menu which will display the structure of the currently 
selected Hit in a floating window, easily turned on and off. 

• Several features added to the Right Mouse Button (RMB) menu for selected spectra. 

• Switching to the matching name entry of the library identification in the Name tab of the current library 

• Exporting selected spectra to an Excel-compatible *.TSV file or to the Windows Clipboard 

• Penalize rare compounds added for scoring based on a new algorithm (Compound Ubiquity with respect to 
non-mass spectrometry databases) 

• Some Main Menu items have been moved. Exploring is recommended. 

Additional Information on the NEW Features of MS Search v.4.0 can be found at (https://mzinterpretation.com/). 

What was New in Version 3.0 of the MS Search Program 
The following features were added to the version 3.0 of MS Search, distributed with NIST 23. 

• Major Spectrum Type choice (EI, Tandem, Peptide, All) helps to suppress display of search parameters most 
probably not used. 

• Name search has been improved by increasing search field from 16 to 249 characters; the list of names has 
been split into two windows: compound list in the upper window and spectra list in the lower window. 

• The list of Other Databases (non-mass spectra) was significantly extended. 

• NEW. A Partial Spectrum Search method was added. 

• AI estimated RI are displayed in EI Hit List and is used for EI search with RI Match Factor correction instead 
of missing semi-standard non-polar RI in a Hit. 

• Hovering a mouse pointer around a peak in a spectrum plot displays peak annotation.  

Changes 
• Term “In-source/EI with accurate ion m/z” replaced with “HiRes No Precursor”. 

• “Penalize rare compounds” EI library search option has been retired. 

• Clicking the InChIKey in the Text Information window takes you to an Internet Google Search rather than to 
PubChem. 

https://mzinterpretation.com/
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New Features MS Search Program v.2.4 
Since the release of Version 2.3 with NIST 17, no substantial changes were made to the fundamental Search Routines. 
There have been several display changes which allow for better control of the display of Hit Lists and the handling of 
the many Tandem spectra that can be associated with a single compound. 

• Names and orders of some library searches have been changed 

Identity Search Similarity Search 
NIST 20 NIST 17 NIST 20 NIST 17 

EI Normal* Quick* EI Hybrid Hybrid 

EI Quick Normal EI Simple Simple 

MS/MS MS/MS EI Neutral Loss Neutral Loss 

In-Source Hi Res In-source Hi-Res MS/MS in EI MS/MS in EI 

  MS/MS Hybrid MS/MS Hybrid 

* It is important to note that the Normal search, NOT the Quick search, is the default EI Identity Search. This 
may cause a difference in Hit List between NIST 20 and older versions for the same search. 

EI searches are strictly unit mass resolution and MS/MS (Tandem) searches allow the specification of high mass 
accuracy peaks. 

• Tandem Mass Spectra Filtering for all Hit Lists (Spectrum and Other Searches) 
The NIST Tandem Library contains spectra over a range of energies, precursor types, and fragmentation 
methods. This means that a search of the Tandem Libraries can produce many Hits generated from a single 
compound, which can be tedious to sort through. To facilitate this task, a filtering process is available that can 
easily control the types of spectra shown in a Hit List. This is invoked by pressing the filter ( ) button in the 
Button Bar above the Hit List showing results. This is available for both the Lib. Search and Other Search 
tab views. The filtering process may be turned on and off with the control at the top of this dialog box (below). 
When the filter is enabled, the  button will appear to be pressed. Upon pressing OK, the Hit List will reflect 
the selections in this dialog box. These controls match those in the Constraints section; except they do not 
permanently remove hits – all original hits can be seen by turning off the ‘Enable Filtering’ checkbox. This filter 
has no effect on EI searches. (Figure 1) 

• Corresponding changes are made in Constraints used when searching Tandem Libraries.  

 
Figure 1. Tandem Hit List Filter Used to Limit Hits Displayed from Library and  

Other Searches Only Applicable to the Tandem Libraries. 
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Enhancements to Utility Programs Since NIST 11 
Mass Spectral Interpreter has significantly evolved over the past three years. There was a major release in April of 
2020 that included a considerable number of enhancements from earlier versions. The major areas involve mechanisms 
and their relative rates for fragmentation of all types of ions (EI and Tandem MS, both positive and negative; integer and 
accurate mass) as well as various interface enhancements. This program connects mass spectral peaks to their probable 
chemical structure origin and can be quickly invoked from the NIST MS Search Program with the F9 key. 

New Features in MS Search v.2.3 Released with NIST 17 
Following Version 2.2, distributed with NIST 14, several important features were added to the NIST Mass Spectral 
Search Program. These are summarized below. 
Features Relevant to Electron Ionization Mass Spectra (Low Resolution) 

• A new EI Hybrid Search (Similarity/EI Hybrid). 

• Presearch for EI Similarity/Neutral Loss search 

Features Relevant to All Mass Spectra 
• InChIKey presearch for all Library spectrum searches (finds all spectra, which have the same first InChIKey 

segment as the search spectrum, and compares them to the search spectrum) 

• When a spectrum is associated with a structure in the Spectrum Information dialog box of the Librarian tab 
view, the InChIKey is automatically associated with the spectrum.  

• Columns in any Hit List can be positioned as desired. 

• Update list of libraries may be performed without exiting MS Search 

• Indexing old libraries for EI Hybrid, EI Loss, HiRes MS/MS Hybrid, HiRes Any-peaks Peak and Loss searches, 
and InChI presearch. This includes third-party libraries like the Wiley Registry.  

Features Relevant to Tandem and High-Resolution Mass Spectra 
• HiRes MS/MS Hybrid Search 

• Types of Any Peak Search: HiRes peak and HiRes loss 

• Display additional MS/MS information in Hit Lists 

• Edit accurate peak m/z, intensities, and peak annotations in the built-in mass spectrum editor 

• MS/MS Precursor m/z search 

• Precursor type constraint 

• Ion polarity filter 

New Features in MS Search v.2.2 
The following features were added to version 2.2, distributed with NIST 14 as compared to ver. 2.0g, distributed with 
NIST 11 or with NIST 12 Tandem Library. 

Features Relevant to Electron Ionization Mass Spectra (Low Resolution) 
• Use of Retention Index in library searching: Deviation of experimental RI from the library value optionally used 

to penalize the Match Factor. 

• Older user libraries with RI values can be indexed to allow the RI values to be used in library searching 

• Display RI values in a Hit List column 

• Import, export, and edit compound RI value(s) 

• New definitions of derivatives are used for finding replicate spectra  

• Optionally display derivative precursor in the Lib. Search Hit List 
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Features Relevant to All Mass Spectra 
• All small molecule mass spectra in NIST libraries have InChIKey(s) linked to PubChem (NIH). These 

InChIKey(s) may also be used for searching compound information on the Web or for exact structure searches 
within NIST libraries. 

• Set Prepend/Overwrite/Ask automatic mass spectrum import option. 

• Import and display Glycan structures in KEGG Chemical Function (KCF) format and add them to user library 
mass spectra.  

Features Relevant to Tandem and High-Resolution Mass Spectra 
• Display additional MS/MS information in Hit Lists 

• Edit accurate peak m/z, intensities, and peak annotations in the built-in mass spectrum editor 

• In-source tandem spectra or EI with accurate m/z spectra - High resolution mass spectra 
o Import of ‘in-source/EI with accurate m/z’ spectra, which does not include a defined m/z of the precursor 

ion. To import these spectra, select "In-source /EI (accurate m/z)" in Spectrum Import Options.  
o In-source/EI with accurate m/z spectra have accurate ion peak m/z and intensities. The accuracy is set in 

Spectrum Import Options.  
o In-source/EI with accurate m/z spectra may be searched in In-source/EI with accurate m/z and/or MS/MS 

library with the new In-source HiRes search (ion peak m/z tolerance down to 0.015 ppm or 6x10-5 m/z 
units), Similarity Simple, Identity Normal or MS/MS Presearch OFF search options. For this purpose, 
adding Reverse Search option may be useful.  

o In-source/EI with accurate m/z spectra may be added to a user library. Currently, in-source/EI with accurate 
m/z spectra added with NIST MS Search to a user library may be searched with In-source HiRes search 
only with Presearch OFF option. Rebuild the library with Lib2NIST to get in-source HiRes search benefits1.  

• A new MS/MS search for small molecules 

o Improved ability to identify compounds with a few dominant peaks – a common situation for Tandem MS.  
o More robust scoring for spectra acquired on imperfectly tuned instruments  

• New Mass Spectrum Import Options  
o Control the number of decimal places in the input m/z  
o Set peak intensity threshold  
o Import in-source or EI spectrum with accurate ion peak m/z and intensities.  
o Import MS/MS and in-source/EI with accurate m/z spectra from JCAMP files (October 2012, nistms32.dll 

version 2.1.5.3 or later)  

GC Methods / Retention Indices Database in NIST/EPA/NIH EI Libraries 
The NIST GC Methods/Retention Indices database introduced in NIST 05 continues to be expanded with new entries 
for existing spectra as well as entries for newly added spectra. When spectra are measured by NIST, they are only 
added if RI data is available as part of the measurement. 
In NIST 17, the GC Methods/Retention Indices library was extended by including summary statistical analysis of all data 
in the record. This information will not be displayed in the spectrum Text Information window if the GC Retention 
Indices box on the Hit List Info page of the Library Search Properties’ dialog box is not selected. The summary data 
are given in terms of the type of column (standard non-polar (DB-1), semi-standard non-polar (DB-5), or polar 
(carbowax)), the median value of the retention data for that column type, the deviation, and the number of experimental 
determinations. Note the deviation is calculated as the median absolute deviation. In the example below (for 6,6-
Dimethyl-2-methylene, bicyclo[3.1.1]heptan-3-ol or pinocarveol), there are 13 values for the DB5 series of data, 9 for the 
DB 1 and 12 for the polar column with median absolute deviations of 4,7 and 8, respectively. 

Experimental RI median±deviation (#data)  
Semi-standard non-polar: 1138±4 (13) 
Standard non-polar: 1135±7 (9) 
Polar: 1654±8 (12) 

 
1 Library searchable with In-source HiRes search has files peak_em0.inu and peak_em0.dbu 
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The averaged data will also optionally be shown in the Hit List of the Lib. Search tab view based on the column type 
selection on the RI(GC) page of the Library Search Properties dialog box. This selection also determines what is 
optionally displayed in the Hit Lists of the Other Search tab view when the Spectrum Type is EI. The column position 
for the RI values is user selectable. 

NEW to the Hit List in v.4.0 of MS Search (NIST 26) of the Lib. Search tab view is dRI. This is the difference between 
the average of the database values and that associated with the searched spectrum. 

The Retention Indices checkbox controls the display of detailed experimental data. The number of GC 
Methods/Retention Indices displayed is controlled by selecting All or First and entering the number of values to be 
displayed in the properties dialog box. The default is to display the first 2 values. Displaying all values may cause the 
display to be slow if there are a very large number of method values. 
In addition, for most compounds, values are shown using two theoretical methods: 
1) Estimated retention index is displayed based on the structure associated with the spectrum. This is based on a 

chemical group additive approach. These values are reported in linear alkane retention index units (iu) with a 
confidence interval, e.g., “Confidence interval (Ketones): 57(50%) 246(95%) iu” reported for acetone. This means 
that there is a 50% probability that the true value falls within 57 iu of the estimated value and 95% of the time the 
true value falls within 246 iu of the estimated value. The analysis is based on error measurements of all the data for 
the class of the compound given, in this example, ketones. These estimates are only shown if Retention Indices 
are checked in the properties box. The estimates are not displayed in the Hit Lists. If spectra in a user-library have 
associated structures, this Estimated RI value will also be listed for these spectra if the calculation is possible.  

2) AI predicted semi-standard non-polar retention index values from a newly developed approach by NIST scientist 
Lewis Geer are also shown. These predicted non-polar linear alkane retention index indices [1] are more accurate 
than the Estimated non-polar values provided for NIST/EPA/NIH EI Library spectra in this and previous releases as 
well as user-library spectra with associated structures. AI estimated values are NOT available for user-libraries with 
structures. The AI values were calculated for semi-standard non-polar (DB-5) columns and are expressed in index 
units (iu). These indices are generated by feeding the chemical structure of compounds into a path-augmented graph 
transformer network [2]. This network was trained on experimental retention indices from the NIST EI Library, minus 
a test and validation set. The test set was used to estimate 50% and 90% confidence intervals for all compounds 
that have predictions. AI Retention Index values have been estimated for all the compounds with EI spectra in 
NIST 23. 

If the semi-standard non-polar column is selected on the RI(GC) page of the Library Search Options dialog box and 
there are no experimental values for the compound, the AI predicted semi-standard non-polar retention index value will 
be reported. This is indicated with an (*) following the value. No values for other column types result in no value reported. 

References:  
[1] Kováts, E.: Gas-chromatographische Charakterisierung organischer Verbindungen. Teil 1: Retentionsindices 

aliphatischer Halogenide, Alkohole, Aldehyde und Ketone. Helvetica Chimica Acta 41(7), 1915{1932 (1958). 
doi:10.1002/hlca.19580410703  

[2] Chen, B., Barzilay, R., Jaakkola, T.: Path-Augmented Graph Transformer Network (2019). 
https://arxiv.org/abs/1905.12712  

The NIST Tandem Library  
Tandem spectra, along with an increased number of fields relevant to data obtained using MS/MS, are provided in three 
separate libraries (high res [hr_nist_msms], low res [lr_nist_msms], and APCI [apci_msms_nist]). Most of the spectra in 
these libraries have been measured at NIST, though some have been acquired from other sources. The preparation of 
the Tandem Library revealed that at sufficiently high signal-to-noise measurement conditions, modern instruments can 
provide very reproducible “library-searchable” spectra. Although collision energy is an important variable in collision cell 
instruments, spectra vary in an understandable way depending on the compound and instrument type as well as 
collision-energy conditions. Energy-dependent variation is accounted for by including spectra, for most compounds, over 
a wide range of collision energies, ranging from slight to complete dissociation of the precursor ion. The Score reported 
for the best matching spectrum is used for identification (use the Best matching only button to show only closest 
matching spectra).  
The MSMS tab view, included in previous releases, has been discontinued. The tandem mass spectra are treated like 
spectra found in any NIST MS Search Program compatible Library. Simply select the NIST library or libraries you want 
to search for CAS#, Formula, molecular weight range, etc. All that is necessary is to include the appropriate library or 
libraries in the Include Libs section of the Search dialog box for the Other Search tab view or as the single library to 
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be searched in the Incremental Name Search. The Library Spectrum Search and Structure Similarity Search are 
also applicable. One of the challenges when looking at the tandem ion mass spectra for a given compound is that there 
can be several different precursor ions for that compound and spectra for several different collision energies. Some 
filtering can be done with the Tandem Filter feature that has been added. This filter is not available when searching by 
name. 
It is important that the user understand that tandem spectra in general are different from EI spectra as well as the fact 
that structures in the MS/MS Library refer to the form of the compound before the precursor ions are formed. It should 
also be noted that the integers in the MW field of the Text Information window for the spectrum are the nominal (integral) 
mass of the neutral molecule. The Exact Mass field shows the monoisotopic mass.  
For beam-type instruments (e.g., triple quadrupoles, HCD, and Q-tof instruments), the MS2 designation in the Spectrum 
Type field refers to spectra generated by dissociation in a collision cell of a selected precursor ion. For ion trap 
instruments, the MS2 designation refers to dissociation in the trap after following the isolation of the precursor ion. 
In the case of data acquired using an ion trap mass spectrometer, there may also be data designated as MS3, and MS4 
spectra, which were obtained by the isolation of a precursor-ion for a subsequent iteration of MS/MS. 
As can be seen, there is a great deal more information provided in a text format for the spectra in the tandem libraries. 
The Library Spectrum Search and Structure Similarity Search are also applicable. Note that in all cases, the structure 
shown is that of the compound prior to ionization. 

More Information from the NIST Data 
A NEW feature has been added to MS Search v.3.0 by which 
hovering the Mouse pointer near a peak in a mass spectrum 
display will show the items selected in the Options section of the 
Plot tab Properties dialog box for display, e.g., m/z Label, 
Formula/y-b, and/or Loss/other in a box floating on the 
spectrum. 
This is especially advantageous for viewing spectra from one of 
the Tandem Libraries. Only the data for the selected items will be 
displayed. 
In an accurate m/z value Tandem mass spectrum, selecting only 
the m/z Label checkbox will cause the peaks to be labeled only 
with the accurate m/z value of the ion. Selecting Formula/y-b 
checkbox only causes the peaks to be labeled with the elemental 
composition of the ion. Selecting only the Loss/other checkbox 
results in a label that indicates the elemental composition of the 
neutral loss from the precursor ion, e.g., p-C15H28, where p 
represents the precursor ion. 
Figure 3 is an illustration of the selection of all three checkboxes. 
In order to have this information displayed, it had to be entered 
at the time the mass spectral record was created. 

 
Figure 2. Plot tab view of the Name Search 
Properties Dialog Box as is in Version 4.0. 
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Figure 3. Mass Spectrum from the NIST 26 Tandem Library Showing Hover Display for Unlabeled Peak. 

Software Changes from earlier versions of the MS Search Program 
Version 2.0g of the MS Search Program (NIST 11) 
Below is a list of features new to the previous version, 2.0g, which was distributed with NIST 11 and the NIST 12 
Tandem Library. 

• A new Exact Mass Search allows searching for exact mass of a precursor (exact molecular weight) using its 
mass or exact m/z of a product ion. It considers the presence or absence of an electron, adducts or losses; 
accepts uncertainty in ppm or millimass units; and allows searching for isotopic or monoisotopic peaks. 

• A new Exact Mass Constraint similar to Exact Mass Search. 

• Ability to use accurate mass to search exact fragment ion mass values in NIST libraries using the Any Peaks 
Search. 

• Display of the exact mass with any spectrum that has an associated chemical formula. This even works for low 
resolution EI peaks – these are processes using the separate MS Interpreter formula to assign chemical formula 
to most peaks. 

• Manage and search as many as 127 separate MS libraries instead of 16, which was the limit in previous versions. 

• Optional display of columns in Hit Lists containing the number of synonyms and the number of Other Databases 
in which the Hit appears. The Hit List can be sorted according to the values in these columns. 

• Full compatibility with the most recent NIST Peptide MS/MS Libraries. 

• Copy selected lines from Hit List or Spec List into Windows Clipboard as tab-delimited Unicode text; this may 
be conveniently pasted into Excel. 

• Spectra in the MSP text format can be imported from the Windows Clipboard into the Spec List via a Right Mouse 
button (RMB) menu option. 

• Searching for words in mass spectrum Text Information Window. 

• Optional exclusion of Homologues from the results of Structure Similarity Search. 

• Import spectra from mzXML and mzData files. 

• Multiple CAS Registry numbers for a spectrum. A small fraction of spectra in NIST 14 has more than one CASrn. 
Each CASrn may be used in a CASrn Search. 
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• The MS Interpreter program now enables high mass accuracy for both molecular ions and product ions. 

• An alternative peak matching method using ‘time warping’ was implemented to better match peaks in noisy 
MS/MS spectra. 

• Several convenience features.2 

Version 2.0f of the MS Search Program (NIST 08) 
Below is a list of features new to the previous version, 2.0f, which was distributed with NIST 08. 

• A new spectrum search for MS/MS spectra in MS/MS libraries, including the NIST MS/MS libraries. 

• Spectra of stereo isomers, tautomers, and derivatives are displayed as replicate spectra. 

• Tags (which can function as Field Names) can be entered into the “Comments” field of a user library along with 
the Field contents. 

• Hit List can be sorted alphabetically. 

• Five new Constraints have been added: Tags in Comment, Peptide Sequences, Peptide Mobile Protons, 
Peptide Charge, and Peptide Number of Residues. Tags in Comment Constraint, for example, allows 
searching for the name of the contributor in the EI Library. 

• A search for information in the “Contributor/Comment” field, which may be particularly useful for certain types of 
information relevant to MS/MS. 

• Flexibility has been added to searches using a “Name Fragment in Constraints”. It is now possible to specify the 
presence or absence of any arbitrary part or parts of a name. 

• The Program does not use or require the installation of special NIST fonts. 
  

 
2 New convenience features added to version 2.0g including: 

• Default view of Constraints and Other Searches dialog boxes changed to provide more convenience to the 
users. 

• Ability to Sort the Spec List alphabetically, by number of Synonyms, by number of Other Databases. 

• Toggle between Tab views (Lib. Search, Other Search, Name, Compare, Librarian, and MSMS Windows) 
using Ctrl-Tab or Ctrl-Shift-Tab. 

• When a Tag from the “Comment” field is displayed separately, its display in the “Comment” field is suppressed. 
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OS Compatibilities 
• The NIST Mass Spectral Search Program, Version 4.0 is ONLY COMPATIBLE with the 64-bit versions. 

• MS Search v.4.0 is a 64-bit Unicode application that requires Windows Vista, or Windows 7, 8, 8.1, 10, 11.  

• Adobe PDF reader is required to access the NIST 26 Manual.  

• MS Search v.4.0 has only been tested with Windows 10 and Windows 11. 

• It is best to turn off the custom scaling level feature of Windows 10 and 11 as issues may be observed. 
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Notes On Installation 
The installation program for the Tandem and EI versions of NIST 26 has different appearances. 

The Installation Program does not create any Desktop or Taskbar icons. To run MS Search the first time, select the 
Windows icon on the far left of the Button Bar right after running the installation. The display will have an icon for MS 
Search at top left. Select this icon to run MS Search for the first time. This will place an icon for MS Search in the 
Taskbar. This will cause the icon for MS Search v.4.0 to be displayed. Put the Mouse pointer on the icon; click the Right 
Mouse button once. This will display an RMB menu. Select Pin. The icon is now pined to the Taskbar. 

To create a Desktop icon, select the windows icon on the lower left of the display put the Mouse pointer on the NIST 
icon at the top of the display and drag it to the Desktop. 

Nota Bene:  
Each individual tab view has a Main Menu. Each Main Menu has a File selection. 
Each File menu has a Select Spectrum Type option. If only one of the two 
available library types (EI or Tandem) is installed, the Select Spectrum Type 
option will remain perpetually grayed (unavailable), as shown in the figure on the 
right. Once the other library (EI or Tandem) is installed, this option becomes 
available. 

When MS Search is first run, the default display is the Lib Search tab view. The Spec List 
window (upper-left) will be populated with individual spectra that can be searched. There are 
12 in the EI installation and 26 in the tandem installation; the first 12 of which are also included the EI installation. 

 

 Spec List window for EI Installation 
  
 
 
 

Spec List window for Tandem Installation 

Example data files are provided for the examples included in this manual. These data files are found in the 
C:\NIST26\MSSearch\test-files\ folder. This folder will contain an \EI folder and a \tandem folder depending on the 
installation performed. The \EI folder has both a hi-res\ and a \low-res\ folder. The \low-res\ folder has two GC/MS data 
files. The C7-40.D file is used to create a calibration file. The other file (Hemp-flower-DCM-conc.D) is used to 
demonstrate the capabilities of the Analysis EI Input File selection of the File menu displayed by selecting File from 
the Main Menu. The \hi-res\folder contains two CDF files. One is for RI calibration and the other (SRM3268-Kudzu.cdf) 
is for demonstration purposes. There are also EI GC/MS Data files in the C:\NIST26\AMDIS32\ folder. 



  

NIST  26 MS Libraries and Search Program v.4.0 Page 13 

The \tandem\ folder contains the For_ToxMix_ASMS.msML and NTBLS2956_AC_01_PP_1.mzML LC-MS/MS data 
files for use with the Analyze MS/MS Input File selection of the File menu displayed by selecting File from the Main 
Menu. 
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Installation 
Windows 10, 11 
NEW INSTALLATION on a computer that does not have a previous version of NIST Mass Spectral Data or software. 
NIST 26 is provided with two different installations: 

NIST 26 EI Installation which includes 
NIST MS Search Program. (c:\nist26\mssearch) 
NIST 26 NIST/EPA/NIH Electron Ionization Library (c:\nist26\mainlib and c:\nist26\replib). 
Lib2NIST Converter (c:\nist26\mssearch). 
MS Interpretation Program (c:\nist26\mssearch). 
GC/MS Analysis Program (c:\nist26\amdis32). 
GC Method\Retention Index database (c:\nist26\nist_ri). 

The NIST 26 Tandem Library 
NIST MS Search Program. (c:\nist26\mssearch) 
NIST 26 MS/MS HiRes Library (c:\nist26\mssearch\hr_nist_msms), Windows 10 or 11; 64 -bit Only. 
NIST 26 MS/MS LowRes Library (c:\nist26\mssearch\lr_nist_msms). 
NIST 26 MS/MS APCI Library (c:\nist26\mssearch\apci_msms_nist). 
Lib2NIST Converter (c:\nist26\mssearch). 
MS Interpretation Program (c:\nist26\mssearch). 

Each of the above installations is provided on its own media. The NIST 26 EI Installation media installs the NIST 
software and the EI Library on a single computer. The NIST 26 Tandem Installation media installs the NIST software 
and the Tandem Library on a single computer. These two installation programs have different appearances and perform 
somewhat differently. 

If both the Tandem and EI Library will be used on the same computer, with a single version of MS Search, it is 
recommended that the EI Installation be done first. This will be followed by the Tandem Installation. Run the Tandem 
Installation as if it was being used as a standalone. This will overwrite some components that were installed with the EI; 
however, it ensures that all components of both installations are installed. If both libraries are installed on a single 
computer, the license prohibits installing either Library on another computer. 

To install the NIST Software and the desired Library from the NIST 26 EI or the NIST 26 Tandem installation media, it 
is only necessary to run the SETUP.EXE program and accept the defaults. 

• Open Windows Explorer and navigate to the location of the NIST 26 installation. This may be a folder, a CD drive, a 
USB drive, or in a folder on your computer, if you have done an FTP download of the installation.  

• In the folder or on the device which contains the NIST 26 install software, highlight SETUP.EXE and double-click the 
left Mouse button to run the program. Depending on your computer settings, you may not see the EXE extension 
when using Windows Explorer. If this is the case, there are as many as three different files with the name SETUP, 
each having a different extension. Make sure the one with Application in the Type column is selected. 

• Follow the instructions presented by the SETUP.EXE program.  
• If installing the EI Version on a new computer, the NIST/EPA/NIH MS Library and 

AMDIS Setup dialog box will display the two dialog boxes (Confirm New Folder), 
sequentially overlaid, shown at the right, asking to create the 
C:\NIST\MSSEARCH\ and C:\NIST26\AMDIS32\ folders. Select the Yes button for 
both.  

• There will be a dialog box asking if you want to Copy or Link existing libraries. If 
this is a new installation on a new computer or an upgrade where user-libraries 
were backed up, there will be no existing libraries, select the Next button. 

• If performing an EI Installation and the Agilent ChemStation Data Analysis software 
is on the computer, the next dialog box asks if the NIST Seach should be the default 
search, retain the PBM search, or do nothing. It is recommended to select the NIST 
Search (the default if the Next button is selected). 

• The Select Program Folder dialog box is displayed next prompting to enter a Program Folder Name. The Default is 
NIST Mass Spctral Database. It is recommended that this name be edited to something similar to NIST 26 Mass 
Spectral Database or NIST 26 Mass Spectral Library. 

• Allow the Setup.exe to continue, accepting the default for any further prompts. A dialog box will be displayed when 
the installation is complete. 

The Installer may behave differently under different versions of Windows due to User Account Control security features. 
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Upgrading from a Previous Version of the NIST Data and Software 
RECOMMENDED: If upgrading from a previous version of the NIST Library, there is no need to keep the previous 
version. First go to the \MSSearch\ folder of the previous version. This is usually in the c:\NISTxx\MSSearch\ folder, 
where xx is the version number of the previous version. Move any user-libraries (which are folders) to a secure backup 
location. The NIST Library folders for the previous versions (\mainlib, \replib, \ri_nist, or those listed for the Tandem 
Library) DO NOT need to be moved or backed up from the C:\NISTxx\MSSearch\ folder.  

BEFORE running one of the SETUP.EXE programs on the installation media, the previous version of the NIST Software 
and Data should be uninstalled using the Add or remove programs feature of Windows. 

If there are user-libraries (these are folders within the c:\NISTxx\MSSsrarch\ folder) to be retained, copy these to a 
different location. After the new version of the NIST software and Data are installed, they can be copied to the 
c:\NIST26\MSSearch\ folder. 

To uninstall the previous version, after backing-up any user-libraries to be saved, select the magnifying glass  icon in 
the Taskbar at the bottom left of the Windows Desktop. Type “Add” in response to the Type here to search prompt. 
When Add or remove programs appears (upper left of displayed dialog box, select it. In the resulting Window, scroll 
down until NIST xx MS EI and Tandem Library (or something similar) comes into view. Then select the Uninstall button 
to uninstall the previous version of the NIST software and data. If installing both versions, install the EI version before 
the Tandem version.  

After performing the uninstall, return to the c:\nistxx folder and delete this folder. You may have to delete the residual 
contents of the \mssearch folder and the \amdis32 folders inside the c:\nistxx folder to accomplish this total deletion. 
Now it is the time to install the distributed version of the NIST 26 Mass Spectra Data (EI or Tandem), MS Search, and 
its associated software.  

DISCOURAGED: It is possible to keep both the existing versions and NIST 
26. If the setup program finds a previous version of the MS Search program 
and the NIST Data, the Question dialog box on the right will overlay the NIST 
Setup dialog box. Read the contents carefully. If the Yes button is selected, 
the existing version MS Search and the NIST Data will be overwritten. The 
name of the previous version’s folder will be retained (e.g., \NIST14) and the 
contents of the previous version will be overwritten. If No is selected, no 
changes to the existing folder will occur and NIST 26 will be installed in the 
C:\NIST26 folder. If No is selected, prompts will appear to allow setup to 
create the C:\NIST26\mssearch and C:\NIST26\AMDIS32\ folder as in the 
case for a clean installation. If user-libraries to be retained were moved to a 
folder and the plan is to move them to C:\NST26\MSSearch after the installation is complete, this dialog box saying to 
Copy or Link  user-libraries by selecting them can be skipped by selecting the NEXT button. After the backed-up user-
libraries are copied to the C:\NIST26\MSSEARCH folder and MS Search subsequently started, all will be available. 

A new Program Folder should be created (selected) for the Start Programs shortcuts (see New Installation, page 14). 
The default name displayed when the Program Folder dialog box appears is NIST Mass Spectral Database and should 
be changed to something similar to NIST 26 Mass Spectral Libraries. If this is not done, the contents of the existing 
Program Folder, NIST Mass Spectral Database, will be overwritten, and the previous version of MS Search and its 
Libraries will no longer be accessible from the Start menu. 
Select the defaults for the remaining dialog boxes. 

INSTALLING THE TANDEM LIBRARY AFTER INSTALLATION OF EI LIBRARY 
Locate and run the SETUP.EXE program on the Tandem distribution media. The dialog box on the top right is displayed. 
Typical is selected by default. Select Custom, then select the Next button. From the displayed dialog box (below, right) 
deselect all items except for those associated with the Tandem Library. After selecting the Next button on this second 
dialog box, follow the prompts as they appear on subsequent displayed dialog boxes to complete the installation of the 
Tandem Library.  
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History & Evolution of NIST Mass Spectral Search Program 
The NIST Mass Spectral Search Program began in the late 1980s as an IBM PC DOS application. It was developed by 
Steve Stein at NIST, then the National Bureau of Standards (NBS), to allow users of the EPA/NIH electron ionization 
(EI) mass spectral library to recall spectra without needing to measure a compound’s spectrum and submit it to a search 
system to view its library spectrum with related data. At that time, instrument vendors’ data systems required users to 
measure a spectrum that closely matched a specific compound in the library before being able to view the reference 
spectrum. Most of these systems did not display chemical structures, a limitation that set MS Search apart early on. MS 
Search’s inclusion of structural displays and superior spectrum-matching algorithms made it more effective than many 
manufacturer-provided search tools. 

Around 1988, the National Institute of Standards and Technology (then NBS) assumed stewardship of the EPA/NIH EI 
mass spectral library, which contained spectra for approximately 45,000 compounds. Soon after, NIST began a 
comprehensive project to evaluate the existing spectra and collect additional data from donated sources. In the early 
1990s, NIST started measuring EI mass spectra and acquiring large datasets from organizations such as Chemical 
Concepts and the Japanese Mass Spectrometry Society. As the evaluation process advanced, features were added to 
the MS Search Program to support NIST’s internal data reviewers—features that also became popular with end-users. 

By 1994, NIST adopted a policy of including replicate EI spectra for frequently encountered compounds, a practice that 
continues today. 

In 1998, NIST released the first version of the NIST/EPA/NIH Mass Spectral EI Library (NIST 98) in which every spectrum 
had been evaluated by trained mass spectrometrists. This release also introduced AMDIS (Automated Mass Spectral 
Deconvolution and Identification System), a tool used to extract pure mass spectra from complex GC-MS data where 
compounds often coelute or are present at trace levels. 

The next major release, NIST 02, was initially accompanied by an updated DOS-based search program. Shortly 
afterward, a Windows version replaced the DOS interface. The data had expanded to 147,200 compounds, with 27,500 
additional replicate spectra. 

With the release NIST 05, a new era began. It included a library of product-ion (MS/MS) spectra derived from 
electrospray ionization (the NIST Tandem Library), along with a database of GC methods and retention index (RI) values 
from scientific literature. Many of the compounds in the RI database were represented in the EI mass spectral library. 
The MS Interpreter program was also introduced in this release, allowing users to correlate structural fragments with 
spectral peaks—an invaluable tool for both evaluators and end-users. 

Subsequent releases (NIST 08, 11, and 14) saw continued growth in both EI and tandem spectral data, as well as 
expansion of the GC Method/RI database. 

NIST 17 marked another milestone. It included a substantial growth in the number of spectra in both Libraries, a 
significantly updated version of MS Interpreter, now applicable to EI, product-ion, and accurate m/z spectra, and a Hybrid 
Search algorithm for both EI and MS/MS spectra, which modifies reference spectra to resemble query spectra when 
exact matches are unavailable. The algorithm identifies mass differences to help infer structural modifications. Statistical 
RI information, including average values, standard deviations, and citation counts for each column type were also 
introduced. 

NIST 20 brought further expansion of the EI and Tandem datasets and a new version of MS Interpreter, enhancing its 
utility for Hybrid Search users. 

By 2023, the MS Search Program had become increasingly complex due to diverging requirements for EI and Tandem 
data. MS Search v3.0 introduced a data-type selection system—EI, Tandem, or Peptide—allowing users to filter features 
based on the data they’re working with, reducing confusion, and streamlining the interface.  

Most search types had supported the display of multiple related spectra for a compound (e.g., from the EI replicate 
library, stereoisomers, or isotope variants); however, this was not the case for the Incremental Name Search. A 
significant improvement in NIST 23 was the improvement to the Incremental Name Search. When using NIST-provided 
libraries, all associated spectra are now displayed in a dedicated window below the Names List. This makes it much 
easier to view related compound spectra. NIST 23 also added a special names library for both low- and high-resolution 
tandem spectra, allowing name searches across all Tandem data regardless of resolution. 
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With the EI library growing more than tenfold since NIST assumed stewardship, finding new compounds to measure 
became challenging. Starting with NIST 14, a new acquisition strategy was implemented using the InChIKey 
(International Chemical Identifier Key). By comparing chemicals of interest across non-spectral databases and available 
commercial inventories, NIST identifies compounds to acquire and measure using MS/MS or EI techniques. Resulting 
spectra are added to the appropriate libraries, with associated GC methods and RI values for EI spectra. This approach 
contributed to an increase of over 40,000 spectra in the EI Library between NIST 20 and NIST 23, with substantial growth 
in the Tandem Library. 

Another key development in NIST 23 was the expansion of non-mass spectral database coverage. The number of 
searchable external databases grew from 9 (a number unchanged for over 30 years) to seven classes comprising 59 
generic titles. 

NIST 23 not only delivered dramatic growth in both EI and MS/MS data coverage but also introduced significant software 
improvements. 

NIST 26 represents the next major leap forward. It is now divided into two distinct products. One contains the 
NIST\EPA\NIH EI Mass Spectra Library and the other contains the Tandem Library. The Spectrum Type (EI, Tandem, 
Peptide, or All) is defaulted to EI or Tandem depending on the installation. Both the EI and Tandem Libraries are provided 
with software (MS Search and MS Interpreter).  

Much of the investigative use of NIST’s Data results from chromatography; either gas or liquid. A new feature in the form 
of a Chromatography tab has been added to the MS Search Desktop. This incorporates the features of AMDIS and the 
mzML file which contains LC-MS/MS data. The process performs an AMDIS deconvolution on EI GC-MS and a similar 
process on LC-MS/MS data. The processed files are saved and can easily be recalled. Changes have been made to 
the appearance of various dialog boxes that enhance their usability. 
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Nominal Mass for Libraries 
In the early 1940s, before the introduction of the first commercial mass spectrometers, individuals and organizations 
began collecting reference mass spectra. These spectra displayed (first tabularly and later graphicly) the m/z values of 
ions as integers, whole numbers. This was partly because of the limited accuracy of the instruments used to measure 
the mass of organic compounds at that time. Even though the mass spectrometer measures the actual m/z value of 
ions, the upper limit was such that cumulative effects on the mass of an ion were inconsequential.  

Since 1961, the masses of all elements have been measured relative to the most abundant isotope of carbon (12C), 
which has been assigned an exact value of 12 Da3. Importantly, mass spectrometers do not measure ion mass directly; 
instead, they measure the mass-to-charge ratio (m/z)—the ion’s mass divided by its charge. In electron ionization (EI), 
nearly all ions carry a single positive charge. Therefore, the m/z value of the molecular ion (M⁺•), formed by the loss of 
a single electron, is effectively the same as the molecular mass on an integer scale, because the electron’s mass 
(~1/2000 of a proton or neutron) is negligible. 

EI mass spectra of organic compounds consist of a series of peaks, often starting with a cluster of peaks representing 
the M+• and proceeding to lower m/z values toward the left, the lowest of which is usually a function of the m/z acquisition 
range. These peaks represent ions formed by the fragmentation of the M+•. The various ions are usually represented by 
a cluster rather than a single peak. In most cases, the lowest m/z peak in the cluster represents an ion where all atoms 
of each element in the molecular formula are the same isotope (the monoisotopic peak). Each of the peaks at higher 
m/z values represent ions where one or more of the atoms of an element is an isotope with a higher mass. These are 
called isotope peaks (ions of the same elemental composition but with different isotopic makeups). 

EI mass spectrometry of organic compounds typically involves 11 elements: C, H, N, O, Si, S, P, and the halogens. 
Some of these elements have multiple stable isotopes (atoms of the same element differing in the number of neutrons4), 
while others—such as F, P, and I—are mononuclidic, meaning they possess only one stable nuclide. 

The exact mass of an element’s most abundant nuclide is the element’s monoisotopic mass. The integer value for the 
most abundant nuclide is its nominal mass. The nominal mass of an ion is the sum of the nominal masses of each 
of its elements’ times the number of atoms of that element. 

The difference between the integer mass of a nuclide and its exact mass is called the mass defect. The mass defect 
of 1H, 2H, 13C, and the two isotopes of nitrogen is a positive number; meaning that the exact mass is a little greater than 
the integer mass. The mass defect of the nuclides of all other nuclides listed above is negative; the exact mass is a little 
less than the integer mass. The mass defect of a nuclide is always less than 100 milliDa regardless of it being positive 
or negative. The two elements with the greatest mass defect relative to their exact masses are hydrogen (7.825 milliDa 
relative to an exact mass of 1.007825, ~0.8%) and bromine (21.7 milliDa relative to an exact mass of 78.9183, ~0.3%). 

As the m/z range of instruments increased and the accuracy of measuring the m/z values improved a decision had to 
be made as to what would be the standard for ions in reference libraries. Would it be based on nominal mass or the 
mass measured by the mass spectrometer. Consider the mass spectrum of Hexacontane (C60H122). The measured 
integer m/z value for the M+• would be 843 (842.995 Da); whereas the nominal mass of the M+• is 842 Da. It was decided 
that all reference spectra would have peaks which corresponded to the ion nominal mass. Some instrument companies’ 
data systems will adjust the EI mass spectrum to accommodate the mass defect. If compensation is not done by the 
acquiring instrument, then when the spectrum is imported into the NIST MS Search Program, MS Search can be set to 
make the correction. All spectra in the NIST/EPA/NIH EI Reference Library are based on nominal mass. There are 
spectra in the NIST Tandem Library that are based on measured mass, and these are what are called accurate m/z 
value spectra, sometimes called high-resolution spectra. 

Mass defect only becomes an issue when the mass of the analyte is >500 Da. Care must be taken when analyzing such 
a compound that the appropriate correction be applied for the mass defect. The value for the hydrogen mass defect 
correction entered in the numeric enter box at the top left of the Spectrum Import Options dialog box is 0.99888. The 
bromine mass defect value is 1.00087. 
 

 
3 At the time the +C standard the symbol for atomic mass was changed from amu (atomic mass unit) to u (unified atomic mass 

unit).Many people had difficulty with this translon and in the 2005, the official unit became the Dalton (Da). 
4 In order for an element to have isotopes it must have two or more species with the same number of electrons and neutrons, but 
different numbers of neutrons. Each of these is also referred to as a nuclide of the element. Elements with only a single nuclide are 
NOT referred to as monoisotopic, but rather mononuclidic. 
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Figure 4. NIST/EPA/NIH NIST 26 Spectrum of Hexacontane (C60H122). 

 

 
Figure 5. NIST/EPA/NIH NIST 26 Spectrum of 2,2',3,3',4,4',6,6'-Octabromodiphenyl Ether. 

As stated above, in EI most ions have a single charge; however, there can be peaks representing ions that are double 
charged. These are typically observed with compounds that are highly aromatic. Linear quadrupole mass 
spectrometers measure ions every 0.05 m/z units. This means that the observed m/z value of such ions with the mass 
of 205 Da will be 102.50. If the instrument being used is capable of reporting to the nearest 0.05 m/z units, have it do 
so. This way, you will be able to spot double charge ions. Otherwise, errors may occur because the integer m/z value 
of the ion in the spectrum can be 102 or 103.  
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FIRST QUESTION: How To Get Spectra into MS Search 
The first question always asked after installing the NIST Mass Spectra Search Program is, “How do spectra get into 
the Program?” 

Prior to NIST 26 and MS Search v.4.0, it was necessary to import spectra from a file containing individual spectra 
(MSP/MSPEC) or have spectra exported from manufacturers’ data analysis programs while that program called MS 
Search. It has always been possible to send EI GC/MS spectra from AMDIS, which could open netCDF and some 
manufacturers’ proprietary data file types. With the addition of the Chromatogram tab view to the MS Search Desktop, 
it is now possible to open chromatographic data files in MS Search (GC/MS low resolving-power files as netCDF, or the 
mzML format and several instrument company proprietary formats, and high resolving-power (accurate m/z values) 
GC/MS files in the Thermo Fisher© RAW, mzML, netCDF, and mzData  formats. LC-MS/MS data files as Thermo Fisher© 
RAW, Bruker TIMS and TOF tdf, and mzML can also be opened and processed.* When a chromatographic file is opened 
in the Chromatogram tab view, the reconstructed total ion current (RTIC) chromatogram is displayed in the 
Chromatogram window and individual spectra, purged of mass spectral peaks not related to the component, are added 
to a Hit List window. These deconvoluted spectra are displayed in a Sample/Lib Match Spectrum window in a 
comparison with a library search result. The deconvoluted spectra can be searched using conventional spectrum 
comparison library searches of Lib. Search tab view or transferred to other parts of MS Search or MS Interpreter along 
with the structure from the library search match. 

Spectra in the Hit List window of the Chromatogram tab view can be added to the Spec List window of MS Search 
(Lib. Search or Librarian tab views) or added to the Compare tab view (see cautionary statement in the Compare tab 
view) by use of a Right Mouse Button (RMB) menu in the Hit List window. By default, when these spectra are sent to 
the other tab views, the views do NOT automatically come into focus. A regular library search of the spectrum in the Hit 
List window of the Chromatogram tab view can be initiated by selecting Library Search from this RMB menu. This 
action will bring the Lib. Search tab view into focus as is the case when Library Search is selected from a RMB menu 
in tab view.  

MS Search has multiple library search 
routines that execute different types of 
searches and may be performed with different 
constraints as well as different libraries. When 
the Mouse Pointer is in either the 
Chromatogram or Hit List window of the 
Chromatogram tab view, the RMB menu 
(Figure 6) has a Library Search Options 
selection that results in the display of the 
same Library Search Options dialog box that 
is displayed by selecting Library Search from 
the Main Menu’s Options menu. After making 

all adjustments to accommodate the desired search, select the OK 
button at the bottom of the dialog box to save all the settings. These 
settings will be employed when the Library Search selection is made 
from the Chromatogram or Hit List window’s RMB menu. The settings 
for this dialog box are described in detail beginning on page 77. 

When spectra imported directly from manufacturers’ data analysis 
programs or files containing one or more spectra are searched, 
Constraints can be used which are set in the Library Search Options 
dialog box displayed by selecting the Library Search Options button in the Button Bar of the Lib. Search tab view or 
by selecting Library Search Options from the Options menu. Multiple libraries can be selected for search in this dialog 
box. These same Constraints and libraries to be searched are used when a library search is initiated with the Library 
Search selection of the RMB menu in the Hit List window of the Chromatogram tab view.  

 
*Proteowizard’s MS Convert (https://proteowizard.sourceforge.io/tools/msconvert.html) can be used to create a supported format from 
most instrument company’s proprietary format files. The netCDF high-resolution files produced by the JEOL AccuTOF and the 
Thermos Fisher© Orbitrap software will work with the Analyze EI HiRes Input File selection from the File menu.   

 
Figure 6. RMB 

menu displayed in 
Chromatogram 

window of Chro-
matogram tab view. 

 
Figure 7. Displayed Library Search 

Options dialog box from RMB menu in 
Chromatogram or Hit List window. 

https://proteowizard.sourceforge.io/tools/msconvert.html
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If MS Search is installed on a computer that has Agilent ChemStation®, or MassHunter® Qual, MassHunter® Quant, or 
OpenLab software installed, direct links between MS Search and these Agilent programs are established. Spectra are 
exported from the ChemStation Data Analysis spectrum display by putting the Mouse pointer in the ChemStation 
spectrum window and double-clicking the Right Mouse button. One spectrum or several spectra can be sent from 
ChemStation Data Analysis by running one of the NIST macros called from the ChemStation Spectrum menu. Spectra 
can be sent, one at a time, from MassHunter Qual or MassHunter Quant by using the Search using the NIST MS 
Program selection on a RMB menu displayed with the Mouse pointer on the spectrum display. A group of spectra can 
be sent from MassHunter Qual by highlighting spectra shown in the Data Navigation window and using the same RMB 
menu command used to send individual spectra. OpenLab uses the NIST dll for its internal search and can send spectra 
to MS Search from an RMB menu. 

The Thermo Fisher’s FreeStyle data analysis program in Xcalibur® (or Qual Browser in older versions) can send spectra 
directly to MS Search with calls from menus and the use of the RMB menu commands. Thermo Fisher’s Xcalibur data 
analysis software uses the NIST MS Search dll(s). A demo version of MS Search is provided with Xcalibur. This will 
have to be replaced when installing the current version of NIST Data (both Tandem and/or EI) and the current version 
of MS Search. 

Accurate m/z data files must contain spectra with centroided mass spectra peaks. 

The Perkin Elmer TurboMass® and Waters MassLynx® Data Analysis software have links that send spectra directly to 
the NIST MS Search Program. Consult these individual manufacturers for details. Other manufacturers may have similar 
capabilities.  

The NIST Automatic Mass spectral Deconvolution and Identification System (AMDIS) will read the native formats of 
several instrument manufacturers’ GC/MS data files. Spectra can easily be exported from AMDIS (with or without 
retention index values) to the MS Search Program. Manufacturers that have formats which are not readable by AMDIS 
will often have utilities to export their GC/MS data files in the netCDF format, which can be read by AMDIS.  

There are several ways to export product-ion mass spectra so they can be read by MS Search. MS Search can read 
files containing one or more mass spectra with the following extensions: MSP, MSPEC, TXT, MOL, JDX, SDF. KCF, 
MGF, DTA, PKL, mzXML, and mzData. Before importing individual spectra or groups of spectra from instrument specific 
data or using spectra identified using the Chromatogram tab view of MS Search, it is a good idea to go through the 
Getting Started section of this manual. 

If the mass spectrometry data analysis software in use does not have a feature allowing for the direct export of a mass 
spectrum to the NIST MS Search program, try using the File/Open command from the Main Menu of the data analysis 
program to export spectra in one of the readable NIST file types. Better yet, export the data files to a netCDF file (EI 
data) or an mzML file (LC-MS/MS data) and open these in the New Chromatogram tab view. 

If the LC-MS or LC-MS/MS instrument does not have the ability to export the chromatography data file in an mzML 
format, this can be accomplished using the msconvert utility ProteoWizard downloadable from: 

https://proteowizard.sourceforge.io/ 

This program is reported to be able to convert all instrument manufacturers’ LC-MS LC-MS/MS data files into mzML files 
with centroided mass spectra peaks. 

The following example is for the processing of a nominal m/z EI GC/MS data file (Analyze EI Input File) in the New 
Chromatogram tab view. The next two sections will cover Analyze HiRes EI Input File processing and Analyze MS/MS 
Input File. 

  

https://proteowizard.sourceforge.io/
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Getting Started with the NEW Chromatogram tab view 
[In this manual Selecting means to place the Mouse pointer an object and click the left Mouse button once.] 
When MS Search is opened for the first time after installation, one of two Title Bars will be displayed: 

 or   

depending on whether the NIST Tandem or the NIST\EPA\NIH Electron Ionization (EI) Library was installed. The 
display will be that of the Lib. Search tab view. At the bottom of the Desktop, there are six selectable tabs.

 
Select the tab labeled Chromatogram to bring the Chromatogram tab view into focus. 

 

 
Figure 8. Setting up a Program for GC/MS EI from the Unpopulated Chromatogram tab view. This Changes the 

Appearance of the File menu as shown above. 

This presentation is related to LowRes EI GC/MS. If the Tandem version of NIST 23 was installed, go to page 30. 
The Spectrum Type should be EI or Any. If it is Tandem, change it appropriately by 
selecting File on the Main Menu, then select Select Spectrum Type from the File 
menu. Selecting an item is done by placing the 
Mouse pointer on the item and clicking the left 
Mouse button. This will sometimes result in the 
display of a dialog box. The spectrum type is 
chosen by selecting the radio button next to the 
desired type in the Select Spectrum Type 
dialog box. Once the Spectrum Type has 
been selected, select File on the Main Menu, 
and select Analyze EI Input File from the File 
menu. This causes the Select 
LowRes/Calibration Files dialog box to be 
displayed with three list boxes (Figure 10). The 
top box specifies the type of Analysis.  

 

Figure 10. Dialog box 
displayed when Open EI Input 

File is selected from File 
 

 

Figure 9. Select Data File 
dialog box. 
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Figure 11. NIST Mass Spectral Search Program Chromatogram tab view after Processing an EI Data File. 

For this example, select Analysis NO RI. The bottom displayed list box (labeled Calibration File) will disappear. This 
is used to select the name of the Retention Index Calibration file when doing analyses using RI values (explained later 
in this manual). Preforming analyses using Retention Index will also be described later in this manual. 

The dialog box will continue to be displayed after selecting the Analysis type. Select the button with ••• on the right side 
of the middle drop-down list box. This will cause the Select Data File dialog box (to be displayed Figure 9). This dialog 
box has a button that will display a drop-down list of instrument manufacturers data analysis software. If not already 
selected, select the Agilent ChemStation (*.D). Then select the GROB.D file name (navigation to the file location in the 
C:\NIST26\AMDIS32\ folder is required) and select the Open button (lower right of the dialog box) The Select Data File 
dialog box will close leaving the Select LowRes Input/Calibration Files dialog box still displayed. For this example, 
ignore the AMDIS Deconvolution Settings button in the dialog box. 

Any library in the NIST MS Search format and in the folder with the NIST 
EI mainlib and replib can be included (user-libraries or third-party 
libraries such as the Wiley Registry of Mass Spectral Data) in the 
search. Select the Library button on the Select LowRes Input/RI 
Calibration Files dialog box to display the Libraries dialog box  
(Figure 12) with the upper window displaying the names of available 
libraires and the lower window containing the names of the libraries to 
be included in the search. Just below this a line showing the number of 
spectra to be searched and the number of libraries being searched. The 
order of the libraries can be changed by highlighting the name and using 
the  buttons on the right. The order of the libraries has no impact on 
the Hit List because spectra are displayed based on Match Factor, not 
search order. If the mainlib and replib are not in the lower window, select 
them in the upper window and then select the Add button. If other 
libraries are in the lower window (under the Include Libs: label), 
highlight and select the Delete button (). 

Once the data file and libraries are selected, select the OK button on 
Select LowRes Input/Calibration Files dialog box. Running Task will 
appear in the Filter Bar and the hourglass icon () will display until 
processing is finished (this can take some time, depending on the size 
of the file), at which time the windows of the Chromatogram tab view 
are populated as shown in Figure 11, unless the Run in background 

 

Figure 12. Libraries dialog box displayed 
by selecting Library on the Select LowRes 

Input/Calibration Files dialog box. 
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check box () was selected. During this processing time 
the focus can be changed to another tab view. The focus 
may be changed to another tab view and other operations 
carried out. When the data file processing finishes, the 
Process result dialog (see next page) will be displayed, 
regardless of the tab view in focus. Selecting the Open 
button will cause the focus to change to the 

Chromatogram tab view and the results of the processed file will be visible. If the Save button is selected, the dialog 
box closes, and the focus remains with the present tab view. When the focus is changed to the Chromatogram tab 
view, the results of the processed file will be visible. 

When the processing is complete the data file name will appear with the number of components identified. ([Grob 
nHits=xx]). This number is based on the settings in Filter Bar. If the settings are different than those shown in 
Figure 11, the nHits=XX will be different. The first component is automatically selected. Circles () on the 
chromatographic trace represent deconvoluted/tentatively identified components. Some of the s are filled (colored 
yellow by default). The filled s represent components that have a Score greater than the number in the box to the right 
of the Highlight Score label on the Filter Bar. Selecting one of the s will cause it to increase in size and change color 
(green, by default). The entry in the Hit List window for that component will be highlighted and the display in the 
Sample/Lib Match Spectrum window will be the component (up) and library match (down) spectrum. The Meta Data 
Lib Match window will contain information for the library match. The meaning of the Filter, Max2Med, and Merge 
Duplicate ID are explained later in this manual or the Help file displayed by selecting the Help button in the Hit List 
page of the Chromatogram Properties dialog box. 
 

Nota Bene: The Select LowRes Input/Calibration Files dialog box (Figure 9) is displayed when 
File/Analyze EI input File is selected from the Main Menu. A checkbox next to the Run in background 
label is observed on the lower left, just above the OK button. Due to the time required to process some 
data files, this will cause the file processing in the Chromatogram tab view to run in background, allowing 
other operations to be executed. This includes moving from one tab view to another. Once the file 
processing is complete, a dialog box will appear offering the bringing of the processed file into focus in the 
Chromatogram tab view (              button) or saving the results (              button) and leaving the current 
tab view in focus. The checkbox remains selected until deselected.  

 

 
Figure 13. Hit List Controls in Bar below the Menu. 

The horizontal axis of the (Reconstructed Total Ion Current) RTIC Chromatogram window is fixed as a linear display of 
Retention Time (in minutes), and the left vertical axis is, by default, a linear display of relative abundance. The right 
vertical axis is, by default, linear with respect to the total ion current. Displays of both the vertical axes of the RTIC 
Chromatogram window can be linear, square root or log. This setting is on the Chromatogram View page of 
Chromatogram Properties dialog box displayed from the RMB menu (Properties) with the Mouse pointer in the 
Chromatogram window. The default is linear. 

The position of the  represents the retention time (spectrum number, horizontal position) and the relative 
chromatographic abundance (vertical position.) Nota Bene: the position of  representing a component when using 
Tandem Spectra in the Chromatogram tab view is not defined in the same way as EI data. 

When  is selected on the RTIC Chromatogram window, the Hit is highlighted in the Hit List window. If a Hit is 
highlighted in the Hit List window the component is selected on the RTIC chromatogram window turning the color of 
 from clear or yellow to green. 

The Hit List can be filtered based on several items in a dropdown list box just above the Chromatogram tab view’s 
RTIC Chromatogram and Plot/Tabular windows (Figure 13). Selecting Reload on Starup results in the contents of the 
Chromatogram tab view, at the time of MS Search’s closing, being restored when the program is restarted. This may 
delay the startup of MS Search. The Highlight Score selection will result in the circle identifying a component symbol 
being filled (yellow by default) if the Score is equal to or greater than the specified number in the dropdown list box to 
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the left. The Filter setting determines the items in the displayed Hit List and designated on the Chromatogram based 
on the Score. Only spectra that have a Score equal to or greater than the specified number in the dropdown list box to 
the left will appear in the Hit List in the Hit List window. The next filter is Max2Med with a dropdown list box. This is the 
ratio of maximum to median ion intensity in spectrum – low values indicate low signal strength. The last selection on the 
Filter Bar is the Merge Duplicate ID. The None option in this list box turns the process off. The other values have to do 
with the differences in the retention time of two identical identities (explained in more detail later in this manual).  

By default, the Hit List window is initially sorted by spectrum number in increasing order (first column right of the 
Component Number column labeled Scan); however, the Hit List can be sorted by any desired column header by 
selecting its title. The first selection results in sorting by decreasing value. A second selection results in a sort by 
increasing value. The sorted column will contain a  (decreasing) or  (increasing) preceding the title. Often it is 
desirable to sort by Abund.Rel. This allows examination of result in order of decreasing abundance by progressing down 
the Hit List.  

The number of Hits displayed for the same spectrum number is controlled in 
the AMDIS Deconvolution Settings dialog box (displayed by selecting the 
by the AMDIS Deconvolution Settings button in the Select LowRes 
Input/Calibration Files dialog box) and adjusting the number of Adjacent 
peaks subtraction. If None is selected, a single Hit will be displayed for any 
spectrum; if One (default) is selected, up to two Hits can be displayed; and, if 
Two is selected, up to three Hits can be displayed for a single spectrum. More 
details about this setting can be found in the AMDIS Help File, 6.3.3 Deconv. 
(Deconvolution) tab. To get to this selection of the AMDIS Help File, select 
Settings from the Analyze menu (selected from the AMDIS Main Menu). 
Then select the Deconv. tab followed by selecting the Help button on the 
dialog box.  

Combine scans: is a setting that is NEW to the employment of AMDIS in the Chromatogram tab view. This is to 
improve results from GC/MS instruments that acquire spectra faster than the elution of the chromatographic peak. The 
AMDIS algorithm works best when the number spectra for a chromatographic peak is between 5 and 10. This is ~2 
spectra sec-1. If the acquisition rate is too fast, AMDIS will produce multiple identifications of the same compound 
appearing close to one another. If the rate is too slow small chromatographic peaks can be missed. The peak width can 
be determined by expanding a single sharp peak and subtracting the time from beginning from that at the ending of the 
full width at half-maximum (FWHM) of the peak., e.g., value is 2.6 sec. The acquisition rate is obtained by multiplying 
the RT value for the last Hit in Hit List of the Chromatogram tab view by 60 to have the time in seconds and divide this 
by the number of reported spectra for the last Hit, e.g., (RT of 30.1571 min (60) / spec no. (13662) = 0.132 sec spec-1.  
Divide this number of sec spec-1 into the number of seconds for the FWHM of the chromatographic peak, e.g., 
2.4 / 0.132 = 18 spectra (FWHM) per chromatographic peak. If the acquisition rate is <0.5 enter a factor in the Combine 
scans field to result in a rate of ~0.5 sec. spec-1. For this example, that value would be 3; however, for this example, 
these settings can be ignored.  

Scan direction: All commercial transmission quadruple mass spectrometers scan from low m/z value to high except for 
the Agilent Technologies instrument. It scans from high m/z value to low. This will impact spectral skewing, which is a 
factor in deconvolution. Time-of-flight and quadrupole ion traps are pulse instrument and have no scan direction. 

 

Figure 14. Hit List window in Chromatogram tab view after Processing EI Data File in this example. 
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In addition to the Structure window on the lower left of the Chromatogram tab view, the 
structure associated with the library spectrum of a Hit can be displayed in a floating window. 
To display this window, select Show Structure from the View menu, displayed by selecting 
View on the Main Menu. This Structure window can be dismissed by selecting the  
button in the upper right corner or deselecting the choice in the View menu. The Show 
Structure option on the View menu has been added to all tab views in v.4.0 of MS Search. 
In the Chromatogram tab view, this floating window can be used instead of the fixed 
Structure window allowing for expansion of the width of the Hit List window. This allows 
the fixed Structure to be dismissed by sliding the vertical diver bar between it and the Hit 
List window to the right. This allows for more space for the Hit List window, if required. 

The MS Search Title Bar (  ) is displayed at the top of Chromatogram tab. 

As Filters are adjusted in the Filter Bar, the nHits= value can change. This can be informative.  

The results of all data files processed in the Chromatogram tab view are automatically saved. Examination of the file 
menu shows selections to Reopen and Delete the results of processed files.  

When the File\Reopen selection is made the dialog box on the left is displayed showing all the conditions of the process 
including the searched libraries (shown left). 

The Hit List window Chromatography Properties dialog box has all the initial selections for the column headers as 
shown in Figure 15. There are 11 different selections when the program is used in the normal mode. There are an 
additional 10 when Include Expert Results in the Chromatogram Properties dialog box is selected. The following is 
list available when the expanded mode is selected along with definitions (those only available when the Expert mode 
is selected are designated with an *): 

Order Number – 
Position in Current Hit 
List 
*Scan – spectrum 
number 
RT – Retention time for 
compound in minutes 
*LibRI – statistical SSNP 
Experimental RI median 
value if present. If not, 
the AI predicted SSNP 
retention index (n-alkane 
scale) value is used. 
Score – NIST Identity 
Score 

Prob – Probability of hit being correct assuming correct ID is in library 
Dot Prod – Cosine Similarity (Unweighted) 
R.Match – Score not including query peak not in library spectrum 
Abund.Rel. – Percent abundance relative to largest abundance 
*#mpeaks – number of peaks matching between the library and sample  
*Purity – Percent total signal in fragmentation zone due to contam. ions 
*Max2Med – Ratio of max to median intensity in spectrum – low values 
indicate low signal strength 

*Width (scan) – No. of spectra that constitute the component 
*nSpec – Number of duplicate IDs within selected narrow RT range 
Other DBs – Compound Ubiquity Index (# DBs comp. is present in) 
Formula – Chemical formula of library compound 
*AbUncertPct – Percent of abundance from uncertain peaks 
*SumAB – Sum of peak abundances with base peak = 1 
Library – Name of the library containing the Hit 
*#peaks – Total number of peaks in the spectrum including uncertain peaks 

  

 
Figure 15. Nota Bene: Some items 
may not appear as selectable Hist List 
header options depending on the type 
of analysis performed (Analysis with 
Calibration File, Analysis with No RI, 
Analysis w/RI Estimation). 
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The deconvoluted spectrum (the spectrum pointing up in the Head-to-Tail display of the Sample/Lib Match Spectrum 
window) may have dashed peaks. These peaks represent ions that may not belong to the rest of the spectrum. They 
are called uncertain peaks. These uncertain peaks are used in the determining of the closeness of the match between 
the library and sample spectrum if they match library spectrum peaks (Score, Dot Product, R.Match) in the 
Chromatogram tab view’s deconvolution and search. The uncertain peaks are igored if the don’t match the library 
spectrum peaks. 

The deconvoluted spectrum can be sent to MS Search’s Spec List 
window (Lib. Search/Librarian tab views) by selecting (highlighting) 
one or more components in the Chromatogram tab view Hit List 
window, then with the Mouse pointer in the Hit List window, click the 
Right Mouse button, and select Send to from the RMB menu (Figure 
16). This action does NOT bring the Lib. Search/Librarian tab view 
into focus. The RTIC Chromatogram window’s RMB menu also has 
a Send To selection; only a single spectrum at a time can be sent. If 
Library Seach is selected from  these two RMB menus, the 
deconvoluted spectrum/spectra is/are sent to the Spec List and 
searched using the settings and selected libraries in the Library Search Options dialog box (displayed by selecting the 
Library Search Options ( ) button on the Button Bar of the Lib. Search tab view or selecting Library Search 
Options from Options on the Main Menu). The Lib. Search tab view will be brought into focus. If the deconvoluted 

spectrum is already in the Spec List window, when the 
Lib. Search tab view comes into focus, the existing entry 
will be highlighted and searched. When spectra with 
uncertain peaks are sent to the Spec List by the Library 
Search command of the RMB menu, the uncertain peaks 
will also be sent. Whether or not uncertain peaks are used 
in the search is controlled by a selection in the Search 
page of the Library Search Options dialog box. When 
the display of m/z-Intensity List is selected in the 
Unknown Text Info page of the Library Search 
Properties dialog box, a B (background) or N (noise) 

designation will appear to right the intensity value for the uncertain peaks as shown in the figure above. L is another 
type of uncertain AMDIS peak (Figure 17). These are due to overlapping peak uncertainty between neighboring 
deconvoluted components. 

The spectrum from the Meta Data Lib Match or Tabular Data for Deconvoluted Spectrum window can be Library 
Searched or Sent to the Spec List of the Lib. Search tab view or the Compare List of the Compare tab view using 
their respective RMB menus. These functions cannot be performed from either of the two Plot windows. 

Nota Bene: When a selection in the Chromatogram window or a selection or selections in the Hit List 
window of the Chromatogram tab view are sent to the Compare List of the Compare tab view using 
the RMB menu, the only thing sent is deconvoluted spectra. If the Compare tab view is formatted with 
a top spectrum window, a Compare window, and a window containing spectra to compare with the top 
window’s spectrum, the Compare tab view will be cleared, and the spectra/spectrum will appear in 
individual windows. If subsequent spectra are sent from the Chromatogram tab view, these spectra 
will be prepended to the top of the display. The default number of spectra in the display is 3 but can be 
change in the Properties dialog box displayed with RMB menu in the Compare tab view. Caution: If 
another file is processed in the Chromatogram tab view and deconvoluted spectra sent to the 
Compare List of the Compare tab view, these spectra will be prepended to the list of spectra that was 
created from the previous file. It is best to bring the Compare tab view into focus and use the RMB 
menu to Clear this tab view before processing a new file. 

If a group of spectra have been highlighted in the Hit List window of the Chromatogram tab view, they can be 
exclusively viewed using the RMB menu’s Show Selected option. The excluded spectra can be redisplayed using the 
RMB menu’s Show All option. The Hit List window’s RMB menu options to Export Selected Hits to Text File or Copy 
Selected Hits to Clipboard are New in v.4.0. These options are also present on the RTIC chromatogram window’s 
RMB menu. These options have also been added to the RMB menus of various windows of other tab views.  

The three vertical and one horizontal splitter bars in the Chromatogram tab view can be adjusted. The Change Splitter 
Orientation found on the RMB menu in some of the other tab views is not available in the Chromatogram tab view. 

 
Figure 17. Spec List Plot/Meta Data windows of Lib. 

Search tab view of spectrum sent from 
Chromatogram tab view Hit List window. 

 
Figure 16. RMB menu displayed in Hit 

List window of Chromatogram tab 
view. 
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Various properties such as font type, size and style can be adjusted using the Properties selection of the RMB menu. 
The thickness of the lines that constitute the mass spectral peaks along with other items can also be changed using the 
Properties dialog box displayed as a selection from the RMB menu called from any of the windows for this tab view. 
This dialog box is unique to the window from which it is called. 

The RTIC Chromatogram window (upper left of the Chromatogram tab view) can be zoomed multiple times. A 
complete zoom-out to the original display is accomplished by placing the Mouse pointer on the window and double 
clicking the left Mouse button. This zoom out feature for all graphics display has been an undocumented feature in MS 
Search since NIST 08 and maybe before. The zoom can also be canceled from a selection on the RMB menu (Undo 
Zoom, grayed when the display is not expanded). 

When MS Search is exited and reopened, the contents of the Chromatogram 
tab view are not displayed unless the Reload on Startup checkbox () has 
been selected. If MS Search is closed with this box selected while viewing a 
populated Chromatogram tab, when the program is restarted the display in 
the Chromatogram tab view will be what was being viewed when the 
program was closed. MS Search has always opened to the tab view that was 
present when the program was closed. Selecting this setting may increase 
the time needed for the program to open. 

One of the Chromatogram tab 
view EI Analysis types is Analysis 
w/RI Estimation (Figure 19). If this 
search is performed, the Hit List 
window will have a column labeled 

EstRI (Estimated Retention Index value) containing estimated semi-standard 
non-polar RI values. Display of this column is not controlled with the 
Properties dialog box. Its presence is a function of the Search Type selected 
in the Select Input/Calibration Files dialog box displayed by selecting the RI 
appropriate item from the Analysis dropdown list box. This column’s display 
cannot be turned on and off in the Hit List page of the Properties dialog box. 

It is also possible to select Analysis w/RI Calibration File. This requires the generation of a Calibration File. It is also 
possible to set the RI tolerance and RI penalty rate in the Retention Index Score Corrections (Semi-Standard Non-
Polar) dialog box displayed by selecting the RI Settings button on the Select LowRes Input/Calibration Files dialog 
box (Figure 22). The default setting for the RI penalty rate is Average. Descriptions of the other options can be found 
in the Help File, displayed by selecting the Help button in the Select LowRes Input/Calibration Files dialog box. 

Nota Bene: Over the last few releases of the NIST\EPA\NIH Electron Ionization Mass Spectral Library, increasing 
emphasis has been place of the use of the retention index (RI). A great deal of effort was put into the collection 
of RI values on Standard Non-Polar (e.g. DB-1), Semi-Standard Non-Polar (e.g. DB-5), and Standard Polar (e.g. 
DB-Wax) packed and capillary columns. At the same time the RI values were harvested, the details of the GC 
Methods were recorded. This effort constitutes the NIST GC Method/Retention Index Database. Now, when NIST 
measures an EI mass spectrum, it always measures the compound’s retention index on a 250 µm x 15 m (film 
thickness 0.25 µm) SSNP column. The details of this method are included with the spectrum’s record in the 
Library. RI has been a usable constraint for several MS Search’s releases. Each day, NIST evaluators run an n-
alkane standard before measuring spectra. With the addition of Chromatogram tab view in v.4.0, RI has become 
a bigger part of using MS Search in the identification of unknowns. Its use is encouraged. Its value is significant. 

Nota Bene: Analysts should always remember, they, not mass spectral libraries or software, identify unknowns.  

The NEW Chromatogram tab view is a very powerful tool for dealing with nominal m/z value, accurate m/z value 
GC/MS data files, and LC-MS/MS (DDA) data files. This tool offers a great deal of information to provide a high 
assurance that a substance has been correctly identified. Sometimes, the amount of support information provided can 
be overwhelming and requires deep digging to get the highest level of confidence the identity is correct, the time 
necessary to learning the value of all the information coming from the Chromatogram tab view is well worth the 
eventual reward. Combined with the increase in depth and breadth of the expanded NIST\EPA\NIH Electron Ionization 
(EI), NIST 23 and the NIST 26 Tandem Libraries, MS Search, v.4.0 along with MS Interpreter, and the 2017 version of 
the Hybrid Search is a quintessential tool for organic mass spectrometry. 

 
Figure 18. Dialog box displayed by 

selecting File/Open EI Input File 
from Main Menu. 

 
Figure 19. RI Score Correction 

dialog box displayed by selecting RI 
Settings button. 
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Processing EI HiRes EI Input Files in Chromatogram tab view 
As of the release of NIST 26 and MS Search v.4.0 there are a number 
of GC/MS instruments that measure accurate m/z values for ions 
formed in an EI ion source. The methods of processing an integer EI 
GC/MS file (Analyze EI Input File from the File menu) and a HiRes 
GC/MS Data (Analyze EI HiRes Input File) are very similar to one 
another. There are some differences, when Analyze HiRes Input File 
is selected from the File menu, the Select HiRes Input/Calibration 
Files dialog box is different than the one displayed when Analyze EI 
Input File is selected (Figure 20). Analyze menu displayed from the top 
dropdown list box is the same.  

 

The AMDIS Deconvolution Settings, RI Settings, and Libraries buttons display the same dialog boxes as displayed 
when these buttons are selected in the Select LowRes Input /Calibration Files dialog box. The Estimate number of 
combined scans button is grayed until an Input File is selected. Once selected, it is best to select this button. Accurate 
m/z instruments such as Q-TOFs and Orbitraps acquired data more rapidly than the transmission quadrupole. This fact 
often results in multiple IDs for a single chromatographic peak. This can result in confusion. If multiple spectra (scans) 
are added together, this can be avoided.  

Once selected, a brief period passes (be patient, this can take some time depending on the file size) and then a dialog 
box with Yes and No buttons is displayed with the statement as to the Estimated number of combined scans is X. 
Accept? Selecting the Yes button causes the deconvolution process to use the program’s estimate. If No is selected, 
the number for this setting in the AMDIS Deconvolution Settings dialog box will be used. The Depth of Analysis 
selection in the dropdown list box determines how many components are allowed. This is a sensitivity setting. One 
experiment showed the same data file resulted in 49 components when set to Fastest, 196 when set to Moderate, and 
235 when set to Maximum. The increase in processing time is exponential. 

Currently, there are no accurate m/z EI NIST libraries provided by NIST. The searches are against the integer NIST EI 
libraries (mainlib and replib) unless others have been specified in the Libraries dialog box displayed by selecting the 
Libraries button in the Select HiRes Input/Calibration Files dialog box. The Hit List columns available for the 
processing of both HiRes and LowRes EI files are the same. There is a single command on the File menu to recall 
previously processed EI data files (HiRes or LowRes) The Filter Bars for the two modes are the same. When the file is 
selected in the Reopen EI Results dialog box the top line of the Run Options window is labeled Mode: and specifies 
whether the file is LowRes or HiRes. 

Before processing an accurate m/z EI GC/MS data file, the previous section on processing integer m/z value data should 
be carefully reviewed. Once the data file is processed, the Chromatogram tab view will appear as shown in Figure 19, 
on the next page. The only major difference is labeling of the bar graph display of the deconvoluted component. They 
are labeled to four decimal places. The rules for sending and using uncertain peaks in the Lib. Search tab view are the 
same for the HiRes and LowRes data. 

Analyzing w/RI Calibration File 
The above two examples do not include the use of the components’ retention Index (RI). The Chromatogram tab view 
data processing is designed to facilitate identification using RI Experimental values in the searched NIST Libraries when 
a semi-standard non-polar (SSNP) GC column is used. If an Experimental value is not available for the mainlib or replib 
spectrum, the AI estimated RI value is used. Using the same column used for the analysis and the same chromatographic 
conditions, perform an analysis of a sequential linear hydrocarbon mix; it is good practice to acquire this data file every 
day before samples are analyzed. The existing calibration file should be evaluated using the newly acquired data file. It 
is important to create a new calibration file each time the chromatographic conditions are changed. If the calibration data 
file is in a specific folder and the calibration file has that folder’s name, when a new calibration file is created, it will 
overwrite the current file name.  

 

Figure 20. Dialog box displayed when 
Analyze HiRes is selected from the File 
menu of the Chromatogram tab view.  
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Figure 21. Chromatogram tab view with populated windows after a HiRes EI data file has been processed. 

An effective way to check the validity of the calibration file is to perform an Analysis w/RI Calibration File using the just 
created calibration file and the data file used to create it. The resulting Hit List should show all the n-alkanes. If branched 
compounds are identified, then manual evaluation of the file is required. 

It should be noted that problems may exist above RI values of 3000 when the calibration is generated by MS Search. 
The calibration file (*.CAL) is a simple text file and can be easily opened with Windows® Notepad. The calibration file will 
have the name of the folder it is in, e.g., if the calibration data file is located on the \NIST26\MSSearch\SAMPLE DATA\ 
folder, the calibration file, after creation, will be in that folder and have the name SAMPLE DATA.CAL. 

If it is desirable to use RI values above 3000, it may be necessary to open the CAL file in Notepad and edit it. If the file 
is edited, make sure the format is maintained with only one space been each of the columns. 

It is important to keep in mind that the acquisition rate can affect the calibration file, especially when measuring integer 
GC/MS data with a transmission quadrupole instrument. The faster the acquisition rate, the less time is spent measuring 
the ion current of any individual m/z value. 

The calibration file is generated from the Select LowRes Input/Calibration File or Select HiRes Input/Calibration File 
dialog box. Once the calibration data file is selected from the Select Data File (LowRes) or Open (HiRes) dialog box 
and the Open button is selected, the dialog box closes leaving the Select dialog box open. Select Ok button. The dialog 
box closes, the data are processed, and an Information dialog box is displayed that reads Calibration File Created 
and an OK button; selecting the OK button closes this Information dialog box and the program is ready to process a 
data file.  

Nota Bene: Unlike LowRes (GC/MS EI) data files only generic mzML, CDF, and mzData files are 
support for processing in the Chromatogram tab view. Support for some instrument manufacturers 
native file formats for LowRes (Analyze EI Input File) is a carryover from AMDIS. 
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Processing LC-MS/MS Files in the Chromatogram tab view 

 
Figure 22. Chromatogram tab view with a processed LC-MS/MS data file. 

[In this manual, Selecting means to place the Mouse pointer on an object and to click the left Mouse button once.]  

For LC-MS/MS (DDA) chromatogram files, the Chromatogram tab view enables searching of all MS2 spectra against 
the NIST Tandem Libraries and other such libraries using updated NIST MS Search algorithms. This routine will also 
allow for component deconvolution and performing the NIST17 Hybrid Search, which has proved very effective in the 
aid of the identity of unknowns when it is believed there are no spectra for these compounds in the library. In addition, 
processing of MS1 data is done by the XICanalyzer program5 which identifies the chromatographic peak for each 
spectrum which can be viewed with the XIC Browser, callable from the Hit List or RTIC Chromatogram window with 
the RMB menu Send To selection. Each MS2 spectrum can be further analyzed using the tools provided with MS 
Search, including the Hybrid Search, which is an aid to identifying compounds that do not have spectra in the searched 
libraries. Extracted MS2 spectra can be saved to user-libraries using the MS Search Librarian tab view. 

The layout of the Chromatogram tab view when being used for LC-MS/MS (DDA) data is the 
same as when it is being used for GC/MS data, except for the Filter Bar. The two modes have 
different filters. See Figure 8 for a definition of the layout and windows in the Chromatogram 
tab view. When the selected Spectrum Type is Tandem, the File menu has a different 
appearance as shown on the left.  

Another difference between the Chromatogram tab view used with LC-MS/MS (DDA) and EI 
(GC/MS) data is the information that can be displayed in the Hit List. Like the Chromatogram 
tab view Hit List columns for EI (GC/MS), the available Hit List columns for LC-MS/MS (DDA) 

are divided into two categories: Default and Expert. In the following list of definitions, those only available when the 
Include Expert Results checkbox is selected are marked with an *: 

Order Number – Position in current Hit List 
Scan – Spectrum Sequence number in chromatogram (only needed to compare to original data) 
RT – Retention time for compound (minutes) 

 
5 Guanghui Wang, Zheng Zhang, Yi Liu, Meghan C. Burke, Sergey L. Sheetlin, and Stephen E. Stein, “An XIC-Centric Strategy for 
Improved Identification and Quantification in Proteomic Data Analyses  

 
File menu when 
Spectrum Type is 
Tandem 
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Score – NIST Identity Score – excludes large losses and dimers 
Score (Unfiltered) – Score of any top library ID, including all in-
source spectra (including large losses) 
DotProd –  Cosine Similarity (Unweighted) 
Prob –  Probability of hit being correct assuming correct ID 

is in library 
*R.Match – Reverse Match score ignores query peak not 

matching library peak 
*#mpeaks 
 –  Number of query peaks matching library peaks 
Prec.Shift –  Using MS1 abundances, shifting of m/z used for 

fragmentation needed to match principal ion 
Abund.Rel –  Percent abundance relative to largest abundance 
*nSpec –  Number of MS2 spectra acquired for a component 

(XIC) peak 
Prec. m/z –  Precursor m/z of MS/MS spectrum 
*Charge –  Charge of ion consistent with isotope spacing 
*dPPM –  Difference in m/z between measured and library 

spectrum 
*Purity –  Percentage of total signal in fragmentation zone 

due to contaminant ions 
*Bkgd –  Background percent provides measure of relative intensity of precursor ion for perceiving background ions 

eluting over long periods 
*Max2Med – Ratio of maximum to median ion intensity in spectrum – low values indicate low signal strength 
*Width (XIC Peak Width) – Width of component peak (XIC) in seconds 
*XIC Number (XIC Primary) – Sequence number of component XIC peak 
*Instrument – Type of fragmentation for library spectrum 
*Iso.Profile (XIC_correlation) – Degree of matching isotope peaks in Component peak (XIC) 
Prec.Type – Type of precursor for library spectrum – e.g., [M+H-H2O] where for protonated ion with water loss from  

 precursor ion 
Other DBs – Compound Ubiquity Index (DBs) - the number of external libraries in which the compound is present 
*Formula – Chemical formula of the Iibrary match 
*Mobility (1/K)) – Ion mobility (1/k0) when reported by instrument 
*SumAb –Total abundance of query spectrum with base peak assigned value of 1  
Library – Name of Library containing the spectrum 
*#peaks  – number of peaks in the deconvoluted component. 

The Tandem Spectrum Type of the 
Chromatogram tab view has a number of 
features requiring a deep understanding; 
however, it can be used simply to provide 
identifications of unknowns in an LC-
MS/MS (DDA) chromatogram. This 
example illustrates that process.  

Nota Bene: See Nota Bene page 24 about Run in background checkbox. 

Nota Bene: See The Program Chromatogram tab view page 58 for information on Hybrid Search. 

From the File menu select Analyze MS/MS Input File. This results in the display of the Select MS/MS Input File dialog 
box (above left). Select the Libraries button. If the hr_nist_msms library is not in the Include Libs: window (lower 
window), highlight it in the upper window and use the >>Add>> button to add it. Then select the OK button to close the 
Libraries dialog box. There is button labeled Tolerance in the Select MS/MS Input File dialog box. Selecting this button 
results in Tolerance dialog box being displayed allowing the input of m/z tolerance for the data. If actual values are not 
available use 20 for the Precursor and 40 for the Product when analyzing Q-TOF data and 10 and 20, respectively, when 
analyzing Orbitrap data. The data being analyzed in this example is from a Q-TOF. For this example, leave the Min 
Abundance at 0. Select the OK button to close the dialog box. 

After establishing the proper mass accuracy values and marking sure the correct library will be used, select the button 
(labeled …) on the right side of the Input File entry field. This results in the display of a file Open dialog box. The only 

 
Figure 23. RMB menu display of Hit List page 

of Chromatogram Properties dialog box. 
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file types supported by the Analyze MS/MS Input File selection from the File menu are mzML Files (*.mzML). Most 
instrument manufacturers have a function to out files in the generic format or there are third party programs which can 
be used. For this example, navigate and find the file named ForTox_TestMix_AMSMS.mzML; highlight it and select 
the Open button. This closes the file Open dialog box and the Select MS/MS Input File dialog box is now visible. Select 
the OK button in this dialog box. The data file will have components deconvoluted and each component searched as a 
function of the process will be processed. When complete all the windows of the Chromatogram tab view will be 
populated. 

Check the Filter Bar to make sure the settings are the same as shown below. This should result in the Title Bar at the 
top of the display showing:  

where nHits = 93, shows number of components identified. 

With the Filter Bar set as described above, the upper left window will contain a reconstructed total ion current (RTIC) 
chromatogram and a number of clear circles (). Each  represents a found component (Hit). The first  on the left 
is larger than the others and colored (green, by default). This corresponds to the first item in the Hit List window (lower 
left) which is highlighted.  

 
Figure 24. Filter Bar for Chromatogram tab view with the Tandem Spectrum type selected. 

Nota Bene: In the RTIC Chromatogram window, the vertical position of the  representing 
a component (if the Best Hits option is selected)  is the MS1 area of the XIC associated with 
the identification. If the Best Hits option is not selected, the  represents an MS2, with the 
intensity being that of the MS2 spectrum. In both cases, the vertical position is relative to the 
most abundant in the chromatogram. The RTIC chromatogram’s peak-heights are the sums 
of all MS1 abundances for each MS2 spectrum. 

As stated in the MS Search Help file, with Best Hits selected, the Y-axis abundance of each ID is the area of 
its XIC (extracted ion chromatogram) of the MS1 intensity of its precursor ion and isotopes. When not selected, the 
abundance is that of its MS2 spectrum. In neither case does the Y-abundance exactly match its TIC abundance (if 
there is one) on the right axis. The TIC sums all MS1 electrospray ions associated with an LC-separated component. It 
therefore depends on peak width and abundances of all ions associated with the component. These in-source ions 
may often be observed as well-defined co-eluting columns of XIC identifications.   

The first checkbox in the Filter Bar is labeled Reload on Startup. Unless selected, the currently viewed results will not 
be redisplayed when MS Search is closed and then reopened. The results can be restored in such a case by use of 
Main Menu selection File/Reopen MS/MS Results. This results in the display of the Reopen MS/MS Results dialog 
box. Highlight the name of the file to be restored and select the OK button and the previous results obtained by 
processing that particular file will be displayed. 

The second checkbox (selected above) is the Best Hits label. The highest scoring identification of any chromatographic 
XICs will be the only designated components highlighted. This results in more reliable quantitative results and can reduce 
background ions or repeated identifications of chromatographic peaks that are multiply sampled. The number of 
duplicated IDs for a component can be shown in the nSpec column of the Hit List window (only accessible when the 
Include Expert Results checkbox is selected in the Hit List page of the Chromatogram Properties dialog box). 

To the right of Best Hits label is a checkbox next to the Only IDs label. Select this. This allows only the display of spectra 
that match a NIST Tandem Library spectrum regardless of score. Unidentified spectra are given names beginning with 
NoID_<precursor m/z>). Selecting/deselecting this checkbox will result in the nHits value in the Title Bar changing. 

Following the Only IDs checkbox is the Highlight Score label to the left of a dropdown list box. Some of the s in the 
RTIC chromatogram window are now filled (yellow, by default) and some are clear. Only the ones with an identity Score 
of 500 or greater are filled, the remainder are clear, i.e., the only components represented by filled s are the ones that 
have probably been identified. If the value is changed, the nHits value in the Title Bar WILL NOT change.  



  

NIST  26 MS Libraries and Search Program v.4.0 Page 35 

Following the Highlight Score dropdown list box in the Filter Bar is the Bkgd label followed by another dropdown list 
box. The background is the maximum percent of signal allowed for the appearance in the Hit List. This can be important 
in eliminating the influence of background ion sampling. In the example the setting is Any. The value can be changed 
by selecting the dropdown arrow on the right side of the list box to the right of the Bkgd label. Changing the value will 
result in the nHits value in the Title Bar changing. 

The penultimate selection on the Filter Bar is Filter Scores. Selecting the checkbox to the left of this label allows the 
filtering of lower quality spectra at three levels. These are selected from the dropdown list box that becomes active when 
the checkbox is selected. There are three options available (Weak, Average and Fixed). The Fixed option allows the 
elimination of all IDs below a specified Score. The use of the Non-Filtered Score is based on four different quality 
factors (bkgd, purity, max2min, and isotope analysis), all of which may be optionally viewed in the Hit List. The value 
for the Fixed selection is entered through a dropdown list box to the left of dropdown list box used to specify the level of 
filtering. This box becomes active when the checkbox next the Filter Score label is selected but only pertains to the 
Fixed selection. In this example, the Filter Scores checkbox is deselected and the values in the dropdown list boxes 
are not relevant. Selecting this checkbox and setting values in the two dropdown lists will result in changes in the nHits= 
value in the Title Bar. 

The last filter is the absolute threshold (Ab. Threshold to the left of a dropdown list box) setting. The values run from 
0.001 to 1.0%, with an Auto setting which will set the value based on the data. Changes to the setting will cause the nHit 
= value in the Title Bar to change. The setting is 0.5% for this example. 

After making sure the values set in the Filter Bar are set to those shown above and nHit = 117 is displayed in the Title 
Bar, sort the Hit List by Score. This is done by placing the Mouse pointer on the Score column header in the Hit List 
and clicking the left Mouse button. A  symbol preceding the column title will appear indicating the sort is from high to 
low.  

Nota Bene: The Hit List can be sorted by any column. Place the Mouse pointer on the column title and click 
the left Mouse button. If the column is not sorted, this will sort it in descending order, and a  symbol will precede 
the title. A second click of the left Mouse button will reverse the direction of the sort (increasing order), and a  
symbol will precede the title. 

The Lib ID (primary name in library) for the first Hit will read Phencyclidine, with a Score of 954. Scroll down the Hit 
List and compare the butterfly plots in the Component/Library Match Plot window. When a Plot window match is 
observed that is not good, put the Mouse pointer on the  in the RTIC chromatogram window or leave it on the entry 
in the Hit List window and click the Right Mouse button to display the RMB menu. Selecting the Send To menu option 
XIC Browser will open what appears to be a new program; the XIC Browser which can provide information about the 
component that may aid in confirming the identification. For this example, select item 11 (3-phenylbutan-1-amine, Score 
747). The component spectrum can be sent to the Spec List of the Lib. Search/Librarian tab view, which will not bring 
either into focus, or searched using the current Library Search Options, which does bring the Lib. Search tab view 
into focus. If the components shown are a subset of a Hit List, the Show All selection restores the view from which the 
subset was selected. 

 
Figure 25. XIC Browser. 
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Searching of Imported Spectra (Lib. Search tab view) 

 
Figure 26. NIST Mass Spectral Search Program Initial View. 

[In this manual Selecting means to place the Mouse pointer an object and click the left Mouse button once.] 
The NIST Mass Spectral Search Program v.4.0 is multifaceted. It has capabilities far beyond the comparison of a 
measured spectrum of an unidentified compound against NIST Mass Spectral Libraries, or those of a third-parties. MS 
Search works with different types of spectra [Electron Ionization (EI), Product-ion (LC-MS and LC-MS/MS)], both integer 
and accurate m/z values. Above (Figure 26) is the view when the Program is started for the first time after running 
SETUP.EXE from one of the two NIST 26 Installations (EI or Tandem).  
The Program opens in the Lib. Search tab view (six tabs on the bottom of the MS Search Program Window, each with 
a different function). Spectra of individual compounds are listed in the Spec List (upper left window). These compounds 
are shown in the Names display (the left-hand tab at the bottom of the Spec List window). The window can be changed 
to the Structure display (if structures are associated with the spectra) by selecting the Structure tab at the bottom of 
the window. If no structure is associated with the spectrum and the Formula (elemental composition) field is populated, 
that will be displayed. If this field is not populated the space will be blank in the Spec List display. 
If either the NIST 26 EI or the NIST 26 Tandem installation was performed, the Spectrum Type based on the type of 
mass spectral data (EI or Tandem) being worked with is selected by default. This Select Spectrum Type on the File 

menu is only needed if both types of data are being used.  
If using both types of spectra, from the File menu (upper left of the display on 
the Main Menu Bar) choose Select Spectrum Type (next to last selection in the 
File menu shown on the right). Selecting this will result in the display of a dialog 
box shown on the left. The three options are EI, Tandem, and Any. Whatever is 
selected will affect what options will be offered when the Program is being used. 
The Spectrum type is determined by selectiong the radio button next to its name. 

If the NIST EI Installation is performed, three libraries will be avaiable: mainlib, replib, and nist_ri. If the NIST Tandem 
Installation is performed, three libraries are available: apci_msms_nist, hr_nist_msms, lr_nist_msms. Libraies to be 
searched are selected from the Libraries page of the Library Ssearch Options dialog box (displayed by selecting 
Library Search Options from the Main Menu’s Options menu or by clicking on the Library Search Options button  
on the Lib. Search tab view’s Button Bar, just above the Spec List. See Figure 26. If both the EI and Tandem mass 
spectral data have been installed, the appropriate libraries for the selected Spectrum Type should be selected before 
performing searches. It should be remembered that whatever libraries are in the Included Libs: window of the Libraries 
page (Figure 27) of the Library Search Options dialog box when the Septum Type is selected will be the libraries used 
for the search until the list is manually changed or changed by restoring an INI file. Changing settings or adding user-
libraries, may be a reason to save configuration INI files. Saving and restoring INI files is discussed later. 

Optionally Displayed 
Displayed by Default 

Spec List 

Hit List Selected Hit List 
Bar graph Spectrum 

Selected Hit List 
Spectrum Text Information 

Compare window 

Text Information Related 
To Selected Spec List Entry 

Hit Histogram 
Distribution of Hit List 

Match Factors 

Position of Splitter Bar Can 
Be Changed to Horizontal 

Bar graph Spectrum Related 
To Selected  

Spec List Entry 

Position of Splitter Bar Can 
Be Changed to Horizontal 

Title Bar

Main Menu

Toolbar 
Optional

Button Bar

Status Bar

Names of all libraries searched & Σ spectra searched 

Six tabs used to bring different aspect of the Program into focus
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Figure 27. Libraries page view of Library Search Options dialog box after both  

EI and Tandem Libraries Installed. 
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First Action in the Lib. Search tab view 
A good place to start is with a single 
spectrum in the Spec List (upper left 
of the Lib. Search tab view); when the 
program is installed, different spectra 
will appear in the Spec List 
depending on the Spectrum Type 
installation. The following pertains to 
the EI Spectrum Type. The Spec List 
allows for the display of multiple 
columns (left-to-right) containing 

position # of entry, Source (Src.) information related to each selection of the spectrum source [Edit, Mainlib, Replib, A 
imported from TXT (MSP or MSPEC) file (which could include 3rd party applications), aa user-library short name], MW 
(Nominal Mass), Formula (element composition), and Name (primary library name).  
Select the name of one of the compounds (Cocaine) in the Spec List window. Selecting the entry in the Spec List will 
cause it to be highlighted. The bar graph spectrum along with the structure (if associated with the spectrum and the  
Structure on Plot option has been selected in the Spec List Plot page of the Library Search Options dialog box) of 
the compound will appear in the left part of the of the window to the right of the Spec List. If the spectrum has a Formula 
associated and no structure, the Formula will appear in the window. If there is no structure nor Formula, only the 
spectrum plot will be displayed. 

This window has the Spec List tab (bottom of the window on right side) 
selected. The right side of this window contains Text Information 
(metadata) pertaining to the compound. The top line of the Text 
Information window contains the Name (mainlib name or primary name 
given to spectrum). If the entry was from a spectrum exported by AMDIS or 
the data analysis software of an instrument, the name would be related to 
the spectrum, such as the data file name, the spectrum number, and other 
items the exporting source has determined is relevant. The Spec List 
entries are from the NIST Libraries; therefore, the next line is the Formula 
(elemental composition), if associated with the spectrum. The third line has 
MW (nominal mass), if associated with the spectrum; Exact Mass 
(calculated value from the monoisotopic masses of compound’s elemental 
composition), if entered a CAS# (Chemical Abstracts Services registry 
number); and, if provided with the spectrum, the NIST# (a unique number 
assigned to all spectra provided by NIST and only associated with spectra in a NIST Library). If a non-NIST spectrum is 
assigned a CAS# but has no associated structure, and there is an NIST spectrum with that CAS#, the NIST structure 
will be displayed on the plot of that spectrum. This third line of text in the Spec List Text Information window will always 
include the ID# (position in List or Library) and DB: (name of spectrum source). The next line contains the Comments 
(misc. information) or the Contributor (source of the spectra in the NIST Libraries). If a structure is associated with the 
spectrum the next line contains the InChIKey, (a unique text string that describes the structure). The following lines 
contain Related CAS# (NIST Library Spectra only), 10 largest peaks:, and Synonyms (a list of other names for the 
compound when available, which are displayed as a column (default) or changed to a wrapped display by making a 
change in the Library Search Properties dialog box’s Spec List Text Info’s page. The Library Search Properties 
dialog box is displayed using the Right Mouse Button menu (RMB) with the Mouse pointer in the Spec List Text 
Information or Plot window. Synonyms not only contain chemical names, but there are also trade and commercial 
names. Other DBs are non-mass spectral databases where the compound is listed. The Other DBs field is unique to 
NIST spectra. Retention Index information (EI spectra only) is also displayed. The InChIKey is a hot link which will 
result in a Google Search for the compound in the default Internet Browser. Prior to NIST 23, this linked to PubChem. 
Other information can appear on subsequent lines with the number of m/z Values and Intensities pairs on the 
penultimate. The last lines contain a list of the individual m/z value and intensity pairs; the specific format is described 
later. The fields available in the Spec List Text Information window are also available in the Hit List Text Information 
window. A new feature in NIST 26 is the Show Structure floating window with the structure of the selected Hit, initiated 
from Main Menu’s View menu. 

  

 
Figure 28. Spec List page of Library 

Search Properties dialog box. 
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Nota Bene about Chemical Abstract Services (CAS) registry numbers and the NIST\EPA\NIH Electron 
Ionization (EI) Mass Spectral Library: A significant number of spectra in this library have not been assigned 
CAS#s. This does not mean these compounds do not have CAS#s assigned by the Chemical Abstracts 
Services. It means, for various reasons NIST has not assigned them. 

Nota Bene about Show Structure selection from View menu in the Lib. Search tab view: If an entry is 
selected from the Spec List window, the structure, even if associated will not be displayed. The last selected 
entry in the Hit List will continue to be displayed until a new selection is made in the Hit List. 

 
Figure 29. Fully Populated Lib. Search tab View Resulting from an EI Normal Identity Search of the Spectrum. 

For spectra from the NIST/EPA/NIH EI Library, below the header Experimental RI median ±deviation (#data), is a list 
for up to three different column types (Semi-standard non-polar DB-5 Standard non-polar DB-1, and Polar DB-WAX) 
if there is experimental RI data in the NIST GC Method/Retention Index Database. An example is: Semi-standard 
non-polar: 2198±2 (9) which means the deviation from the average of 9 values is ±2. Below this is the header Estimated 
non-polar retention index (n-alkane scale), The value has a Confidence interval (explained later). 

Nota Bene: Some non-NIST mass spectral libraries will have a field labeled Experimental RI median 
±deviation (#data). The information under that heading is usually something like Unspecified xxx±N/a (1). 
This is usually an estimated value that has been inserted and not a measured value. 

The Estimated non-polar retention index (n-alkane scale) label follows. A value will appear for any spectrum with a 
structure in the NIST Library, third-party and user-libraries. Beginning with NIST 20, a new type of estimated Retention 
Index was also displayed. This is the AI predicted non-polar retention index (n-alkane scale), where AI is an 
abbreviation for Artificial Intelligence. This is unique to the NIST/EPA/NIH EI Mass Spectral Library. This value has 
proven to have a better comparison to the measured values and will be discussed later in this manual. The is a value 
for semi-standard non-polar (SSNP) columns (DB-5). Following that is the header Retention Index, under which (by 
default) the first two GC Method/RI listings from the nist_ri database appear. This gives not only the RI value but also 
the GC method and a citation to the source of the method from which the RI value and the GC Method were taken. The 
number of citations displayed is adjustable on the Hit Text Info page of the Library Search Properties dialog box. 
These citations can be searched for keywords using the Find selection on the RMB menu displayed in the Hit List Text 
Information window. Display of the RI (experimental and estimated) can be dismissed by a de-selection of the GC 
Retention Indices checkbox on the Hit Text Info page in the Library Search Properties dialog box. 

On the right side of this Text Information windows for the Hist List and the Spec List displays is a scroll bar. Pulling 
the scroll bar up or down reveals information not currently visible in the window.  
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Search the Spectrum 
First, verify that the settings are correct. Select the  button (Library Search Options). This will display the Library 
Search Options dialog box. If the Search page is not selected, select it. Make sure the radio button next to the Identity 
label is selected and the label in the dropdown list box under the label reads EI Normal. Next, select the Libraries page. 
Make sure the mainlib and replib are the only entries in the lower (Include Libs:) window. If other names are present, 
highlight them and click on the  in the Title Bar. If the mainlib and replib are not in the lower window, highlight them 
in the upper window and use the >>Add>> button to select them. Once these settings are verified, select the dialog 
box’s OK button to close the dialog box. There are several ways to initiate the spectrum search: 

1. Put the Mouse pointer on the compound name in the Spec List and double click the left Mouse button. 
2. With the Mouse pointer on the Go button ( ), click the left mouse button to search the highlighted spectrum. 
3. With the spectrum highlighted in the Spec List, and the Mouse pointer in the Spec List, Spec List Plot, or 

Spec List Text info window, click the Right Mouse button and select Library Search from the RMB menu. 

This will fully populate the Lib. Search tab windows as shown in Figure 29. The lower left window is the Hit List. To 
the right of that is a split window containing the graphic display of the first Hit List spectrum (left) and the Tabular 
information (metadata) for that compound (right). As different entries in the Hit List window are highlighted, the 
display in the two windows of the Hit List compound window will change.  
The center-right window is a graphic display comparing the selected Hit List spectrum (lower portion) with that of the 
searched spectrum. The display of this window can be turned on and off by selecting View from the Main Menu and 
then selecting/deselecting Compare pane. The display in the Compare pane (window) also changes as different items 
in the Hit List are selected.  

The Compare window has four different display options: Head to Tail, Side by Side, Difference, and Subtraction. The 
different displays are selected by selecting the labeled tab at the bottom of the Compare window and clicking the left 
Mouse button. Each of these displays will be explained in more detail later in this manual. 

The Hit List has four numeric values starting with the third column: Match, Reverse Match, PSS.Match (introduced in 
v.3.0 with NIST 23), and Prob. %. The Match Factor (1 – 999) is calculated based on a comparison of all peaks (m/z 
values and relative intensities) in the searched spectrum and the library spectrum. The Reverse Match Factor is a 
match factor calculated disregarding any peaks in the sample spectrum that are not in the Hit List spectrum. The Partial 
Spectrum Search Match is a Match Factor calculated disregarding any peaks in the library spectrum not in the sample 
spectrum. The Prob% is a value indicating whether the searched spectrum has been identified. This value is used in 
conjunction with the InLib = xxx value shown in the Title Bar of the Lib. Search tab view. Understanding these two 
values is explained in the section on search algorithms and they are only displayed when a Normal EI Identity search 
is performed when the Spectrum Search Options Method is set to Full Spectrum Search (Score). Before exploring 
the various Library Search options, review the Example Searches section on page 102. 

By default, the Hit List is sorted from high to low March Factor. The higher the value of the Match Factor, the more 
likely the Hit spectrum and the searched spectrum are due to the same compound. As a general guide, 900 or greater 
is an excellent match; 800–900, a good match; 700–800, a fair match. Less than 600 is a very poor match. However, 
spectra of unidentified compounds with many peaks will tend to yield lower Match Factors than similar spectra with 
fewer peaks. The Prob. (%) value and the value for the search (InLib, located in the lower right corner of the Hit List 
window and on the Title Bar of the Lib. Search tab) require more explanation; however, the lower the % Prob., the 
greater the number of similar spectra in the Hit List. When searching the spectrum of o-xylene, the % Prob. for the 
various isomers and ethylbenzene will be low because of the similarity of the four spectra for the four different 
compounds. The confidence level for a match is described later in the manual. The Reverse Match Factor is a good 
indicator of a spectrum representing more than a single compound. If a high value (higher than that of the MF) of a Hit 
that is seen lower in the Hit List and is associated with a somewhat low MF, that Hit should be considered as possible 
one of more than a single compound represented by the searched spectrum. The difference between the searched 
spectrum and the Hit can be shown in the Compare window by selecting the Subtraction tab. The RMB menu selection 
Library Search can then be used to search results. 

The Hit List window can be sorted by any column in either ascending or descending order. Place the Mouse pointer on 
the column header title and click the left Mouse button once. A  symbol will appear in the header showing that the sort 
is in descending order. Click the left Mouse pointer and the direction of the sort reverses showing a  symbol to indicate 
an ascending sort. The header used for the sort will have a  or  symbol on the left side of the column depending on 
the direction of the sort. Selected lines in a Hit List or Spec List can be copied into the Windows Clipboard in tab-
separated text format, by highlighting the desired lines and then pressing the Ctrl+K keyboard keys. Selected lines of 
the Hit List or Spec List can be copied to a Text File or to the Windows Clipboard using items on the RMB menu with 
the Mouse pointer in the Hit List or Spec List. Selected spectra in the Hit List can be exported to an MSP or MSPEC 
file with a selection on the RMB menu.  
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Customize Appearance of the Lib. Search tab view 
Put the Mouse pointer on the Hit List window, lower left of the Lib. Search tab view, click the Right Mouse button to 
display the RMB menu (shown on left below). Selecting Properties from this menu results in the display of the Library 

Search Properties dialog box (shown on 
the right). The first task is to change the 
Font to something that better fits the 
display being used. The default Font is 
Microsoft Sans Serif, Regular style, Size 
10 pt. 
Select the Select Font button of the 
Library Search Properties dialog box. 
This opens the Font dialog box. Select 
the desired Font (e.g., Arial), Font Style 
(e.g., Regular), and Size (e.g.,12). Then 
select the OK button. The Font dialog 
box closes and returns to the display of 
the Library Search Properties dialog 
box which was still displayed but 
underneath the display of the Font dialog 
box.  

The next step to consider is the setting of all the windows of this tab 
view to the same font just selected. This is done by selecting the Set 
for all views button (just to the right of the Select Font button). This 
causes a confirmation dialog box to be displayed with a message and 
Yes and No buttons. To change the font in all the windows of this tab 
display, select the Yes button. This action closes the confirmation dialog 
box and returns the view to that of the Library Search Properties dialog 
box. Selecting the OK button of the Library Search Properties dialog 
box causes dialog box to close. The Font changes are now visible in all 
of this tab view’s windows. 
When EI spectra of unidentified substances are searched, there are 
several columns it may be desirable to add to the Hit List window. The 
default columns are: # (order number; the   next to the numeral means 
there are replicate spectra for this compound); Lib (abbreviated to two 
characters with Short Library Name checkbox selected); Match (Match 
Factor, always displayed); Prob% (if these is a spectrum in the library for 
the unidentified compound, this is the probability that it has been 
identified); and, Name (the primary compound name assigned to the 
library spectrum). Other columns that may be useful in determining if the 
Hit is correct, are the R.Match (a Reverse Match Factor calculated after disregarding any peaks in the searched 
spectrum that are not in the library spectrum; this is useful when the searched spectrum is of more than a single 
compound), and the Experimental Retention Index value from the NIST GC Method/RI Database, when available. If 
experimental RI data are not available when the Semi-Standard Non-Polar column type has been selected, the 
Artificial Intelligence estimated RI value is displayed. If another column type has been selected, and there is not an 
Experimental Value, the field will have a dash (-). These and other columns can be displayed based on selections in 
the Library Search Parameters dialog box’s Hit List page. The selection window (which has a scroll bar) is under the 
label Items to Display. In addition to these two additional column titles, MS Search also can display the columns for 
No. Synonyms (the numerical value for the number of synonyms associated with the Hit List compound) and No. Other 
Dbs (the numerical value for the number of non-mass spectral databases that the Hit List compound is in). The higher 
these two numbers, the more common the compound. More common compounds may have a higher probability of being 
the correct identification. This list of available displays has been changing over the last few releases and should be 
carefully explored. 

Several of the selectable items are specific to a certain type of search. These search types are listed to the right of the 
selectable item. The columns that are displayed by default can be specific for the type of search being performed. The 
Column headers for the Identity Normal EI search are different than those for a Similarity EI Hybrid search. This will 
be explained in more detail when reviewing specific types of searches (see Example Searches on page 102). 

Once all additional column headers have been selected, select the OK button of the Hit List page of the Library 
Search Properties dialog box. The desktop now has a different appearance. Most notable is the Hit List window. See 
below, a before and after example of changes to the Hit List window. 

 
RMB menu displayed 
with Pointer in Hit List. 

 
Library Search Properties dialog box as 
displayed by selecting Properties with 
Pointer in Hit List window. 

 
Font dialog box displayed by selecting 
the Select Font button on the Library 
Search Properties dialog box. 
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The next step is to adjust the column widths in the Hit List and Spec List windows. Place the Mouse pointer between 
two of the column titles on the Hit List window Title Bar. The pointer changes shape. Holding down the left Mouse 
button and dragging to the left or right results in a change in column widths. The results are shown in the two views of 
the Hit List above. The position of any column in the Hit List can be changed by putting the Mouse pointer on the 
Column header while holding down the left Mouse button and dragging the pointer to the desired new location. An 
important thing to remember is that many of these changes can be reversed by selecting the Set default layout button 
( ) on the Tool Bar. Items such as font and thickness of peaks in bar graph spectra will not be restored. 

Now try a different configuration. Put the Mouse pointer in either the top or bottom window on the right side of the Lib. 
Search tab view and display the RMB menu. From the displayed RMB menu, select Change Splitter Orientation. Next, 
select View on the Main Menu Bar at the top of the display. Deselect (use Mouse pointer to remove the  mark) the 
Compare window and Status Bar (the text information at the bottom of the Program’s desktop).  

Not all RMB menus are the same. Display the RMB menu for each of the windows and each of the two panes of the two 
Spectrum/Text information and Plot windows (right side of the display, top and bottom). Multiple configurations and 
the Change Splitter Orientation RMB menu selection are not avaialbale for the Chromatogram and Compare tab 
views. There is a Change Change Layout button ( ) in the Button Bar of the Lib. Search, Other Search, Names, 
and Librarian tab views. This will cycle through multiple layouts for thse tab views. 

Splitter Bars 
Each tab view has sliderbars, which allow changing the size and shape of the various windows for that tab view. Put the 
Mouse pointer on one of the bars (verticle or horzional) that consititues a window. If the Mouse pointer image changes, 
this is a splitter bar. The changed pointer will have either a horinontial or verticle orentation, which tells you the direction 
it can be moved. In the defalut configurations, there is a verticle silder bar in the Lib. Search, Other Search, Names, 
and Librarian tab views, that seprates the two halves. Figure 30 is an example of where the splitter bar separating the 
Hit List window and the Histogram window was moved to only show the names of the libraries and total number of 
spectra searched in the Histogram window.. This allows for more of the 100 Hits to be displayed in the Hit List window. 
The Fonts were changed. The width of the mass spectral peaks were changed and the Rention Index column header 
was added to the Hit List. 

 
Figure 30. Lib. Search tab view after, changing Fonts, adjusting Column widths,  

adding Hit List Column headers, and splitter bars positions. 
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Figure 31. Lib. Search tab view after changing splitter orientation and adding Hit List columns. 

Figure 32 is the same search results after selecting Change Splitter Orientation from the RMB menu and moving 
horizontal splitter bars to no longer display the Text Information window for the searched spectrum. Figure 32 shows 
the same display as Figure 31 with the Compare window closed by use of the splitter bars and the Toolbar and Status 
Bar options being deselected from the View menu. The Toolbar contains many useful buttons, and it is recommended 
that it always be displayed. 
The display Title Bar for the Lib. Search tab view will contain the type of Search performed and the Presearch used, 
the InLib value for the search, and the number of Hits found. The maximum of Hits is 100 if the Presearch is set to 
Default or Fast. If the Presearch is set to Off, there can be as many as 400 Hits. 

 
Figure 32. Lib. Search tab view after closing display of Compare window  

and Changing the Splitter Bar orientation. 

Selecting the  button in the Toolbar ( ) will cycle through three different 
configurations of the Lib. Search, Other Search, Names, and Librarian tab views. The vertical bars separating the two 
sides of the various windows can be moved to provide more convenient views. The horizontal bars on each side of the 
vertical bar can be repositioned such as that shown above, on the left, where Histogram window has been minimized 
to allow for more Hit List information to be displayed. 
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Zooming Graphic Windows 
Any spectrum plot display in any of the six-tab views can be Zoomed by placing the Mouse pointer in the window 
containing the display, holding down the Left Mouse button, and dragging the pointer to form a box around what is to be 
magnified. The pointer will turn into a magnifying glass  icon. An un-zoom is accomplished by selecting Zoom Out 
from the RMB menu displayed with the Mouse pointer in a Plot window. Another way to zoom out is to place the Mouse 
pointer in a zoomed Plot window and double click the left Mouse button. In tab views with multiple graphics windows like 
the Lib. Search and Compare tab views. All graphic windows of spectra will be zoomed and un-zoomed together. 

NOTE on Behavior of Dialog boxes 
The NIST MS Search Programs uses several interactive dialog boxes. Some of these have multiple pages as seen in 
the Library Search Options dialog box. In order to cause changes in these pages, the dialog box must be closed by 
selecting the OK button. All changes in all pages will be in effect when the dialog box is closed by selecting the OK 
button. The next time the dialog box is displayed, the page visible at the time of the exit using the OK button will be 
displayed. If the Cancel button or the  at the upper right corner of the dialog box is used, the page display when the 
dialog box was opened will be displayed when reopened. 

More on the Spectrum Search 
The default Search for the EI Spectrum Type is the Identity\EI Normal search of the mainlib and replib libraries. The 
default search for the NIST 26 Tandem Library installation is the Identity\MS/MS search of the hr_nist_msms and 
lr_msms-nist libraries. When a Spectrum Type is selected, the currently selected libraries DO NOT automatically 
change. Information on other ways of comparing an EI mass spectrum of an unidentified compound and those in the 
NIST\EPA\NIH and other libraries like the Wiley Registry of Mass Spectra Data and using the NIST Product-ion libraries 
of LC-MS/MS data are explained in more depth later in this manual. 

The Library Search Options dialog box’s top page is labeled Search. The 
most often used Spectrum Search Type for EI (GC/MS) data is Identify/EI 
Normal. There is a dropdown list box under the heading Spectrum Search 
Options near the top of the page. By default, the Full Spectrum Search 
(Score) is selected. The second option is Impurity Tolerant Search (Rev-Dot). 
This is what was called Reverse Search in previous versions of MS Search. 
When this is selected, the Hit List is automatically sorted by the Reverse Match 
Factor. There is a third option (Partial Spectrum Search (PSS-DOT)) which is 
explained elsewhere in this manual but results in the Hit List being sorted by 
the PSS.Match column. In this section is a checkbox next to Compound 
Ubiquity Correction label. This is a NEW feature in v.4.0 of MS Search used 
to enhance the Match Factor of more common compounds, when selected. If 
the Hit has a high Compound Ubiquity Index (CUI), its Match Factor will be 
increased. When dealing with an unknown spectrum and two have almost 

identical Match Factors, the one with the higher CUI is the more likely candidate. As used in MS Search, the CUI is a 
citation index that reports the number of 58 diverse chemical collections containing the compound. This is described in 
the literature6. 

Another important feature of the Lib. Search tab view is the ability to perform either a structure similarity search or 
an exact structure search. Both structures and spectra can be pasted from the Windows Clipboard into the Spec List 
window. After copying a structure in a MOL file format or a spectrum as a text file in the MSP/MSPEC format onto the 
Windows Clipboard, the RMB menu, with the Mouse pointer in the Spec List window, is used to copy either to the Spec 
List window. The appropriate selections are: Insert Clipboard Structure or Insert Clipboard Spectrum. 

Structures associated with spectrum-displays can be put onto the Windows Clipboard by 
using the RMB menu and selecting Copy Structure to Clipboard when the Mouse pointer is 
on either a text or graphic view of a spectrum or the Hit List or Spec List. Structures can also 
be put on to the Windows Clipboard from most third-party structure drawing programs using 
the copy command in these programs. With the structure on the Clipboard and the Mouse 
pointer in the Spec List window, display the RMB menu and select Insert Clipboard 

 
6 Deborah F. McGlynn, Lindsay D. Yee, H. Martin Garraffo, Lewis Y. Geer, Tytus D. Mak, Yuri A. Mirokhin, Dmitrii V. Tchekhovskoi, 
Coty N. Jen, Allen H. Goldstein, Anthony J. Kearsley, and Stephen E. Stein* “ New Library-Based Methods for Nontargeted 
Compound Identification by GC-EI-MS” J A Soc. Mass Spectrom, Vol 36/Issue 2, 389 – 299  
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Structure. This results in the displayed dialog box shown on the previous page. After making the desired edits, select 
the OK button to add the structure to the Spec List. To perform a structure similarity search, highlight the entry in the 
Spec List and then click on the  button.  

The libraries to be searched are specified in the page labeled Libraries in the Library Search Options dialog box. (See 
right side of Figure 33.)  

The libraries used for a structure similarity search are specified separate from those specified for a spectrum search, 
even though they can be the same libraries. If no libraries are selected for the spectrum similarity searches, all sections 
associated with this task will be grayed. If a structure is associated with a spectrum in the Spec List, selecting the  
button will perform a Structure Similarity Search. To perform an exact structure search, copy the InChIKey shown 
for the structure in the Text Information window to the Windows Clipboard. Select the Library Search Options button 
( ). Then paste InChIKey to the text entry box next to the InChIKey label in the Search page of the Library Search 
Options dialog box in the Presearch area. Select the radio button to the left of the InChIKey label. Select the OK button 
in the dialog box and then select the  button in the Button Bar, with any spectrum highlighted. Unlike the Structure 
Similarity Search, this uses the libraries associated with a spectrum search. 
When a structure is put into the Spec List, it is assigned an InChIKey, which is displayed in the Text Information 
window of the selected Spec List entry. 
There are four Presearch selections on the Search page of the Library Search Options dialog box, each with a radio 
button. Just under this is a radio button to the left of the InChIKey label. Selecting this will cause whatever Presearch 
radio button is selected to be deselected. If the field to the right of the InChIKey label is left blank, the InChIKey of the 
structure of the selected spectrum in the Spec List will be searched. The spectrum will not. This is a search for a 
matching structure in the libraries being searched, which were selected for the spectrum search of the page labeled 
Libraries. This is the exact structure search. This only works for Spec List entries of spectra with structures and for 
structures only. If a structure similarity search is attempted on a spectrum with no structure, no Hits will be found.  
The RMB menu for all windows in all tab views have a Library Search selection except for the two Plot windows in the 
Chromatogram tab view. These two windows and the Compare windows in the Lib. Search and Compare tab views 
are the only windows in MS Search that do not have Structure Search as a selection on the RMB. 

CAUTION 
It is easy to create problems when settings are made in the Library Search Options dialog box’s 
Search page for a specific type of operation. It is a good idea to check the setting in this dialog box 
frequently to avoid errors in results. This is especially true when the Use Constraints box is checked. 

 
Figure 33. Libraries (left) and Search (right) pages in the Library Search Properties dialog box for the Any 

spectrum type. The RI (GC) page not available for Tandem spectrum type: MS/MS page not available for EI.  
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Presearch 
Searching large numbers of spectra can take some time. One of the ways is to prepare a list of good candidates and 
then search only those spectra, peak by peak (m/z value and relative intensity). MS Search has two ways of performing 
a presearch. One is Default and has proved very effective with few missed identifications. The other is the Fast way 
which reduces the presearch time but can have a higher error rate. It is recommended to always use the Default 
Presearch. The third radio button is Off. This will perform a peak-by-peak search of all spectra in all selected libraries. 
This can be time consuming. The Default and Fast Presearch results in a maximum of 100 Hits. The Off Presearch 
will give a maximum of 400 Hits. The last Presearch option is Mass(Da). This will only search spectra that have the 
nominal mass entered in the box following the label. This presearch is only selectable for the EI spectrum type. 
Constraints 

In the lower part of the Search page of the Library Search Options dialog 
box is the  Use Constrains selection. The Hit List of any library search 
(search of a sample spectrum against spectra in various mass spectral 
libraries) can be limited to exclude spectra that have various properties, 
Constraints. These constraints are set on the Constrains page of the 
Library Search Options dialog box. This same Constraints page is the 
second page on the Sequential Search dialog box displayed in the Other 
Search tab view. When MS Search is being used with EI spectra, these 
constraints are MW(Nominal Mass), Exact Mass, Name Fragment, 
Elements Value, Elements Present, Peaks, and Tages in Comments. 
When searching Tandem data, there are additional constraints: MS/MS 
Charge, Peptide Number of Residues, MS/MS Instrument Type, and 
MS/MS Precursor Type. The EI constraints are explained in the following 
Other Search tab view section under the Sequential Search heading. 
The additional Tandem constraints are explained later in this manual. 
The constraints are listed in a window, with a scroll bar on the right side, 
near the top of the page. Each has a checkbox () to the left of the 
constraint label. When a check is put in one of these boxes, the checkbox 
next to the Use Constraints label (at the top of the page) is automatically 

selected, as is the checkbox next to the Use Constraints label on the lower part of Search page. Unchecking either, 
automatically unchecks the other. The unchecking of either of these Use Constraints checkboxes does not uncheck 
the box next to the individual constraints in the window with the scroll bar. Before setting any constraint, it is best to 
select the Clear All button at the top of the Constraints page. The Clear All button deselects all the individual 
constraints and the two Use Constraints checkboxes; however, the settings within these individual constraint pages 
remain. If an individual constraint is subsequently selected, make sure the settings are those desired for the new search. 
If the Use Constraints checkbox is reselected and there are selected individual constraints, those selected constraints 
will be used. Next to the Clear All button is a label, Selected X, where X is the number of selected constraints.  

Selecting the checkbox next to the label for any individual constraint in the scroll-down list window will result in 
highlighting the constraint’s name and an appearance change of the lower part of the Constraints page to be relevant 
to the selected constraint. The individual constraint’s page can be brought into focus without selecting it by selecting the 
title rather than the checkbox. Even if information is changed in the new Constraints’ page, the selection will not be 
used until the checkbox next to its label is selected. 

Order for Search Results 
By default, the Library Search Hit List is ordered starting with the best Hit regardless of what library the Hit is from. 
There is no need to be concerned about the order of libraries in the Includer Libs: window of the Libraries page of the 
Library Search Options dialog box. The window does have        buttons used to move the position of the library. These 
are not necessary for a Library Search. In the case of the Other Search tab view, the order can be important. Libraries 
are searched in the order they appear in the list. Some of the Other Search options, limit the number of Hits that are 
displayed. If that number is exceeded before all the libraries are searched, then Hits may not be observed for the 
remainer of that library and subsequent libraries. 

 
Figure 34.Library Search Options 

Constraint page Exact Mass Selected.  
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Other important Information with respect to dealing with the Lib. Search tab view 
Another important new feature of v.4.0 is additions to the RMB menu. 
When the Mouse pointer is in a Hit List window of any tab view the 
RMB menu will appear as shown here. It is now possible to copy 
selected lines from any Hit List (except that in the Names tab view) to 
the Window Clipboard from the RMB menu. It is also possible to create 
a text file that can be pasted into Excel. In addition, a selected spectrum 
can be sent to the Names tab view (which also brings it into focus). 
There have been other undocumented features added to v.4.0. 
Previous users should explore all the Main Menus of all tab views as 
well the RMB menu of all windows of all tab views.  

Other Search tab view 
The NIST mass spectral data, third-party libraries of mass spectra, and user-libraries can be searched using several 
other methods besides submitting an unidentified mass spectrum. These are the Other Searches, carried out in the 
Other Search tab view. Just like the Lib. Search tab view, this view can be customized in the same way through 
Properties dialog boxes displayed by selecting Properties from the RMB menu when the Mouse pointer is in any of 
the three windows. The RMB menu command, Change Splitter Orientation, and the Change Layout and Set Default 
Layout buttons are also available in this tab view. 

The other ways to search mass spectral libraries (selected by a drop-down list 
box to the right of the   button) are by: MW (Nominal Mass); Exact Mass; 
Formula (elemental composition); MS/MS/ Precursor m/z (only available when 
the Spectrum Type is Tandem or Any), Any Peaks (explained in detail later in 
this manual); Sequential Method (combining different search criteria to create a 
focused search); CAS (Chemical Abstracts Services) Number (registry number); 
NIST Number (a unique identifier number given each spectrum in the NIST 
archive); and ID Number (the position of a spectrum in the library being 
searched). The MW, Exact Mass, MS/MS Precursor m/z, Formula, Any 
Peaks, Sequential, and CAS Number searches allow the simultaneous use of 
multiple libraries. MS Search will allow for up to 127 libraries. The NIST Number 
search is only used with libraries distributed by NIST. The NIST Number search 
can search all NIST Libraries at once. The ID Number search can only search a single library at a time. The MW, Exact 

Mass, MS/MS Precursor m/z, Formula, Any Peaks and 
Sequential searches can be restricted with respect to several other 
properties. These are viewed by selecting the Constraints page in 
the Type Search dialog box for an individual search. Some, but not 
necessarily all, constraints are available for each of these search 
types. Each search type has its own dialog box named Type Search, 
e.g., MW (Nominal Mass) Search. The Constraints page for each 
of these search types is the same; however, unavailable constraints 
are grayed in the scrollbar list box. For example, MW, Exact Mass, 
Element Values, and Elements Present are not available for a 
Formula search. 

An easy way to experience the use of the Other Search tab view is 
to perform a Formula search. After having made any desired 
appearance changes using the Properties dialog box displayed 
from any window (Hit List window [vertical list on left of the Other 
Search tab display]; Spectrum window [top right window], or Text 
Information window [lower right window]) select the down arrow 

button on the right of the list box just above the Hit List window. This causes a dropdown menu to be displayed with up 
to nine items. Select the Formula option. This results in the two-page Formula Search dialog box being displayed. The 
Constrains page is displayed by default. At the upper left is a checkbox next to the Use Constraints label. Make sure 
this is unchecked. For safety, click on the button labeled Clear All. All searches can be constrained. Constraints are 
explained in detail under Sequential Search. This first use will not involve Constraints. Select the Options page. This 
allows the selection of the libraries to be searched. For this example, the only entry in the Include Libraries window 
should be mainlib. 

 
Formula Search Dialog Box. 

 
Types of Other Searches 

when Spectrum Type is EI. 
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Nota Bene: Sometimes the replib (NIST EI library of spectra which are in the mainlib but are from other 
sources) is not selectable for searches conducted in the Other Searches tab view. To view these spectra, 
select the Replicates On/Off button (  ) in the Button Bar or for an individual compound, select the ⊞ on 
the left of the # in the Hit List. This keeps the replib spectra with the mainlib spectra. 

There is a text entry box just to the right of the Enter Chemical Formula label in both the Options and the Constraints 
pages of this dialog box. Enter a simple formula, e.g., C6H6. Select the Search button at the bottom of the dialog box. 
The three windows of this tab view (Hit List, Plot, and Text Information are populated (Figure 35). 

The most powerful of these Other Searches is the Sequential Method Search. This search allows all libraries in the 
NIST MS Search format to be searched in multiple ways. It may be necessary to re-index older user libraries and 
third-party libraries. This is done with the Tools menu on the Main Menu bar. 

An undocumented feature is the ability to search for a specific InChIKey using the Sequential Search. Put the InChIKey 
in the input area of the Name Fragment. All other selections should be cleared first by clicking on the Clear All. 

 
Figure 35. Appearance of the Other Search tab After the Formula Search has been Executed. 

Other DBs in the Hit List and Text Information windows 
It has long been understood that when two Hits in a search of an unknown spectrum against mass spectral libraries 
have close Match Factors, if one is found in several non-mass spectra databases and the other is not, the one with a 
presence in other (non-mass spectral) databases is the more likely candidate to be the mass spectrum of the unknown. 
This is also true for the number of Synonyms of the two Hits and when one of the Hits has replicates in the NIST\EPA\NIH 
EI Library and the other one does not.  

After the release of NIST 14, NIST started looking to other non-mass spectral databases than the nine listed in the Other 
Databases constraints tab (no longer present). The Other Databases List has been expanded to seven Classes: 
Wikipedia, Contaminants, Drugs, Environmental, Food, General, and Metabolite. The specific category is listed in the 
Text Information Window for an individual Hit under the Heading Other DBs. Under each of these categories are the 
names of the actual database where the compounds are found. Hit List, when the DBs column header is displayed in 
the Other Search and Lib. Search tab views, will have a number that is the total of other non-mass spectral databses 
where the compound is found. In the Other_DBs.pdf file (found in the NIST26\MSSearch folder). a total of 59 Generic 
Titles has hot-links to the corresponding Internet sites. Hold the <ctrl> key and click on the link to display this file. The 
source Excel spreadsheet is also included (Other_DBs.XLSX). Information can then be checked in these non-mass 
spectral databases about individual compounds. Other DBs information is only available for NIST provided libraries. 
The Other DBs field will not appear with metadata of user-libraries produced by MS Search or from third parties.  
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Figure 36. The Text Information window display in the Name Search Tabe where the other DB has been 

selected for display in the Text Info page of the Name Search Properties dialog box. 

Search Results vs Order of List of Libraries 
Unlike the Library Search tab view Hit List, the Other Search tab view Hit List is ordered according to the order of the 
libraries in the Options/Libraries page windows of the Type Search dialog box. The MW (Nominal Mass) search is 
limited to a maximum of 2,000 Hit. The Any Peaks Search and Sequential Search are both limited to 6,000 Hits. If the 
maximum number of Hits is reached before all libraries are searched, it is possible that some Hits from libraries lower 
on the list will not be reported. To make sure all Hits are accounted for; it may be necessary to search a few libraries or 
only a single library at one time. 

Names tab view 

 
Figure 37. Names Tab View for a NIST Library in MS Search v.4.0. 

One of the major changes to v.3.0 of the NIST Mass Spectra Search Program was the Incremental Name Search when 
using the NIST provided libraries. The purpose of the Names tab view is to search any single library and retrieve the 
mass spectrum and metadata of an individual compound using the primary name or any associated synonym. This new 
variation of the Names Search is only with NIST provided Libraries (NIST\EPA\NIH EI and NIST Tandem). The previous 
Name Search still works with other types of libraries and is automatically invoked when one of those libraries is selected. 
It has always been possible to display spectra from the NIST replicate library (replib) of EI spectra along with derivatives 
of a precursor, diastereomers, or isotopic labeled variants; however, this has been tedious and sometimes confusing in 
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previous versions. Details of the Names tab view are explained later in the manual and should be reviewed in detail. 
This just gives an overview and a brief explanation of the Incremental Name Search as it pertains to NIST-provided 
Libraries. The display for NIST-provided libraries is shown in Figure 37. 

The default settings for the Increment Name Search require that names with numeric and special character prefixes be 
entered into a Text Entry box just above the Left upper window. It is not possible to type Greek alphabet character such 
as β, σ, or γ. They need to be spelled out, e.g., β-pinene would be typed as “betapinene”. If β-pinene is pasted into the 
text entry field, it will appear as “BETAPINENE”. Another important issue is characters such as -, ’, etc., are not 
recognized and are not allowed in the text entry field. Previously, the text entry field allowed only 16 characters. Version 
3.0 of MS Search expanded this to 256 characters. All names (the mainlib name and all synonyms) are displayed in 
ascending alphabetical order as the name is entered. No matter whether characters are entered as uppercase or 
lowercase, the echo in the Text Entry box will be uppercase. 

More generic searches can be performed by selecting the  button to the right of the name text entry box. When this 
button is selected, numerical and special characters are not accepted when typed. A good example would be if 
“2pentaone” is typed, the 2 will not appear in the text entry field and the list will contain all the isomers of pentanone (2- 
and 3-). If this button is not selected, the 2 does appear and all compounds that begin with 2pentanone would be listed. 

The default behavior of the Names tab view is to update the displayed mass spectral data as each character is typed 
(all windows in the tab view). Displaying the Name Search Properties dialog box, with the RMB menu, selecting the 
Incremental page in the dialog box, and deselecting the checkbox next to the Automatically display selected 
spectrum label will change the behavior. The changed behavior is that after the name is entered in the text field, it will 
be necessary to put the Mouse pointer on the desired name in the upper Hit List window and double click the left Mouse 
button. The behavior and appearance of the windows that make up the Names tab view, can be customized by use of 
various selections of pages in this dialog box. 

When searching an NIST Library, the left side of the Names tab view is made up of an upper and lower window. 
Compound names are displayed in the upper window. These are all the names associated with a given spectrum, e.g., 
the primary name (mainlib name) or synonyms. Links to a selected spectrum appear in the lower window. If a synonym 
is entered, the mainlib spectrum for that compound will be displayed with the plot of the spectrum and in the Name: field 
of the Plot and Text information windows. An example would be to enter the name “SKELLYSOLVE”, and the displayed 
Plot window name would be “Pentane” and the Name: field would have Pentane in the Text Information window. 
“Skellysolve A” would appear in the list of Synonyms in the Text Information window, depending on the settings in the 
Text Info. page of the Name Search Properties dialog box. 

Compounds in the upper list can be displayed as names in a text form or structures by selecting the appropriate tab 
(Names or Structure) at the bottom of the window. 

The lower window functions in different ways depending on the NIST Library Type being searched (EI or Tandem). If 
the EI Library is being searched, the lower window will contain all spectra with the highlighted spectrum in the upper 
window. The first entry in the list has the name spectrum and is highlighted. The displays in the Plot and Text 
Information windows are the same as those for the highlight spectrum in the upper window. This is followed by a list of 
one or more replicates (spectra of the same compound but from a different source, which are found in the replib) if 
there are multiple spectra for the compound. As each entry in the lower list is highlighted, the displays in the windows 
on the right-side will change. The highlight in the left-side upper window remains in its original position.  

Select the Clear button to the right of the Text Entry field on the far left of the display. This will clear the Text Entry field. 
A good example for the EI Library is to enter NAPHTHALENE in the Text Entry field, after making sure the mainlib 
appears in the dropdown list box to the right of the  button. If something else is listed, select the down arrow on the 
right side and select mainlib from the displayed list. By default, mainlib is the first item in the list. This compound has a 
mainlib spectrum (spectrum) and four replib spectra (replicate 1, replicate 2, replicate 3, and replicate 4). Following 
that are four listings, each with the name InChI isomer, isotope. These are spectra of different isotope variants of 
deuterated naphthalene (1 D atom, 2 D atoms and a mainlib and replib spectrum of a perdeuterated variant). 
Another good EI example to enter is ACETOSALICYLICACID. The name in the Hit List (top left window) is Acetosalic 
Acid. The name under the spectrum plot (middle window) and in the Name field of the Text Info window (far right) is 
Aspirin (which is the mainlib name). Acetosalic acid is a synonym for this compound. The position of the horizontal 
splitter bar has been changed to vertical using the Change Splitter Bar Orientation selection on the RMB menu 
displayed with the Mouse pointer in the Plot or Text Info window. This compound has a mainlib spectrum and four 
replicate spectra (in the replib). In addition, this left lower window has 16 labels that begin with “precursor +” followed 
by the name of the derivatizing agent(s) and, the number of individual agents added to the precursor molecule if >1. 
Both mainlib and replicate spectra for any compound will be listed. 

This view of the Text Information window in the Names tab view (Figure 38) allows for a clear observation of Information 
pertaining to the Retention Index (RI) of the compound. There is experimental RI data for more than a third of the 
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compounds in the NIST 26 EI Library. These come from the measurement of spectra by NIST and/or the literature. When 
experimental data are available, these are presented for as many as three different types of GC columns. The number 
following the column type under the title Experimental RI median±deviation (#data) is an average for the measures of 
the RI value with its deviation and the number of measurements that make up this average. The two predicted RI values 
are also shown. The display of Synonyms and Other Databases has been deselected. 

All GC Methods for all four of the RI values used in the composite are listed under the heading Retention index. Each 
method can be brought into focus using the scroll bar on the right side of the Text Info window. If the Synonyms were 
displayed, it would be seen this compound has 157. 

 
Figure 38. Names Tab View for the search of SALICYLICACID in the NIST/EPA/NIH Electron Ionization Library. 

The display has been altered from the default by selecting Change Splitter Orientation from the RMB menu 
with the Mouse pointer in the Spectrum window and hiding the display of Synonyms and Other DBs. 

Below the Experimental data is a label that reads: Estimated non-polar retention index (n-alkane scale): This is a 
value that is calculated based on the structure associated with the spectrum. There is a value for this field regardless of 
the spectrum being in an NIST Library or a user-library such as the Wiley Registry of Mass Spectral Data or a user-
library created with MS Search. The only requirement is that the spectrum has an associated structure. 

Below this estimated value is a label that reads AI predicted non-polar retention index (n-alkane scale): This is a 
value that pertains only to spectra in the NIST/EPA/NIH EI Mass Spectral Library and is calculated based on the structure 
and measured RI values of spectra in the current library and the NIST archive. This value has been found to be closer 
to experimentally measured values than the RI values calculated based on structure alone. 

Below the AI predicted RI value is a heading entitled Retention Index. Below this heading are the details of the GC 
method when the various RI values were measured. By default, only the first two methods are listed. The number of 
methods listed or specifying all methos be listed can be set in the Text Information windows Properties dialog box 
displayed from the RMB menu with the Mouse pointer in the window.  

If <…> appears after the last listed GC Method/RI value, additional GC Methods/RI sets can be displayed. 

Instructions for Spectrum and Name searches of the NIST Tandem Libraries follow. 

Search by Spectrum for the NIST Tandem Libraries 
Product-ion mass spectra obtained by MS/MS are referred to as MS/MS spectra in MS Search. There are three libraries 
of product-ion mass spectra provided in the Tandem Installation. These are named apci_msms_nist (precursor ions 
formed by atmospheric pressure chemical ionization) and, hr_nist_msms and lr_nist_msms (precursor ions formed 
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by electrospray ionization, ESI). There are two possible ways to search a measured ESI product-ion mass spectrum 
against either or both hr and/or lr libraries when the spectrum has a known precursor ion: Identity MSMS or Similarity 
MSMS Hybrid. These two searches are explained later in the manual. These same two searches can be used with the 
apci_msms_nist library. These libraries can also be used in the identification of accurate mass spectra produced by in-
source CAD, which are spectra without a specified precursor ion: Identity HiRes NoPrecursor. In addition to using the 
NIST provided product-ion libraries, user-libraries can be built using product-ion spectra obtained from in-source CAD 
techniques associated with APCI. DART, DESI, and product-ion spectra obtained by MS/MS. Instructions on building 
these user-libraries are provided later in this manual. There are also third-party libraries of product-ion mass spectra 
produced by ESI, like the MoNA (MassBank of North America, https://mona.fiehnlab.ucdavis.edu/) LC-MS/MS library, 
which can be used with MS Search when properly formatted. 

Some searches require settings in the MS/MS page of the Library 
Search Options dialog box (Figure 39). 

MS/MS, MS/MS Hybrid, and HiRes NoPrecursor options: 
Search m/z Tolerance: 
Precursor: ± 0.015-100,000 ppm or 6x10-5 – 500 m/z units (for MS/MS 
search only) 
Product-ion: ± 0.015-100,000 ppm or 6x10-5 – 500 m/z units. 
Note: For Low Resolution library (LR_*) product-ions tolerance is fixed 
at unit mass resolution. 

If a library name begins with LR_ (Low Resolution), for its spectra the 
entered tolerance T is replaced with max(T, 0.45 m/z) for all product-
ion peaks unless peptide scoring is selected, e.g., if T=4500 ppm, 
tolerance will be increased to 0.45 m/z for m/z < 100. 

When searching with high mass accuracy spectra, the NIST low 
resolution library (lr_nist_msms) is searched using wide m/z tolerances 
(unit mass resolution). This ensures that compounds with only low-
resolution spectra can be found when searching with high mass 
accuracy spectra. If searching with low resolution spectra, simply 
specify a wide m/z product-ion tolerance for searching any library. 

If the \MSSearch folder is examined for folders and the Tandem Library has been installed, two folders containing 
accurate m/z spectra will be observed (hr_nist_msms and hr_nist_msms#2). The need for these two files is due to 
programming limitation. When using v.4.0 of MS Search, you will only see the name hr_nist_msms. The two files are 
combined within the software. 

Name Search of NIST Tandem Libraries 
When the list of selectable libraries is viewed in the dropdown list box 
of the Names tab view, there is only one listing for the two ESI 
product-ion mass spectral libraries provided by NIST (hr/lr NIST 
Tandem). This listing contains all the names (primary compound 
name and synonyms) for the hr_nist_msms and lr_msms-nist 
libraries. All names are searched at once. The top window on the left 
side is a list of all names in the two libraries. The lower window is a 
list of all spectra associated with that name. Type the name Cocaine 
in the text entry box on the far left. If the  button right side of the 

 button has a blue background, numerals and symbols will not 
be excepted. To enter numbers and symbols the button must have a 
white background. Type “2HYDROXY”. The highlighted name will be 
2-Hydroxy-10,11-dihydro-5H-dibenzo[a,d]cyclohepten-5-one.  
The Plot window will show the spectrum is in the hr_nist_msms 
library. The first 11 entries in the lower window will be [M+H]+ HCD 
xx% P=225.1. This says that a protonated molecule with an m/z value 
of m/z ~226.1 (m/z 225.091) was analyzed in a higher energy collision 
cell (HCD, Thermo Scientific Elite Orbitrap Elite) at xx% (collision energy). The Text Information window will show the 
Collision_energy: field with 30% 13eV (actual energy). Each of the next 10 items in the list on the lower left of the 
Names tab view will represent different collision energies. The next item has (LR) at the end. This means the spectrum 
is in the NIST low resolution Tandem Library (lr_nist_msms). The IT means the analysis was done using a quadrupole 

 
Figure 39. MS/MS tab in Library Search 

Options dialog box. 

 
Figure 40. Settings to display m/z values 

and formula  

https://mona.fiehnlab.ucdavis.edu/
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ion trap instrument. The next five items have the form [M+H]++>xxx.x IT 35% P=131 (LR). These are MS3 spectra 
where the precursor ion (m/z 131 for the first item) is an MS2 fragment from the precursor of the compound (m/z 225.091). 
The 35% is related to the NEC. 

The MS3 IT spectra are followed by spectra measured on an Orbitrap at different collision energies using the [M – H]- 
ion as the precursor ion. There are Orbitrap positive-ion spectra where the precursor ion is due to the loss of a C6H6 
molecule from the protonated molecule. These spectra are followed by other precursor formed by various losses from 
the pronated or deprotonated molecule. 

 
Figure 41. Names tab view for one of the spectra associated with 2-hydroxy-5-dibenzosuberone 

The Plot window for the Tandem Libraries has the option of displaying the m/z values and/or chemical formula of the 
labeled ions. Using the tabs at bottom of right side windows, the display can be changed between the Plot and Text 
information windows or just the Plot window by selecting either the Plot/Text or Plot tab, Figure 41. 

 

Figure 42. Names tab view for one of the spectra associated with 2-hydroxy-5-dibenzosuberone  
in the Plot only view 



  

Page 54  NIST 26 MS Libraries and MS Search Program v.4.0  

The Replicates/Related selection on the Options menu displayed by selecting 
Options on the Main Menu (third item) has no effect on the Names tab view 
searches. This selection primarily impacts EI Library searches and some searches 
performed in the Other Searches tab view of NIST libraries and NIST user-libraries. 
The functionality is described in more detail later in this manual or by selecting Help 
in the Replicates Display Options dialog box.  

Compare tab view 

 
Figure 43. Compare tab view. 

The Compare tab view has two modes of operation, selectable from a dialog 
box displayed by selecting Select Compare Mode from the Options selection 
of the Main Menu in the Compare tab view (shown on left). If Selected Spectra 
is selected in the dialog box, the Compare tab view clears. When a search is 
executed in the Lib. Search tab view and the Compare tab view is brought into 
focus, the Compare tab view will remain blank. Select the Lib. Search tab view 
and highlight one or more spectra in the Hit List window, issue the RMB menu 

command with the Mouse pointer in the Hit List window, and select Send To\Compare List. The focus automatically 
switches to the Compare tab view which has the three sections (queried spectrum, Compare window, and a list of three 
of the selected spectra). If more than three spectra were selected, the scroll bar at the right of the lower display can be 
used to bring them into focus one at a time. If a subsequent search is executed and the focus is switched to the Compare 
tab view, the display will be the same as resulted from the previous Send To\Compare List command. Switch the focus 
back to the Lib. Search tab view, highlight one or more spectra in the just generated Hit List, and issue the RMB menu 
Send To\Compare List command. The focus is automatically changed to the Compare tab view, and the display is of 
the required spectrum, Compare window, and the spectra selected at the time of the Send To\Compare List command 
(regardless of the number selected, a maximum of three at a time will be sent). 

If Hit List (Query/Compare/Hits) is selected in the dialog box, when a search is executed in the Lib. Search tab view 
and the Compare tab view is brought into focus, manually, the top spectrum will be that of the queried spectrum, the 
middle window is the comparison of the required spectrum, and the selected Hit (first one by default), and the lower 
potion shows the number of spectra corresponding to the number set in the Compare tab view’s Properties dialog box 
for display, The first x Hits will be the number of spectra sent to lower section, where x is he number set in the Compare 
Mode dialog box. If the focus is returned to the Lib. Search tab view, spectra selected in the Hit List window, and the 
Send To\Compare List command issued, the Compare tab view will automatically come into focus with the number of 
spectra set in the Properties dialog box visible, and all selected spectra in the lower section, visible via the scroll bar. 
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When sending spectra to the Compare tab view from the Lib. Search tab view, if they originate in the Spec List and 
the Spec List tab is selected in the upper multiple function Text/Plot window, the existing contents will be cleared, and 
subsequent sends will be prepended with those of the sent spectra.  

In addition to the functions of the Compare tab view described above, spectra (with or without structures) can be pasted 
into the top or bottom windows to perform manual comparisons. Details of how to do this are described later in this 
manual. 

The Librarian tab view 
The Librarian tab view is used for building and maintaining user-libraries. It is also used to associate structures with 
measured spectra for analysis in MS Interpreter. The details of how each part of this tab view works will be described 
later in this manual. 

Other Stuff 
There are detailed instructions provided for other features of the NIST MS Search Program in this manual. Make sure 
they are reviewed, especially the different types of searches and Constraints. In addition, there is important information 
in the Program’s Help file (Help\Help Topics). Select the Index tab on the NIST MS Search 4.0 Help file displayed by 
selecting Help Topics from the Help menu (Main Menu), enter General Points in the text entry box, and click on the 
Display button. This provides descriptions of Exact and Accurate mass, MW (molecular weight), and defines Short 
Cut keys such as the ability to copy the Hit List to the Clipboard as a TSV file searches and Constraints (see Constraints 
on page 46). 
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Guide to the Program 
The NIST Mass Spectral Search Program uses tab displays selectable at the bottom of the Program’s desktop.  
The tabs are: Lib. Search, Other Search, Names, Compare, Librarian, and Chromatogram 

Selecting a tab results in the display of a different tab view (Desktop Display). All tab displays have movable divider/slider 
bars (splitters), some of which can be re-orientated, as well as tabs associated with various windows within a tab view. 
Selecting Window/Tile Vertically or Window/Tile Horizontally from the Main Menu displays all the tab views on a 
single screen. Each tab view window has its own set of window control buttons (minimize         maximize/restore 

close  ). If one of the minimized buttons is selected, the window is no longer visible and a symbol for that tab 
view window appears at the bottom of the Desktop, just above the tabs for each tab view 

 
Selecting the maximize button on the symbol will restore that tab view of full screen. Selecting the restore button on the 
symbol at the bottom of the display for that tab view, will bring the tab view back to its original tab view position. If several 
of the tab views are closed, the remaining open tab views can be titled by selecting one of the two Tile options from the 
Main Menu’s Windows menu. Some Title Bars will have the name of the tab view displayed (Librarian, Name, Compare 
Tool). With any tab view in full screen display, selecting any tab at the bottom of the program will bring that tab view into 
full screen focus. 

The Individual Program tab views: 

Lib. Search  (Figure 23) used for all comparisons of spectra and/or structures to one or more libraries (maximum of 127 
libraries). 

Other Search, Exact Mass, MS/MS Precursor m/z, Formula (elemental composition), Any Peaks, CAS Number, 
NIST Number, and ID Number, all of which can be constrained. There is a wild card search (Sequential Method) 
which allows users to create a specific multiple-criteria search. These are described individually later in this manual. 

Names (Incremental Name Search) allows a name to be typed and have the program match the name. This search 
uses all names and synonyms in the specified library. It has unique features when searching NIST provided libraries. 

Compare for easy comparison between spectra. It is, by default, automatically refreshed with the latest spectral search 
of the library. Selected spectra can also be input for comparisons. 

Librarian keeps a history of the recent spectral searches. This tab view can also be used for import, editing, and user 
library construction. In some cases, the Librarian tab is referred to as the Spec List. The left-side vertical window in 
the Lib. Search tab is also called the Spec List. 

NEW in v.4.0 Chromatogram allows for the opening of chromatographic files (GC/MS or LC-MS/MS), finding individual 
components and identifying them against the library spectra (NEW in NIST 26) 

Alternate layouts can be selected using the Change layout button  in the Tool Bar which is just under the Main 
Menu. A Tool Tip (description of what an item does) is displayed when the Mouse pointer is placed over a Tool Bar 
button. There is also a Tool Bar button to restore the default layout  (Set default layout). Alternatively, Default 
Layout and Change Layout in the Window menu (selected from the Main Menu) may be used. 

There is a Right Mouse Button (RMB) menu that can be displayed from 
any window of any tab view. The function of the menu items will be explained 
throughout this manual. In every tab view, properties of the individual 
windows can be controlled by accessing the Properties dialog box from the 
RMB menu (last selection). These dialog boxes will have multiple pages. 
Each tab view has its own multiple page Properties dialog box like the one 
shown for the Lib. Search tab view’s Comp. Results page (Figure 56). The 
displayed page is dependent on the window where the Mouse pointer is 
displayed when the RMB menu is displayed. The pages on these dialog 
boxes control the information displayed in the tab view’s individual windows. 
The contents are self-explanatory. There is a Help button that will display 
more detail.  

Individual pages of the various Properties dialog boxes are displayed by 
selecting the page name in the left column of the dialog box. 

All tab views have the same Main Menu except for the Chromatogram tab view. 
They also have the same Toolbar . Some items will be grayed when not available. 
The various menu selections and Toolbar buttons available for each of these tabs are described in more detail 

 

Figure 44. Library Search Properties 
dialog box, Compare window page 
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throughout the manual. The display of the Toolbar can be turned on and off by selecting selecting/deselecting Toolbar 
from the View menu of the Main Menu. The Button Bar (Lib. Search, Other, Search, Names, and Librarian tab views) 
is below the Toolbar and is always displayed. It is composed of several buttons, each having its own Tool Tip. The Lib. 
Search, Other Search, and Names tab view have one or more dropdown list boxes, The Chromatogram tab view has 
a Filter Bar in place of the Button Bar. The Filter Bar for the Tandem and EI spectrum types are different.  

The File menu has Save Configuration and Restore Configuration selections which allow all the various tab display 
configurations to be saved to a specific file name and then recalled. Multiple users or those using both Tandem and EI 
spectrum types may have different ways of configuring each tab view that is best for them or specific tasks. Each user 
can restore a specific set of display options. This does not include data in the Search History. There is no change in 
the Search History or Spec List resulting from a Restore Configuration. Different configurations for different types of 
searches can be convenient. Selected libraries and search constraints are also saved. 

The File menu has a Select Spectrum Type option (New in NIST 23) which allows the type of spectrum (EI, Tandem, 
or Any) currently worked with to be specified. This results in some options of the Program being hidden depending on 
the Spectrum Type. These are options that do not pertain to the search of the selected Spectrum Type. The Any 
selection results in the display of all options. 

The Search selection on the Main Menu allows for quick selection of non-spectral type search. 
Depending on the choice, the selection will transfer you to the correct tab view and bring up the 
options for that search. 

The View option on the Main Menu (Figure 63) allows 
the on/off display of the Tool Bar and/or the Status 
Bar (bottom portion of which contains the For Help 
press F1 message on the left). There is an option to 
turn off the display of the Compare Pane window in 
the Lib. Search and Compare tab views in the View 
menu. NEW to v.4.0 of MS Search is the selection 

from the View menu, Show Structure (Figure 45). This results in the display 
of a floating fixed-size window with the structure and the name of the 
compound whose spectrum is being displayed. As different spectra are 
selected from a Hit List, the display is updated. Sometimes, when using MS 
Search with a small display, the automatic sizing of structure in displayed 
spectral plots will distort the structure and lead to an incorrect conclusion such as a bond repenting an attached free 
methyl as being attached to an N atom and forming a five-membered ring. This new feature will help to avoid that 
problem. 

Nota Bene about Show Structure selection from View menu in the Lib. Search tab view: If an entry is 
selected from the Spec List window, the structure, even if associated will not be displayed. The last selected 
entry in the Hit List will continue to be displayed until a new selection is made in the Hit List of Lib. Search 
tab view. In the Librarian tab view, as spectra are selected, structures will be displayed in the floating window. 

Another important note about structures is fact that when there is no structure associated with a spectrum and 
the Formula (elemental composition) field is populated, the elemental composition will appear in the floating 
Spectrum window or be displayed with the spectrum (when Structure on Plot is selected in an appropriate 
Properties dialog box) in lieu of a structure. If the Formula field of the Text Information window is not 
populated, there will be no display. 

In the Names tab view (of NIST Libraries) the structure associated with the just selected spectrum of either 
the upper or lower window of the Hit List will be displayed. 

The View menu also allows the display of Best matching only ON and OFF and is used to display the Derivative 
Precursor dialog box in the Lib. Search tab view. The Best matching also has a button ( ) in the Button Bar. When 
this is turned ON, the Hit List will only contain the spectrum with the highest Match Factor when several spectra with the 
same InChIKey were found. 

Tab views can be brought into focus by selecting the tab name. It is also possible to switch between tab views using the 
hot keys Ctrl-Tab (left-to-right) and Ctrl-Shift-Tab (right-to-left) 

Many of the controls for the appearance of the windows’ layout for individual tab views windows are similar to one 
another. These are covered in detail for the Lib. Search tab view but apply for most of the tab views. 
  

 
Figure 45. Floating structure 

window. 
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 The Chromatogram tab view 

 
Figure 46. Unpopulated Chromatogram tab view. Specifying a Spectrum Type Changes the Appearance 

The Chromatogram tab view allows chromatographic files (GC/MS and LC-MS/MS) to be processed. Processing a 
chromatographic file results in the selection of individual components in the file and provides a library search match 
against either EI or Tandem mass spectral libraries. Different routines are used for the two types of chromatographic 
data. Depending on the spectrum type selection, the File menu will have different selections. For Tandem files, selecting 
Analyze MS/MS Input File from the File menu displays the Select MS/MS Input File dialog box. For GC/MS (EI) files, 
Selecting Analyze EI Input File from the File menu displays the Select 
LowRes/Calibration Files dialog box. In addition, when the search type is EI the 
File menu has a selection which is used to process accurate m/z EI GC/MS data 
files (Analyze EI HiRes Input Files, which displays the Select HiRes 

Input/Calibration Files dialog box, not 
shown) These dialog boxes allow for the 
preparation of the various processes involved 
with each specific type of data and are used 
to execute the analyses. As can be seen from 
Figure 47, LowRes GC/MS files from multiple 
instrument manufacturers can be selected as 
well as netCDF files, which most 
manufacturers instruments data analysis 
software will produce. Tandem spectrum type 
allows Raw Files (specific to the Thermo 
Fisher instruments, *.raw), mzML Files (*.mzML, most manufacturers’ tandem 
MS/MS instruments data analysis systems all for the output of the file type), and 
tdf Files (specific to the Bruker tims TOF instruments *.tdf). HiRes EI file types that 
can be processed are Raw Files (*.raw, specific to Thermo Fisher GC Orbitrap), 
mzData (*.mzData), mzML Files (*.mzML), and CDF Files (*.CDF). 

 
Figure 47. LowRes File 
selection dialog box. 

  

  
Figure 48. Analysis settings 
dialog box for MS/MS (top) & 

LowRes EI chroma files. 
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Figure 49. The Select Input/Calibration Files dialog box for High and Low Resolution GC/MS Data 

As can be seen from Figure 49, the Select LowRes/Calibration Files and Select HiRes Input/Calibration Files dialog 
boxes are identical except for the Titles. Both have an AMDIS Deconvolution Settings, RI Settings, and Libraries 
buttons. The Analysis types for both are the same. Selecting the AMDIS button displays a dialog box with settings 
specific to the deconvolution of GC/MS data. 

Selecting the RI Settings button results in the display of a dialog box that 
allows the setting of the variation in the sample’s measured RI value and that 
of the library match, which is specified in a more qualitative way. 

The Libraries button causes the 
Libraries selection page to be 
displayed to allow the specification of 
the libraries to be used in the data 
analysis process. A maximum of 127 
libraries can be used. The Hits are 
based on the Score, not the order in 
which the libraries are searched. 

After selecting a file, and the Open button is selected, the File dialog box closes, and the file is processed. After a 
GC/MS file is selected and the Open button is selected, the Select Data File dialog box closes, leaving the Select 
Raw/Calibration Files box dialog displayed. When the OK button is selected in this dialog box, the file is processed. 

If the File\Open selection on the Main Menu is chosen with the tab view being other than Lib. Search, when the file is 
selected by highlining the name and clicking on the Open button, the focus will change to the Lib. Search tab view and 
display the import dialog box allowing the selection of the spectra to be imported. If Automation checkbox in the Lib. 
Search tab view’s Library Search Options dialog box’s Search page has been selected, the spectrum/spectra will be 
searched. If spectrum/spectra is/are sent to the Spec List (will be sent to both Librarian and Lib. Search tab views) 
using the RMB, the spectrum, unlike those that are imported through the Choose file for spectra/structure import 
dialog box will not be searched.  

When Library Search is selected from the RMB menu with the Mouse pointer in the Hit List window of the 
Chromatogram tab view, all highlighted spectra will be sent to the two Spec Lists and searched depending on whether 
the Automation checkbox in the Library Search Options Seach’s Search page has been selected. 

Nota Bene: If multiple spectra are searched at one time, the result for each search is available through 
the History List dropdown list box, which is in the middle of the Button Bar just above the Spec List 
window and below the Tool Bar (if displayed) in the Lib. Search tab view. Select the  ∨ button on the right 
side of the dropdown list box and then select the desired search. The display changes to the results of that 
search, including Plot/Text of Search Spectrum tab view of the split window next to the Spec List window 
(in default view). The chosen History number will not necessarily correspond to that spectrum’s number 
in the Spec List. If the spectrum searched is in the History List and has been deleted from the Spec List 
window, it will be displayed in the Plot/Text of Search Spectrum tab view of the split window when the 
spectrum is recalled from the History List. When a previously searched spectrum is recalled, the display 
of the Spec List window DOES NOT CHANGE. This behavior can be confusing. Care must be taken in 
drawing conclusion for the resulting display. 

Details of each window and the processes are explained beginning on page 22 of this manual. Other details are provided 
in the MS Search Program’s Help file. 
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Filter Bars and the Title Bar for the Chromatogram tab view 
The Title Bar contains the name and version number of the program, the Spectrum Mode (EI, Tandem, Any), the name 
of the data file processed, the type of processing (MS/MS {for both Hybrid and non-Hybrid} modes, and EI {for both 
HiRes & LowRes}), and nHits. The value for n is a function of both the settings in Filter Bar and the zoomed region of 
the Chromatogram window. 

 
Filter Bar for LowRes and HiRes EI Data. 

 
Filter Bar Regular MS/MS Search and Hybrid Search if Tandem Data Files. 

 
Desktop display of an expanded region of the Chromatogram tab view resulting from Enhanced Analysis MS/MS 
Hybrid routine with a selected component which has a Highlight Score >=800 and a Filter Score <800 (See 
MS/MS Chromatogram Window in on-line Help file (Search) while displaying Chromatogram tab view. The 
sample was commercial orange juice extracted with methanol, separation with 2.1mm C18 column (m/z range 
80 to 1200) on Thermo Fisher Lumos Orbitrap mass spectrometer (10 µL sample, analysis time 30 min). 
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Processing an LC-MS/MS (DDA) Data file using the NIST Hybrid Search 
When processing LC-MS/MS data files, either a conventional Identity Search can be carried out or an advanced search 
involving the conventional search and a Hybrid Search can be performed.  

Before initiating the Hybrid option of an Analyze MS/MS Input File, it is a good idea to move the slider bar between the 
Hit List and Structure windows of the Chromatogram tab view all the way to the right so that the entire lower part of 
the Chromatogram tab view is available for the Hit List. Several column headers beginning with H will appear in the 
Hit List as result of the operation which are selected by default but only appear in Hit List window when the Hybrid 
search is selected. The structure for Hits can be viewed using the Show Structures selection from the View menu of 
the Main Menu. This provides the floating Structure window. The hybrid Search function should be used with the 
hr_nist_msms Library  

To initiate the Hybrid Search of deconvoluted components, select the Hybrid Search (long run time) check box () in 
the Select MS/MS Input File dialog box displayed by selecting Analyze MS/MS Input File from the File menu displayed 
by selecting File on the Main Menu. Depending on the size of the data file, this can involve a long run time (~55 min. for 
the file shown below. It is suggested that this procedure always be run in the background (select  Run in background 
in the dialog box). If the Chromatogram tab view has the contents of a previous run displayed, that will remain until MS 
Search is instructed to display the results of the just completed process. During this process, the label Running 
Background will appear in RED in the Filter Bar of the Chromatogram tab view. Other features of MS Search can be 
used during this time. Once the file has been processed, the dialog box at the left will be displayed regardless of what 

tab view is currently displayed. If the Open selection is chosen on the dialog 
box, the display can take place in more than 30 to 60 sec. During the 
processing, the selections Analyze EI Input File, Analyze HiRes EI Input 
File, and Analyze MS/MS Input Files will be grayed (unavailable) on the 
File menu displayed by selecting File on the Main Menu. 

As seen in Figure 50, if the search results are displayed with a linear abundance axis, distinguishing components and 
their types can be difficult; therefore, it advantageous to show the abundance axis using a log scale (Figure 51) 

 
Figure 50. Processed LC-MS/MS data file using combination of Hybrid/Conventional Tandem Library Search 

with a linear abundance axis. 

 
Figure 51. Processed LC-MS/MS data file using combination of Hybrid/Conventional Tandem Library Search 

with a log abundance axis. Individual components are much easier to Identify. 



  

Page 62  NIST 26 MS Libraries and MS Search Program v.4.0  

Identified components are indicated by individual circles (). Colors are 
used to identify the classification of the component (, selected; , 
Highlighted; , Insource; , Hybrid; and , < highlight value) When the 
Chromatogram window is expanded the value of n in the Title Bar  is 
reduced to the number of components visible in the window and the Hit 
List window now only contains the Hits for the components shown in 
the Chromatogram window. See Figure 51. 

N

 
Figure 52. Hit List for Hybrid Search as displayed as a result of processing data  

using the Analyze MS/MS Input File. 

As can be seen in Figure 52, the Hit List for the Hybrid Search in Chromatogram tab view is very complex, as is the 
Hit List for the Hybrid Search in Lib Search tab view. 
 
Column Header Names Related to the Hybrid Search in LC-MS/MS Chromatogram Processing  
HdMass – Delta Mass from best matching hybrid search identification 
HScore – Best Hybrid Score 
HdForm – Chemical formula corresponding to HdMass 
HpctRelForm – Percent frequency of HdForm relative to most common -CH2- (100%) 
HPrec.Type – Precursor Type of library spectrum with highest hybrid score 
HName – Name of compound with best hybrid match 

Evaluation of Search results, especially when using the Hybrid Search in the Chromatogram tab view, can be facilitated 
by repositioning columns. This is accomplished by putting the Mouse pointer on the column header title and dragging it 
the right or left. Sizes of the column can also be adjusted. A good place to get a better understanding of using the Hybrid 
search in the Chromatogram tab view is in the On-Help file. Select Help from the Main Menu. From the Help menu, 
select Help Topics to display the Help dialog box. If the left panel is not displayed, Select the Show button in the button 
bar of the dialog box (first button on left with panel not displayed). This will display the panel. Select the Search tab, in 
the Keywords text entry box type MSMS, and then select the List Topics button to the right and under the text entry 
box. Then select MS/MS Chromatogram Window. The display will have the details of the Chromatogram tab view’s  

If the Lib ID and the HName are the same in the Hit List, this is a good indicator that the component has been identified 
as a good match. The Score, Hscore, DotProd, and Scored (Unfiltered) will be high (above 850) and close in value. 
If the HScore is high and Score is low, them the HName and HdForm should be explored as possibilities leading to 
Hybrid search ID. 
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Important Note About processed data in the Chromatogram tab view 
When MS Search is exited, the current results in the Chromatogram tab view of a 
processed data file are not reloaded when the program is restarted unless Reload on 
Startup  is selected in the Filter Bar. The results of each processed data file (GC/MS and 
LC-MS/MS) are stored in perpetuity until they are purposely removed whether this check 
box is selected or not. It is also possible to redisplay a previously proceeded data file (before 
closing MS Search or during a current processing session). Both the Reopen and Remove 
commands are accomplished with selections on the File menu of the Main Menu in the 
Chromatogram tab view using the Reopen and Delete selections for EI Results and MS/MS 
Results. If these actions are carried out during the processing of a data file, when the 

process is complete the Process result dialog box shown on page 61 will be displayed. 

The Restore and Delete actions are done 
using the File menu. is done from the File 
menu regardless of the Spectrum type but 
commands are specific for the Spectrum 
type. Just above, to the left is the File menu 
displayed when the Spectrum type is set to 
Any. The dialog box on the left is displayed 
if one of the Restore Results options is 
selected. The upper window of the dialog box contains a list of the names of 
processed data files. The lower window contains a list of options used in the 
processing of the data files. Be prepared to edit the columns displayed in the 
Reopened file’s Hit List. after a file is selected for Reopening. The dialog box 

on the right is displayed when one of the Delete Results selections is made from the File menu. Select the check box 
() next to the file to be deleted and then select the Delete button. If the Exit button is selected, without first selecting 
the Delete button, the dialog box will close, and the file will NOT be deleted. 
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Cautionary Statement About the Use of MS Search 
The NIST Mass Spectral Search Program is not maintenance free. By default, the results of each spectrum search 
performed in the Lib Search tab view, each search performed in the Other Search tab view, and the results of processed 
file in the Chromatogram tab view are automatically stored when the program is exited. This can result in the 
unnecessary use of valuable computer storage. The program can be configured to automatically delete the Lib Search 
and Other Search tab view’s Histories when the program is exited (settings in the Hit List and/or Spec List pages of 
the Library Search Options or the Hit List page of Search (Other) Properties dialog boxes of the Lib Search and 
Other Search tab views, respectively). These histories can also be deleted using the Clear history button ( ) in the 
button bar of either tab view.  

The Chromatogram tab view CANNOT be configured to be automatically deleted, and proactive actions must be taken 
by the operator to control the possible deleterious results of such storage. 

Lib. Search tab view 

 
Figure 53. Lib. Search tab view. 

The Lib. Search tab view is where a search of an individual spectrum or individual structure against mass spectral 
libraries is performed: user-libraries, and/or the NIST 26 Libraries. The spectrum and structure searches can be done 
against multiple libraries (maximum of 127), and the selected libraries can be different from those selected for the various 
searches found in the Other Search tab view. Spectra can be imported into the Spec List window from linked mass 
spectral data system software, text files containing one or more spectra in the NIST format (some other text file formats 
can also be used), from spectra on the Windows Clipboard as text files in the NIST format, or of components (product-
ion or EI) found in the Chromatogram tab view. 

Nota Bene: The NIST mass spectral file format is simply a text file that can be formed or edited using 
any text editor, such as Notepad. The layout of the file has specific requirements. These are separate 
for EI and Tandem spectra, specifically described in the Librarian section of this manual. 
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Files in NIST text formats are imported by selecting File\Open from the Main Menu. This results 
in the display of the Choose file for spectra/structure import dialog box being displayed. On 
the lower right portion of the dialog box, above the Open and Cancel buttons is a dropdown list 
box with the extension of most of the text files recognized by MS Search. The one that is missing 
is the *.TXT file. The *.TXT files will appear in the dialog box when the All Files (*.*) option. is 
selected. If emailing an NIST text spectrum, it is best to use the TXT extension or send as a ZIP 
or 7z file. 

The Spec List window is at the top left of the Lib. Search tab view. The Hit Histogram window 
is directly below the Spec List window, showing the 
distribution of Hits according to the Match Factor values, the 
names of searched libraries, and the total number of spectra 
searched. This Histogram window can be displayed with a 

linear or log vertical axis. The text at the top of this window is the names of the libraries 
searched, and the total number of spectra searched. The Hit List window is on the 
lower left directly below the Histogram window. It is important to note that in addition 
to the Hit position in the list, name of the library containing the Hit spectrum, a value 
for the match, and the primary name for each Hit, several other values may be 
displayed using settings available in the Hit List page of the Library Search 
Properties dialog box, which is display using the RMB menu. Hits in the Hit List 
window are listed according to descending Match Factor values (by default), 
regardless of which of the searched libraries they come from. 

On the right side of the single movable vertical splitter bar, going from the top to the bottom, are three separate windows. 
The top window is the Search Spectrum/Spec List Spectrum window which has three separate views. Each is brought 
into focus by selecting one of the three tabs at the bottom of the window. The first tab display is the Plot/Text of 
Searched Spectrum window. It is divided into two parts with a vertical splitter bar (Plot and Text Information). After a 
search, this view is automatically defaulted. The second display is that of the Plot of Searched Spectrum. This view 
only comes into focus when the tab is selected and shows just the bar graph spectrum of the last searched spectrum, 
no Text Information. The third view, Spec List, is automatically selected when an entry in the Spec List window is 
selected (highlighted). This view is divided with a vertical splitter bar. One side is the bar graph plot, and the other is the 
text information of the currently selected spectrum in the Spec List window. 

The middle window on the right side of the Lib. Search tab view is the Compare window. By selecting View from the 
Main Menu, the display of the Compare window can be dismissed; it may also be minimized using the horizontal splitter 
bar just above the Plot/Text of Hit windows. This window displays the plot of the currently searched spectrum and the 
selected Hit from the Hit List. There are four tabs: Head to Tail (search, red and Hit blue, default), Side by Side (ibid), 
Difference (left over by subtracting Hit from searched (green, by default)/leftover by subtracting searched from Hit blue, 
by default), and Subtraction (remaining when Hit is subtracted from search, green by default). The Subtraction is 
helpful when the searched spectrum may represent more than a single compound. The spectrum displayed when the 
Subtraction tab is selected can be searched using the RMB menu when the Mouse pointer is in the Compare window. 
Peaks colors for all tab views can be changed in the Compare page of the Library Search Properties dialog box when 
displayed from the RMB menu with the Mouse pointer in the Compare window. 

The bottom window is for the plot and text information (Plot/Text of Hit) or just the plot (Plot of Hit) of the selected entry 
in Hit List window. These views are selectable by tabs at the bottom of this window. There is no automatic switching 
between the two views. The view remains until changed back by selecting the appropriate tab.  

If the Mouse pointer is in the Search Spectrum/Spec List Spectrum window or the Hit List Spectrum window, the 
RMB menu option Change Splitter Orientation can be used to change the orientation (back and forth between vertical 
and horizontal) of the splitter bar between the plot of and text information for the spectrum. In all cases the RMB menu 
can be used to access the appropriate page in the Properties dialog box for each window within any tab view. 

Using the horizontal splitter bars between the three windows on the left side of the Lib. Search tab view allows the 
vertical size of these windows to be adjusted. This can be used to maximize the Hit List window’s vertical space to view 
a larger number of Hits without resorting to the scroll bar on the right of the window. The vertical splitter bar on the right 
side of the Hit List window of the Lib. Search, Other Search, and Names tab views can be used to increase the Hit 
List window’s width. The lefthand vertical window in the Librarian tab view contains the spectra listed in the Spec List 
window of the Lib. Search tab view. It is important to know that the Spec List window in the Lib. Search tab view and 
the Spec List window in the Librarian tab view is the SAME LIST. Spectra may be copied to and deleted from this Spec 
List window in either the Lib. Search or Librarian tab view. Actions taken in the Spec List window of either of these 
tab views are reflected in the other. The Hit Lists in the Lib. Search, Other Search, and Chromatogram tab views are 
read-only. If a spectrum is edited in the Librarian tab view, the edits will appear when that spectrum is viewed from the 

 
RMB menu displayed from 

the Spec List window. 

 
Recognized NIST 
mass spectral file 

extensions. 
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Lib. Search tab view. The Spec List window in Lib. Search and Librarian tab views and the Hit List window in the 
Lib. Search and Other Search tab views can be displayed as text or as graphic structures by selecting the Names or 
Structures tab at the bottom of the window. By default, limited text information is included with the structure display. 
This can be turned off using the Properties dialog box displayed using the RMB menu. If the structure display is selected 
for the Hit Lis or Spec List window and the spectrum has no associated structure, but the Formula field for the spectrum 
is populated, the element composition will appear in lieu of the structure. If the Formula is not populated, the block in 
the List that would normally display the structure/elemental composition will be blank. 

Shown in the figure on the previous page, on the right, is the RMB menu displayed when the Mouse pointer is in the 
Spec List window of the Lib. Search tab view. The RMB menus for all windows in all tab views are similar. Some items 
are self-explanatory, like Export Selected and Import, which open File dialog boxes. When a spectrum or group of 
spectra are exported to an existing file, the option to Overwrite or Append that file is offered. The items on the Send 
To submenu are self-explanatory. The Default Structure Editor is only on the menu if there is a default structure editor 
set up on the computer that has the NIST MS Search Program installed. Both structures (in the MOL file format) and 
spectra (in the MSP/MSPEC text format) can be imported from the Windows Clipboard. Structures, but not spectra can 
be copied from MS Search to the Windows Clipboard. One very important feature of the Spec List window (in the Lib. 
Search and Librarian tab views) and the Hit List window (in the Lib. Search and Other Search tab views) RMB menus 
is the ability to print the contents or view a preview of the print of the contents of either the Hit Lists or the Spec List 
windows. The purpose of the Properties selection of these RMB menus is discussed throughout this manual. 

Each Hit List window (except the one in the Names tab view) and the Spec List window can be sorted by ascending 
or descending order by clicking on the column name in the Title Bar at the top of the window. The Hit List windows in 
the Lib. Search and the Other Search tab views have optionally displayed columns. Three of these show the number 
of Synonyms, the number of Other Databases (non-mass spectral DBs) containing the compound and the Retention 
Index. The Hit List window (except for the one shown window in the Names tab view) can also be sorted by these 
columns (or other columns) by pointing to the column header and clicking the left Mouse button. The position of the 
columns on the Hit Lists can be changed by putting the Mouse pointer on the column title to be moved, holding down 
the left Mouse button and dragging the pointer to the desired position and then releasing the Mouse button. To restore 
to the previous position, the process must be repeated. 

Creating individual configurations to match a Library Search type or for individual user’s preferences is why the Save 
Configurations and Restore Configurations item was placed on the File menu. Additional information on items in the 
Properties dialog boxes, displayed by selecting Properties from the RMB menu, can be found by selecting the Help 
button in the Properties dialog box. 

Selected lines in a Hit List or Spec List can be copied into the Windows Clipboard in tab-separated text format, by 
highlighting the desired lines and then pressing the Ctrl+K keyboard keys. This only copies the contents of Hit List or 
Spec List window, not the entire spectrum. 

New to v.4.0 are the RMB menu selections Copy Select Hits to Clipboard and Export Select Spectra to Text File 
displayed when the Mouse pointer is in any Hit List or Spec List window (Lib. Search, Other Search, Librarian, or 
Chromatogram tab views). Items to be copied, that are heighted, are then exported to a text file and sent to the Windows 
Clipboard.  
Also new to v.4.0 is when a spectrum is sent to the Spec List using the RMB menu’s Send To\Spec List selection and 
that identical spectrum is already on the Spec List, of the tab view being sent to (Lib. Search/Librarian), that spectrum 
will be highlighted if that tab view is switched to right after sending. In previous version of MS Search, such circumstances 
resulted in the display of an error message. If multiple (more than 1) spectra are sent an error message will be displayed. 

In some cases, the Hit Lists will also have a  symbol in front of the Hit number. This 
symbol means that there are replicate spectra for that Hit. Selecting the symbol will 
cause a list of the replicates to appear below the Hit. Some of the names of the replicates 
will be preceded by R, and some by m or r. If an R precedes the name, the spectrum is 
of the same compound as the Hit (has same InChIKey) and is in the NIST replib Library. 
If the name is preceded by an m or an r it means that the replicate is a derivative, isotopic 
variant, or isomer of the Hit. If m, the spectrum is in the NIST mainlib and if r, the 
spectrum in the NIST replib. The display of spectra of derivatives and isomers as replicates of a compound is controlled 
through the Replicates Display Options dialog box (shown above) selected from Replicates/Related on the Options 
menu, displayed from the Main Menu. Details of how this works are found by selecting the Help button.  

Selecting View/Derivative Precursor menu opens the Show Derivative Precursor for dialog box (Figure 46). Selecting 
derivative type(s) affects Lib. Search tab view’s Hit List window’s structure display. The derivative precursors and the 
derivatizing agents are shown as separate item instead of the structure of the derivative. Only mainlib and replib hits 
are affected. Deselecting displayed derivative type(s) immediately changes structure display back to derivative. See MS 
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Search help topic "Show Derivative Precursor" for more details. Only one subtype per derivative type is allowed. Multiple 
derivative types can be selected. 

   
Figure 54. Select any one of the five Derivative type checkboxes; then select the subcategory radio button. 

In the Lib. Search tab view, the upper right window with a vertical splitter bar separating the Plot and Text Info windows 
for the Spec List/Searched spectrum has settable attributes that are found in the Properties dialog box described 
below. Displayed in the lower left corner of this Plot window is the origin of the spectrum (source name) and the primary 
name associated with the spectrum (also referred to as the mainlib name). The origin of the spectrum can be the “name 
of the library” from which the spectrum is from; “Text File” for spectra imported from outside sources; or, when an existing 
Spec List spectrum is displayed after closing and re-starting the MS Search, “Spec List”. Optionally, preceding the 
(source name), the Molecular Weight (nominal mass) of the compound, CAS registry, and NIST numbers (if the spectrum 
has one, if not only the CAS#), and Formula (elemental composition) can be displayed provided if these fields are 
populated in the spectrum’s record. This legend display can be forced to wrap so that all characters will be visible. Also, 
optional, a structure (if associated with the spectrum) can be displayed on the spectrum, if associated with the spectrum. 
The structure will be replaced by the elemental composition if the Formula field is populated, and no structure is 
associated with the spectrum. Labeling of the peaks is either by default or set on the Spec List Plot page of the Library 
Search Properties dialog box, which has a Label peaks greater than (%) option followed by a text entry box allowing 
for the input of a number. If the spectrum is to be displayed without peak labeling, enter 100 in this box or deselect the 
m/z Label option. It is also possible to use this page of this Library Search Properties dialog box to change the colors 
of the mass spectral peaks, scale, labels, bonds and rings in structures, atomic symbols in structures, and the spectrum 
background. Selecting the Set default layout button on the Tool Bar will restore colors to the original values. It is also 
possible to adjust the thickness of the mass spectral peaks. This value is not restored when the Set default layout 
button is selected. The Spec List Plot and Unknown Plot pages have the same selections; however, they are 
independent. 

 
Figure 55. Spec List/Unknown Plot page and Unknown Text info page of the  
Library Search Properties dialog box displayed in the Lib. Search tab view.  
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The Text Info side of this window, by default, is to the right of the portion displaying the plot of the spectrum. This 
orientation can be changed so that the Text Info window is just above the Plot presentation by using the RMB menu 
selection Change Splitter Orientation. In the other tab views where both the plot of the spectrum and the text 
information are displayed, these two windows are oriented, by default, with the Plot window above the Text Info window. 
Again, this orientation can be changed using the appropriate selection on the RMB menu when the Mouse pointer is on 
either of the two windows. The Unknown Text Info page of the Library Search Properties has options with respect to 
what text data are displayed. These options are identical to those on the Hit Text Info page. 

The Hit Text Info page (Plot/Text tab in some tab views) in the Plot of Hit pages of the Library Search Properties 
dialog box have the same selectable display options in the form of checkboxes as the Unknown Text Info and Unknown 
Plot /Spec List Plot pages. The mainlib name is the only thing displayed on the first line and is included as part of the 
display of the Compound Information. The second line of is reserved for the Formula (elemental composition), which 
is included in the display of the Compound Information. The third line contains the following Compound Information 
components: MW (nominal mass); Exact Mass (if there is an elemental composition associated with the spectrum); 
CAS registry number, if in the record; NIST number (only NIST spectra, sequential number assigned to spectra in the 
NIST Archive); ID number (position in the library containing the spectrum); and name of the library containing the 
spectrum. The fourth line also contains information about the compound/spectrum: Contributor (NIST 
Library)/Comments (user libraries). The fifth line is the compound’s InChIKey (if a structure is associated with the 
spectrum), and the sixth line contains Related CAS registry numbers, if any (NIST distributed libraries only). All of the 
above is only displayed when the Compound Information checkbox in the Text Info page is selected.  

For the most part the other checkboxes under the section labeled Display of 
the Hit Text Info, Unknown Text Info, and Spec List Info pages of the Library 
Search Properties dialog box are self-explanatory, except for the one next to 
the GC Retention Indices label. If there is a cheek in this box, following list of 
Synonyms in the Text Information window will be the label Experimental RI 
median±deviation (#data), if the spectrum is from the NIST EI library and that 
CASrn has entries in the GC Metod/RI database. Under this label are up to 
three lines; one each for Semi-standard non-polar, Standard non-polar, and 
Polar GC columns. Each line is followed by a number representing the median RI value of all the enters in the GC 
Method/RI database for the compound measured on that type of column. The number following the ± symbol is the 
deviation. The last number, in parentheses, is the number of measurements in the GC Method/RI database.  

The next label under the experimental RI data is Estimated semi-standard non-polar retention index (n-alkane 
scale). This value will be displayed for any spectrum with a structure, regardless of it being an NIST EI spectrum or not. 
This value is rule-based and may not be displayed for some compounds like organophosphate, even if the compound is 
in the NIST EI Library. The next label is AI predicted semi-standard non-polar retention index (n-alkane scale). This 
value is exclusive to spectra in the NIST EI Library. There is a value for every compound in the NIST EI Library. This 
value has been found to be in better agreement with the experimental RI values than those determined using the rule-
based method. 

The next labeled field is Retention Index. If there are records containing literature GC method/Retention Index data, 
these records will be displayed following this labeled field. The number of displayed GC Method/Retention Indexes can 
be controlled. Just under the GC Retention Indices and Other DBs checkboxes in the Library Search Properties 
dialog box are two radio buttons: All and First. If All is selected, all retention indices associated with that compound will 
be displayed, one after another. If First is selected, only the number entered in the text box to the right will be displayed. 
By default, only the first two records are displayed. If there are more than the specified number of records, <…> will 
appear just below the last line of the bottom record. The records are string-searchable using the Find selection on the 
RMB menu when displayed in a Text Info window. All text is searched, which means GC column types, active phases, 
author names, or text in the article titles can be searched. Only the records displayed are searched.  

 
Experimental data from the 
NIST GC Method/RI Database 
for Benzene (NIST# 114388). 
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It should also be noted that even though the checkbox for GC 
Retention Index in the Text Info tab of the Properties dialog box 
has been selected, if an NIST Tandem Library is being viewed, the 
GC Method/Retention Index information will not be displayed.  

The RMB menu selection Properties will result in the display of a 
multiple-page dialog box (Figure 56). 

The page names (left side) are self-explanatory. This allows 
customization of the appearance of the display and control of what 
is displayed such as a structure on a spectrum, the 10 most intense 
peaks in the spectrum in the text display, etc. Colors of structures, 
mass spectral peaks and axes, etc., and fonts used for 
alphanumeric characters can also be set. Windows in the various 
tab view can have their own customized set of attributes. These 
customized displays can be saved using the File/Save 
Configuration command from the Main Menu. Different saved 
configurations can be recalled by using the File/Restore 
Configuration command from the Main Menu. Separate 
customizations can be established for each of the six separate tab 
views. This includes selected libraries to be searched. 

The GC Methods/RI Database is also available separate from NIST 26 with its own Search program, which allows for 
more extensive use of this Database (ability to search RI ranges). Distributors are allowed to provide this program at no 
additional charge when the NIST 26 EI installation is purchased. Purchasers may have to remind their distributor. 

Examples of the possible content of the Plot of Hit window and Hit Text Info window are shown below in Figure 57 and 
Figure 58 respectively (next page). These figures were prepared by adjusting the splitter bars to produce full desktop 
displays of the Plot and Text Information windows of the Names tab view. 

 
Figure 57. The Spectral Plot display of a spectrum in the Name tab with the nominal mass, CAS registry 

number, elemental composition name of the library containing the spectrum, and the name associated with 
the spectrum. The display is wrapped, the structure is shown, and the peaks are not labeled. 

 
Figure 56. Properties dialog box displayed 
by selecting Properties on the RMB menu 

displayed when the Mouse pointer is on one 
of the windows of the Lib. Search tab. 
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Figure 58. The Text Info display with Compound Information, Synonyms, and Retention Indices as the only 

selected display options. 

 
Figure 59. Lib. Search tab view Button Bar. 

At the top left of the Lib. Search tab view (Figure 53) is the Button Bar (between Spec List window and Toolbar), if 
displayed. The Other Search and Librarian tab views also have Button Bars. The meaning of each of the buttons in 
the Lib. Search view is shown in Figure 59. 

The  button will launch a search of the highlighted spectrum in the Spec List. The Structure Search button ( ) will 
perform a structure similarity search of the highlighted structure in the Spec List. The Import button ( ) is used to 
import spectra from a text file. The Library Search Options button ( ) is used to display the dialog box used in 
selecting libraries to be searched, search types, and other factors associated with the search of spectra and structures.  

The dropdown list box contains the Search History. The results of a previous Lib. Search can be restored and displayed 
by highlighting an entry in this list. Each search in the Lib. Search History is retained until they are removed with the 
Clear History button ( ). NOTE: the Program can be set to automatically clear the History List, when it is exited, by 
selecting the Clear History checkbox in the Hit List page of the Library Search Properties dialog box. Separately, the 
Program can also be configured to delete the Spec List by selecting the checkbox with this same label in the Spec List 
tab of this dialog box; both tabs are displayed by selecting Properties from the RMB menu with the Mouse pointer in 
appropriate window. Individual and multiple entries can be deleted from the Spec List using the Microsoft Windows 
<Delete> command. 
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NOTE ON RECALLING Hybrid Search Results from HISTORY LIST: When a Hybrid Search is performed, if 
the Head to Tail tab has been selected, the Compare Pane window displays the spectrum of the undefined are 
compound on top (peaks pointing up) and a combination of the hybrid spectrum and the selected Hit spectrum 
(explained in more detail later in this manual) with peaks pointing down. If the results of such a search are recalled 
from the History List after another type of search has been performed (say an EI Normal), in order to reconstitute 
the Hybrid Search Compare Pane display, it will be necessary to select the appropriate Hybrid Search under 
the Similarity Spectrum Search Type heading in the Library Search Options dialog box. The result can be 
recalled from the History List and then the Spectrum Search Type reset; however, this will necessitate selecting 
a Hit from the recalled Hit List. 

Replicates are indicated for any compound in any library that has a CASrn that is the same as that in the NIST EI Library. 
Replicates are indicated by the    symbol at the beginning of the Hits line in the Hit List window. The display of these 
replicates is turned on by clicking on the symbol. The Replicates On/Off button ( ) will toggle the display of Hits of 
replicate spectra on and off.  

The Best matching only button ( ) will force the Hit List to display only the hit with the highest Match Factor for any 
given set of spectra where the first block of the InChIKey is the same regardless of which searched library it is in. This 
feature is especially useful when more than one library is being searched. In the case of an MS/MS Search, the best 
matching spectrum is selected out of Hits that have the same InChIkey or names and charge. 

The View Hit List Search Options button ( ) will result in the display of a dialog box with two pages if Constraints 
have been used in the search. The Search or Options tab (depending on whether the Hit List Search Options are for 
a Lib. Search, or an Other Search carried out), lists the libraries searched (and type of Search and Search Options for 
Library Spectrum Searches only). The Constraints page (if present) lists all different constraints along with values 
used in the search (Figure 60 and Figure 61). 
It should be noted that even though an EI Library Spectrum Search is carried out against a list of libraries that does 
not include mainlib and replib, these two libraries will be listed as having been included (Figure 61) as long as the 
Display InChI Replicates checkbox is selected in the Replicates Display Options dialog box displayed by selecting 
Replicates/Related from the Options menu in the Main Menu. This will result in the display of the symbol indicating 
replicates were found when the user-only library was searched. This means that InChI search options are available for 
those spectra in libraries like the Wiley Registry of Mass Spectra and various third-party libraries. 

 
Figure 60. List of Constraints used for a specific 

search along with their values. 

 
Figure 61. List of libraries used in a Library 

spectrum Search along with the Search Options. 

Three other Important Points about the use of Constraints: 
1.) When a Constrained Search is carried out, the Search is performed as if there was no constraint. Only the spectra 
that were found in the Search that fall within the constraint criteria appear in the Hit List. 
2.) The number of available constraints exceeds the display area; a slider bar on the right side of the Constraints 
window in the Search dialog box allows access to all constraints. The Constraint window will only allow for the display 
of six constraint options at a time. Once values have been entered for any of these options, those values will be used 
in subsequent searches until individually changed or the Constraint is deselected. Once an available Constraint has 
been selected (check mark in checkbox entered by putting the Mouse pointer on the checkbox and clicking the left 
Mouse button), the values previously entered for that constraint will be used when future Constrained Searches are 

The only library specified in the 
Libraries page of the Library 
Search Options dialog box of 
the Lib. Search tab view was 
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performed unless they are changed. If a Constraint is selected and is not visible in the Window, an unwanted result 
may occur. The number of constraints selected is displayed in the Constraint page of the various Search dialog boxes 
next to the label Selected. A Clear All button is on the Constraints page of the various Search dialog boxes. The 
Clear All button removes the checks in all the various constraints; it DOES NOT change or delete the current values. 
It is recommended to select the Clear All button and reselect any desired Constraints before starting a new 
Constrained Search. When values in a Constraint are entered, the Use Constraints checkbox is automatically 
selected. Clicking on any individual Constraints checkbox in the Constraints page causes appearance of the specific 
Constraints page of the Search dialog box to change to allow for the entry (or edit) of values for that Constraint. The 
appearance can also be changed to that for a specific Constraint by selecting the constraint description in the window. 

3.) In the Other Search tab view, some Constraints are not allowed, and they will be grayed in the Constraint list 
window. An example is when a Formula search is being performed the Elements Values and Elements Present 
Constraints are not allowed. These may have their checkboxes selected, which will also be grayed. It is not possible to 
de-select these checkboxes; however, if the values in the Constraints are not relevant, the program will prevent them 
from being de-deselected. 

Nota Bene: Any time a Library search is carried out in the Lib. Search or Other Search tab view, a 
search status dialog box is sometimes displayed. The figure below is a good example. Sometimes 
searches are very rapid so that there is no dialog box displayed. 

 
The last button on the right, the View substructure information 
button ( ) displays the Substructure Information dialog box 
(shown on right). The Substructure Information dialog box 
contains a list of the probability of the presence and absence of 
substructures that may be associated with a compound that 
produced the searched mass spectrum along with additional 
predictions about the molecular weight of this compound and 
estimate of the numbers of atoms of chlorine and/or bromine that 
may be contained. This is especially useful with an Identity or 
Similarity search, for either EI or Tandem spectrum type. An 
example of the use of Substructure Information resulting from an 
MS/MS in EI Similarity Search of the NIST/EPA/NIH EI Library is 
provided later in this manual. All of the different searches are only 
available when the Spectrum Type selected from the File menu is 
Any. Otherwise just those specific to EI or Tandem spectrum types 
are available. 
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The Filter  Button pertains to searches of the Tandem 
libraries and is only visible when the spectrum type is 
Tandem or Any. Tandem Mass Spectra Filtering is available 
for all Hit Lists (Lib. Search and Other Search tab views). 
The NIST Tandem Libraries contain spectra acquired over a 
range of energies, from different precursor types, and 
fragmentation methods. This means that a search of the 
Tandem Libraries can produce many Hits generated from a 
single compound, which can be tedious to sort through. To 
facilitate this task, a filtering process is available that can 
easily control the types of spectra shown in a Hit List. This is 
invoked by pressing the filter button in the Button Bar above 
the Hit List showing results. This is available for both the Lib. 
Search and Other Search tab views. The filtering process 
may be turned on and off with the control at the top ( 
Enable Filtering (TandemOnly)) of the MS/MS Hit List 
Filter dialog box (below). When the filter is enabled, the filter 
button will appear to be pressed. Selecting the OK button in 
the MS/MS Hit List Filter dialog box, displayed by selecting 

the  button, the Hit List will reflect the selections in this dialog box. These controls match those in the Constraints 
section; except they do not permanently exclude the display of Hits – all original Hits can be seen by deselecting the 
‘Enable Filtering’ checkbox. This filter has no effect on EI searches.  

A good illustration of the MS/MS Hit List Filter dialog box is to select the Other Search tab view with spectrum type 
being Tandem or Any. From the dropdown list box at the upper left of the display, select Sequential Method. When 
the Sequential Seach dialog box is displayed, the view will be of the Constraints page. Select the Clear All button at 
the top of the dialog box. The  next to the Use Constraints label will be deselected. Locate the Name Fragment 
label in the window with the scroll bar just below the Clear All button and select it. In the text entry box to the right of 
the Name Fragment label and just below the window with the scroll bar, type C H O L E S T E R O L as a contiguous 
string. The ’s next to the Use Constraints and the Name Fragments labels should now be selected. Select the link 
to the Options page. Remove any names in the Included Libs: window. In the upper window select hr-msms_nist. 
Then select the Add button in the middle of the dialog box. Next, select the Search button. The Hit List will have over 
500 Hits. Select the  button, which results in the MS/MS Hit List Filter dialog box. Select the  next to the Enable 
Filtering (Tandem Only); label in the top/center of the dialog box, then deselect the  next to the -H2O. -NH3, -CO2 
label in the column with Allow Precursors label (right side of the dialog box), followed by selecting the Ok button. This 
results in a reduction of the number of items in the Hit List because the filter is allowing only precursor ions that are [M 
– H2O]. None of the previous Hits are lost, they are just not displayed. 

Title Bar, Tool Bar, and Status Bar 
At the top of the display of each Desktop is a Title Bar. This also contains information that pertains to the active tab 
view. On the left side of the Title Bar is the version of the NIST MS Search program and the selected Spectrum type 
(                                     ). When the Lib. Search or Other Search tab view is displayed, this Title Bar will contain 
information about the currently displayed search. In the case of a Lib. Search tab view this will include the search type 
used, the Presearch type, Constrained (if constraints were used), the RI value associated with the searched spectrum 
if provided, if any type of Limits were applied to the search, Lib. Search = value and the number of Hits in the Hit List 
window. The maximum of Hits is 100, unless the Presearch is set to Off in the Search page of the Library Search 
Options dialog box. In this case the maximum is 400. In the case of the Other Search tab view, the Title Bar will 
contain the type of search that was done (e.g., Formula, Molecular weight, etc. and the searched value, i.e., Formula 
(C9H8O4), MW (500), whether or not constraints were used, and the number of Hits found as well as the number of 
Hits displayed when the number of Hits is greater than the display limit. If a TXT file containing CAS registry numbers 
or NIST number is searched, the Title Bar will contain the path and file name. 

The Tool Bar display (Figure 63) is optional by selecting it from the View menu on the Main Menu. It is located between 
the Main Menu and the Button Bar. The functionality of the Switch to Caller and Print Report buttons are also 
available on the File menu; MS Interpreter, and AMDIS also may be launched from the Tools menu as well as the 
corresponding buttons on the Tool Bar. 

 
Figure 62. Tandem Hit List Filter Used to Limit 

Hits Displayed from Library and Other 
Searches Only Applicable to the Tandem 

Libraries. 
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Figure 63. NIST MS Search Tool Bar. 

A Tool Tip is associated with each of the buttons with an explanation of the 
button function. The  button will return all displays on the currently viewed 
tab to the default values. The  button toggles through three separate views 
for the currently displayed layouts. 

The m/z range button displays a dialog box to fix the starting and ending m/z 
values for bar-graph spectra displays, and to choose whether the peaks should 
be labeled with neutral losses or with their m/z value. 

An explanation of each of the items in this dialog box can be found by selecting 
the Help button in the dialog box. The Anchors dialog box is used when viewing 
spectra with a neutral loss label. Selecting Anchors will result in the display of 
the Anchors dialog box, which is explained by selecting the Help button in that 
dialog box. 

The two radio buttons at the top of the m/z range dialog box have to do with 
labeling spectra normally or with neutral loss values. Normal display is the most common. 

One of the important tools in deducing a structure from a mass spectrum is to look at the mass spectral peaks as losses 
from the molecular ion rather than as individual peaks. In this way of viewing the mass spectrum, the peak at m/z 269 
in methyl stearate becomes the [M − 29]+ peak (loss of an ethyl radical) and the peak at m/z 267 becomes the [M − 31]+ 
peak (loss of a methoxy radical). See Figure 64. 

The program can display a spectrum with neutral loss labeling of the library and searched spectrum with the first label 
on the rightmost peak being 0. To activate this display, select Neutral Loss Display from the RMB menu.  

Nota Bene: If you do not know the molecular weight of the search spectrum, the program will attempt to estimate it. 
This value may be overridden by using the Librarian to edit the spectrum and specifying a molecular weight and then 
using the edited spectrum to perform the library search.  

At the bottom of the tab view display, below the Program tabs, is the optionally displayed Status Bar. The Status Bar 
display can be turned off by selecting or deselecting Status Bar from the View menu. When a Spectrum Search is 
being conducted, the left side of the Status Bar will have displayed “Comparing XXX Library spectra with submitted 
spectrum” where XXX is the number of spectra that were found during the Presearch (see APPENDIX 5: Search 
Algorithms). This is followed by a rolling % completion display. Once the search is completed this display is cleared. If 
Off has been selected in the Presearch area of the Search tab of the Library Search Options dialog box, XXX will 
represent the total number of spectra in the libraries being searched. As items in the Tool Bar are pointed to, the Tool 
Tip for that item will appear in the Status Bar. Depending on the position of the Mouse Pointer, the left side of the 
Status Bar can display For Help, press F1. 

There are two fields on the right side of the Status Bar when the Lib. Search tab view is active. The left-most of these 
two fields will display the search type that is currently selected in the Library Search Options dialog box following the 
Type of Search: label. The next information shown following the Displayed: label is the type of search responsible for 
the current display. If a Neutral Loss or Hybrid Similarity Search has been performed, the number to the left of the 
Displayed: search type is the m/z value of the precursor ion.  

 

 
Figure 64. m/z Range Dialog 

Box. 
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Figure 65. Nominal spectrum labeling where the top spectrum is of an unidentified compound and bottom 

spectrum is of the first Hit from a search of the NIST/EPA/NIH Mass Spectral Library (NIST 26). 

 
Figure 66. Neutral Loss spectrum labeling where the top spectrum is of an unidentified compound and 
bottom spectrum is of the first Hit from a search of the NIST/EPA/NIH Mass Spectral Library (NIST 26). 
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Main Menu 

 
Figure 67. Menu for each selection on the Main Menu of NIST 26. 

The above figure was created from the Lib. Search tab view. Some items on an individual menu may not be present 
when the selection is made from these items on the Main Menu in other tab views of the Program. 

An important feature of the MS Search is the ability to save configurations. This is true when 
there are multiple users and/or multiple specific analyses being performed. In Figure 67 above, 
the antepenultimate selection of the File menu is grayed. It is labeled Recent Configurations. 
When a configuration is saved, this label is replaced by the name of the saved configuration. A 
maximum of six configurations can appear on the File menu: the most recent saved six (each 
is numbered). More than six configurations can be saved. They will appear in the Open dialog 
box displayed when Restore Configuration is selected. If one of the listed Configuration is 
selected, a dialog box appears asking if the current configuration should be saved is displayed, 
with Yes and No buttons. If Yes button is selected, a Save As dialog box is displayed allowing 
the current configuration to be saved. If No is selected, that selected configuration will be 
restored, overwriting the current configuration. Selected libraries, constraints, and other items 
in the Library Search Options dialog box of the Lib. Search tab view are also saved. 

The other grayed select on the File menu is Return to Caller. This selection is only available if 
MS Search has been started or brought into focus from a command line instruction from other 
software. This will return the focus to the calling program. There is a button to use to do this in the Tool Bar, which is 
only available under the same circumstances. 

Hit List window in the Lib. Search tab view 
The Hit List window in the Lib. Search tab view can provide a great deal 
of information. Some items are specific to the Tandem or EI spectrum type. 
Some items are specific to types of searches 
performed within an individual spectrum type. 
The display of these information items is 
selectable through the Library Seach 
Properties dialog box Hit List page (Figure 71). 
In the EI Hybrid Hit List window, there are 18 
selections. The EI Hybrid search Hit List 
selections selections are shown on the right. 
The same is true for the Tandem spectrum type. 
NEW to v.4.0 is sets of predefined Hit List items. 
When a specific search is performed, the 
appropriate default Hit List is displayed. This dialog box includes a Help 
button to provide defintions for the various column headers. 

 
Figure 68. Altered view of Items to 

display showing the 11 available for an 
EI Normal Search. 
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It has been possible in the past several releases to copy selected items to the Windows Clipboard in a tab-separated 
text format, by highlighting the desired lines and then pressing the Ctrl+K keyboard keys; however, it is worth pointing 
out again that an important feature added to v.4.0 are the RMB menu selections of Copy Select Hits to Clipboard 
and Export Select Spectra to Text File displayed when the Mouse pointer is in any Hit List or Spec List window (Lib. 
Search, Other Search, Librarian, or Chromatogram tab views). Highlighted items will then be copied and exported 
to a text file or sent to the Windows Clipboard. 

The Hit List window, like all windows on all tab views can the adjusted in size with the vertical and horizontal splitter 
bars. The vertical splitter bar adjusts the sizes of all three horizonal windows on the left side of the display to the same 
width. The widths of the columns in the Hit List window are adjustable by placing the Mouse pointer on the dividing 
line between two columns (the Mouse pointer will change shape ( )), hold down the left Mouse button and push or pull 
to the right or left. Pulling to the right increases the size of the column to the left of the pointer. Pushing to left will 
decrease the width of the column to the left of the pointer. The position of the columns can be changed by placing the 
Mouse pointer in the center of a column, holding down the left Mouse button and moving to the right or left (desired 
direction to move the column). When the column to be moved is over the column next to the desired new location, 
release the Mouse button. The Hit List page of the Library Search Properties dialog box has a checkbox next to the 
Short Library Names label which limits the name in the Lib. column to two digits when selected (default). If not 
selected, the name of the folder that makes up library is displayed. There is also a checkbox to the left of the Clear 
History label. When selected, the Search History list will automatically be deleted when MS Search is closed and 
restarted. There have been several additions to the available information for all of the Hit List in v.4.0. Review these for 
information you have always wanted. 

The Library Spectrum Search and the Structure Search are usually carried out from the Lib. Search tab by selecting 
on the Library Search button ( ) or Structure Search button ( ), respectively. Another way of initiating a search 
is to select a spectrum in any Hit List or Spec List, Plot window or Text Info window in any tab view, or in a Compare 
window; display the RMB menu and select Library Search for a spectrum search or Structure Similarity Search for 
a structure search, if a structure is associated with the spectrum. A third way to initiate a Spectrum Search is to double-
click the left Mouse button on an entry in the Spec List. To search more than one spectrum at once, make a multiple 
selection in any List window of spectra (Hit List or Spec List), display the RMB menu, and select Library Search or 
Structure Similarity Search. Regardless of the tab view displayed, when a search is carried out, the focus will change 
to the Lib. Search tab view. In the default display of the Lib. Search tab view, the Hit List is on the lower left. With 
most spectrum searches, the third column (from the left) of the Hit List contains the Match Factor or Score (depending 
on the spectrum mode and type of search). For a Structure Similarity Search, the match column is labeled as 
DotProduct. A DotProduct of 1000 for the Structure Search does not mean an exact match; it means that the found 
structure is a homologue of the submitted structure. Match Factors and Scores for the Spectrum Search cannot 
exceed 999, which is considered an exact match. Just under section controlling the display of structures in the Hit List 
page of the Library Search Options dialog box a label appears that specify the Search that the current Hits List pertain 
to. In Figure 68 on the previous page, it is EI no RI Search. To the right of the Structure Size in % numeric entry box 
is a checkbox followed by the Structures Only label. Selecting the checkbox will cause no text to be associated with 
the Hit List when the Structures tab at the bottom is selected. 

Histogram List window in the Lib. Search tab view 
This window has two functions: show a distribution of Hits with specific Match Factors in either a linear or logarithmic 
distribution (settable from the Histogram page of the Library Seabeach Properties dialog box). The default display 
is with a logarithmic ordinate. The second is to provide a list of the names of all the libraries used for a specific search 
and the total number of spectra searched. If this text exceeds the width of the window, the text will wrap. This feature 
is optional; selectable in the Histogram page of this dialog box (a checkbox next to the Show libraries searched 
label).  

Spec List window in the Lib. Search tab view 
Two new selectable columns (from the Spec List page of the appropriate Properties dialog box) have been added to 
the Spec List window of the Lib. Search and Librarian tab views. These are molecular weight, MW (nominal mass) 
and formula, Formula (elemental composition). Whatever action is taken with the Spec List in the Lib. Search tab 
view will be echoed in the Spec List of the Librarian tab view. Items can be deleted from the Spec List by highlight 
and then use the keyboard Del key. When items are deleted, there will be gaps in the number sequence. When MS 
Search is closed and restarted, the Spec List will be renumbered to provide a continuous series. Different layouts are 
available. The  button toggles through three separate views for the currently displayed layouts. The  button will 
return all displays on the currently viewed tab to the default values. The RMB menu can be used in the Lib. Search 
and Librarian tab view to change the splitter bar orientation (RMB menu and select Change Splitter Orientation). 
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Figure 69. The Plot/Text window showing some of the Optional Displays. In addition to those shown for the 
Text window, a list of all m/z values/relative intensity pairs and GC Retention information can be displayed 

with MS Peaks in Rows or Columns and the Text information Wrapped or not.  

Plot & Text Information window of Selected Hit in the Lib. Search tab view 
The Plot/Text windows in the Lib. Search tab view have separate pages in the Lib. Search Properties dialog box: Hit 
Text Info and Plot of Hit. An important feature of Pages of all Plot windows is the ability to adjust the thickness of the 
mass spectral peak: list box to the right of Peak With label. The Change Splitter Bar Orientation selection is only 
available when the RMB menu is displayed in either of the two windows associated with a selected Hit or with a 
selected Spec List spectrum. The splitter bar between the Plot and Text Info windows of the Spec List and Hit List 
selection changes from horizontal to vertical or vice versa. 
 

 
Figure 70. Plot/Text window of selected Hit at using the Changer Splitter Orientation  

on RMB menu with Mouse pointer in one of the two windows. By closing the Compare windows using the 
horizontal splitter bar above the Plot window, the Spec List/Searched Spectrum and the selected Hit List 

spectrum are on top of one another. 

The Plot of Hit and Hit Text Info pages of the Library Search Properties dialog box are shown in Figure 71. One important 
fact about the Hit Text Info page is the GC Retention Indices. Either All or a limited number of complete citations can 
be displayed. These can be searched using the RMB menu’s Find selection.  
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Figure 71. Plot of Hit (left) and Hit Text Info. (right) pages of the Library Search Properties dialog box. 

Plot & Text Information window of Selected Item in the Spec List window 
The window to the right of the Spec List of the Lib. Search tab view is similar to the one to the right of the Hit List, 
with one important difference. This window serves three functions: 

 
This window is divided into the Plot and Text Info windows of an item searched from the Spec List or just the Plot of 
the searched item from Spec List. There is a third tab labeled Spec List, which will be a two-window display (Plot and 
Text Info.) of whatever item is currently highlighted in the Spec List. Highlighting a Spec List item results in the 
automatic switch to the Spec List tab view, located under the window. The spectrum displayed in the Plot/Text of 
Seach Spectrum or Plot of Spectrum tab view will be same; however, they may be different from the spectrum display 
in the Spec List tab view. It is important to be aware of this distinction to avoid confusion. There are different Plot and 
Text Info. pages in the Library Search Properties dialog box for the Plot/Text of Search Spectrum and Spec List 
tab views. These pages are labeled Unknown Plot and Unknown Text Information, and Spec List Plot and Spec 
List Text Info, respectively. The Library Search Properties dialog box page for the Plot window of the Plot/Text of 
Search Spectrum and Plot of Search Spectrum are the same: Unknown Plot. 

Compare window of the Lib. Search tab view 

 
Figure 72. The Compare window of the Lib. Search tab view with the Head to Tail display. 

The Compare window can be closed by selecting View from the Main Menu and deselection Compare Pane from the 
dropdown menu. It can also be made not visual by adjusting the horizontal splitter bars on the top and bottom of the 
window. If this is done, visibility can be restored by selecting the  button in the Buton Bar. If the splitter bar orientation 
has been changed with the RMB menu, it will be restored to the original position. If the Compare window has been 
made not visible with the View menu, the use of the  button will not restore it. There are four ways to compare the 
spectrum in the Plot window above the Compare window with the spectrum in the Plot window below. One is the 
Subtraction view. This will be useful if it is suspected that the query spectrum is of more than one compound. 

The Compare window is very important when a Hybrid Search is performed. This is explained in the section regarding 
the Hybrid Search. 
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Library Search Options dialog box 
Search page in the Library Search Options dialog box 
This section on the Search page of the Library Search Options box is repeated later in this manual 

Selecting Library Search Options on the Options menu from 
any tab view or the Library Search Options button ( ) on the 
Button Bar of the Lib. Search tab view will display the multiple-
page Library Search Options dialog box (Figure 73). The 
appearance and options of the dialog box are dependent on the 
Spectrum Type selected in the dialog box displayed when the 
Select Spectrum Type option is selected in the File menu (Main 
Menu). The MS/MS page does not appear if the spectrum type 
is EI, and the RI (GC) page does not appear if the spectrum type 
is Tandem. 

Different types of spectral comparison routines for choosing the 
best matching spectra are available. These are Spectrum Type 
specific. The routine to be used for any Spectrum Type is 
selected from the Library Search Options dialog box Search 
page. 

The two Spectrum Search Types on this dialog box are 
Identity and Similarity. These different Spectrum Search 
Types and their options are explained in the Help Screens for 
each of the Spectrum Types (topic Spectrum Search Type). 

Generally, if it is believed that there is a spectrum of the 
unidentified compound (query) in one or more of the libraries being searched, an Identity Search is best used (EI 
Normal for EI spectrum type when using nominal m/z or accurate GC/MS data, and MS/MS for Tandem spectrum type 
using spectra with a specified precursor ion or HiRes NoPrecursor when using in-source spectra). If it is believed that 
there is no spectrum of the query in the libraries searched for reasons such as obtaining only low Match and Reverse 
Match Factors for an Identity Search, a Similarity Search may yield better results. Although there are three options 
for a Similarity Search for the EI spectrum type, and essentially one selection for the Tandem spectrum type, it is 
recommended that the Hybrid Search be used (for both spectrum types) when it is believed there is no spectrum of the 
query compound present in the searched libraries. Introduced with v.2.3 of MS Search, these are particularly useful in 
this respect.1,2 

A feature that first appeared in v.3.0 is the Spectrum Sorting Options/Method (name changed from Spectrum Search 
Options in v.3.0) dropdown list box (shown below). There are three selections. This section also has the Compound 
Ubiquity Correction checkbox. This is a new feature in v.4.0 that is used to enhance the Match Factor of more 
common compounds, when selected. V.3.0 saw the retirement of the Penalize rare compounds option. This new 
feature is a much more sophisticated replacement. If the Hit has a high Compound Ubiquity Index (CUI), its Match 
Factor will be altered. It has been shown that “a CUI of 0 reduces the inherent likelihood of identification relative to a 
random compound in the library by nearly a factor of 10, whereas a value of 20 increases this likelihood by a factor of 
10.” When dealing with an unknown spectrum and two Hits have almost identical Match Factors, the one with the 
higher CUI is the more likely candidate. As used in MS Search, the CUI is a citation index that reports the number of 
58 diverse non-mass spectral chemical collections containing the compound. This is described in the literature citation 
previously referenced on page 44, Footnote 6, Details of how this works are found in that citation. 

There are a series of options under the label Spectrum Scoring 
Options/Method section. These are selectable through the dropdown list 
box next to the Method label. The first selection in the list is the search 
type most offen used where all peaks in the sample spectrum and the 
library spectrum that are in a match are compared.  

 
1 Arun S. Moorthy, , William E. Wallace, Anthony J. Kearsley,‡ Dmitrii V. Tchekhovskoi, and Stephen E. Stein “Combining 
Fragment-Ion and Neutral-Loss Matching during Mass Spectral Library Searching: A New General Purpose Algorithm Applicable to 
Illicit Drug Identification” Anal. Chem. 2017, 89, 13261−13268. 
2 Ivana Blaženović, Tobias Kind, Michael R. Sa, Jian Ji, Arpana Vaniya, Benjamin Wancewicz, Bryan S. Roberts, Hrvoje 
Torbašinović, Tack Lee, Sajjan S. Mehta, Megan R. Showalter, Hosook Song, Jessica Kwok1, Dieter Jahn, Jayoung Kim, Oliver 
Fiehn “Structure Annotation of all Mass Spectra in Untargeted Metabolomics” Anal. Chem. 2019, 91 (3) 2155-2162. 

 
Figure 73. Library Search Options Search 

page for an Identity EI Normal search in the 
Any Spectrum Type mode. 
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The second option results in the display of the Hit List according to descending Reverse Match Factor (RMF). A RMF 
is a Match Factor (MF) calculated by disregarding any peaks in the sample mass spectrum that are not in the library 
mass spectrum. The third selection is displaying the Hit List in descending order of the Partial Spectrum Search 
(PSS) value. This is a Match Factor calculated disregarding any peaks in the library spectrum that are not in the sample 
spectrum. The PSS seach was new to v.3.0 of MS Search. The Impurity Tolerant Search was selectable as a 
checkbox for a Reverse Search in this dialog box of versions previous to v.3.0 (v2.4 and previous). 

In v.3.0 there was a selection for Match Ion Mode (Tandem) when any Spectrum Mode other than EI is selected. This 
selection has been moved to the MS/MS page (only visible on the Library Search Options dialog box when the 
spectrum type is Tandem). 

Following the Spectrum Search Options are the Presearch selections. These are selectable by clicking on the desired 
radio button. The Default presearch uses a series of presearch screenings to select the spectra which will be compared 
peak-by-peak in a Match Factor (Score) calculation. The Fast presearch is essentially the same as the Default, but 
selects a factor of three fewer spectra, on average. The Off selection has every spectrum in all the libraries being 
searched compared with the sample spectrum. This can be time consuming. This will result in a Hit List with 400 
compounds whereas the other two Presearch options produce a Hit List with a maximum of 100 compounds. 

The InChIKey selection restricts searches to spectra that have the appropriate InChIKey; therefore, it is a type of 
presearch and turns off the other three selections. This can be a full value or a beginning partial value. There will be a 
spectrum-by-spectrum search of the spectra meeting the InChIKey criteria. 

Note the InChIKey presearch is used when the structure associated with the spectrum is known. It is a powerful filter 
that helps with multiple libraries. Existing User- and third-party libraries must be indexed to use this feature. Indexing is 
accomplished from the Tools menu of the Main Menu. Details of the InChIKey presearch are found in the Help file. 

Other Options section on Search page of Library Search Options dialog box 

 
The checkboxes next to the Automation, Apply Limits, Use Constraints, and Use RI (only in EI and Any spectrum 
mode) options are automatically selected or deselected based on actions taken in the Automation, Limits, 
Constraints, and RI (GC) pages of this dialog box. They can be selected or deselected in this page. If they are not 
selected, it is a good idea to review the contents of the corresponding page before selecting one of them. This will 
prevent unwanted or confusing results. The Automation checkbox in the Search page is turned on an off by the 
selection/deselection of the Automatic Search On checkbox in the Automation page. The Auto Report checkbox is 
not automatically selected when the Automatic Search On checkbox is selected on the Automation page or 
Automation is selected in the Search page. If Auto Report is selected, whatever settings are in place in the upper 
section of the Automation page will be applied to the report automatically generated at the completions of each library 
search. The other items are self-explanatory if the page with the appropriate label is made visible. The value in the 
Number of Hits to Print entry box sets the number of Hits that will be in an Auto Report when executed from the File 
menu of the Main Menu. The format of these automatically printed reports is dictated by the Automation page of the 
Library Seach Options dialog box. This format is different from the one generated when File menu’s Print Report is 
executed.  

Version 4.0 has two new selections in the Other Options section of the Search page of the Library Search Options 
dialog box displayed for the EI spectrum type. These are Use RI and TMS mode. The Use RI checkbox which can be 
selected and deselected from the Search page is turned on and off by selecting/deselecting the Use Semi-Standard 
Non-Polar Colum Retention Index for Scire corrections checkbox in the RI (GC) page. 

The TMS mode (EI only) selection has three options for compounds that have been derivatized with a trimethylsilyl 
reagent.: 1) Off - no filter; 2) TMS - for TMS derivatized samples - rejects compounds containing OH and NH with no 
TMS derivatization; 3) Non-TMS - for non-TMS derivatized runs - rejects all TMS derivatized compounds. This is a 
highly specific constraint.  

The Search page of the Library Search Options dialog box also has a Structure Similarity Search Options 
selection. This has the Match Number of Rings checkbox. When selected, the search of compounds that have rings 
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will be constrained to only spectra produced by compounds with a similar structure and the same number of rings as 
the spectrum being searched. The Show Homologues selection is self-explanatory. 

Different Libraries are used for a Structure search and a Spectrum Search. When the Libraries page of the Library 
Search Options dialog box is selected, a dropdown list box appears in the lower part. The selections made above are 
for either Spectrum searches or Structures searches. It is important to be aware that different libraries may be 
selected for these two types of searches, especially when working with both at the same time. 

When the OK button on any page of the Library Search Options dialog box is selected, the dialog box is closed. When 
this dialog box is next opened, it is opened with the page view present when it was closed. In addition to the OK button 
each page has a Help button that opens a contact sensitive Help page. Before initiation, a search of a spectrum or 
performing a structure similarity search, each page in the Library Search Options dialog box should be viewed and 
understood. 

Warning !! If unexpected results are observed for any search, Tandem of EI, the first place to look is the Search 
page of the Library Search Options dialog box to see what Other Options have been selected. The one that has 
been the most problematic is the Use Constraints. If this checkbox is selected, check the Constraints page to see all 
the settings. Another possible source of error is Limits page. The Method chosen in the Spectrum Scoring Options 
section of the Search page can cause unexpected results. 

MS/MS page in Library Search Options dialog box (Tandem Only) 
The MS/MS page ONLY APPEARS on the Library Search Options dialog box when the spectrum type is Tandem or 
Any. It permits selection of the m/z tolerances for the precursor and product-ions in the MS/MS and In-source HiRes 
Search, the option to ignore the precursor ion, and access to a set 
of options specific to peptides. The values can be entered in ppm 
or as m/z values. If the checkbox next to the ‘Ignore precursor 
ion region’: 0=default label is selected, mass spectral peaks 
within a ± interval of the precursor ion are ignored. If 0 (the default) 
is entered, the larger of precursor and product ions is used. 

Precursor ± - precursor m/z tolerance range, 0.015-100,000 ppm 
or 6×10-5 - 500 m/z units. Product ions ± - mass spectral peak 
tolerance range, 0.015-100,000 ppm or 6×10-5 - 500 m/z units. 

Nota Bene: For Low Resolution power NIST library (LR_*) product ions tolerance is fixed at unit mass resolution. If a 
library name begins with LR_ (Low Resolution power), for its spectra the entered tolerance T is replaced with max (T, 
0.45 m/z units) for all product ion peaks. For example, if T=4500 ppm, tolerance will be increased to 0.45 m/z values 
for m/z values < 100. 

In v.4.0 the Match Ion Polarity checkbox was moved from the Search page to the MS/MS page of this dialog box. 

Libraries page in Library Search Options dialog box 
The Libraries page (Figure 74) of this dialog box is used to select the libraries to be included in a Library Search of a 

spectrum. As many as 127 libraries can be searched at the same time. The 
EI Installation includes the NIST 26 Main Library (mainlib) and the 
NIST 26 Replicates Library (replib) and the NIST GC Method/Retention 
Index Database (nist_ri). Multiple user-libraries as well as other 
commercially available libraries from sources other than NIST that are in the 
NIST MS Search user-library format can also be added. The Tandem 
Installation includes three other NIST 26 Libraries: the hr_nist_msms, 
lr_nist_msms, and apci_msms_nist. This means that there is space to 
accommodate an additional 120 user-libraries in either installation. If more 
mass spectral libraries need to be accommodated, the least used ones can 
be moved to another folder. To add libraries to be searched, in the Available 
Libs window of the dialog box, highlight the name and click on the Add 
button. To exclude libraries, highlight the name in the Included Libs window 
and then click on the  button above the upper right portion of this window. 
The order in which libraries are searched can be changed by highlighting 
the library to be moved in the Included Libs window and clicking on the Up 
or Down arrows in the upper right portion of this window. Each click will 
move the library one position. The order in which libraries are searched is 
not important in the search of a spectrum of an unidentified compound 

 
Figure 74. Library Search Options 

Libraries page. 
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because the Hit List has the 100 Highest Match Factor Hits regardless of what library they came from. Other 
Searches also have limited Hit List; the order of search may cause Hits from libraries lower on the search order not 
to be included in the Hit List if the number of Hits exceeds the limits. 

Below the Available Libs and Included Libs windows is a dropdown list box. This box allows for switching between 
the lists of libraries to be included in Spectra searches or Structure searches. These two different types of searches 
can have different sets of libraries and are specific to whether the search is of a spectrum or a structure. 

Automation page in Lib. Search dialog box 
The settings in Automation page of the Library Search Options dialog box have two functions. They are used activate 
the automatic printing of a report to the MS Searches default printer when the Automatic Search On checkbox is 
selected, and to set the number of Hits included in the report, whether the quire spectrum should be included in the 
report, and whether the structure in the Hit spectrum should be included in the report. 
When a query spectrum or structure is searched against a library that is imported from a file (using the File/Open 
command on the Main Menu) or third-party program such as an instrument data system or drawing program, a search 
can be automatically launched. and/or a report be automatically printed based on the setting in this page. Search and 
printing can be turned on and off from either the Search or Automations page of the Library Search Options dialog 
box by the respective selection or deselecting of the appropriate checkbox. Figure 75 shows the option in the 
Automation page of the Library Search Options dialog box. 
Automatic Search On on the Automation page (Figure 75) has the same functionality as the Automation checkbox 
on the Search page. Selecting or deselecting this checkbox on either page toggles the checkbox on the other page. 

Search results can automatically be printed whether the search is 
automatically launched. Checkbox Auto Report on the Search page 
of the Library Search Options dialog box turns on this feature. The 
Number of Hits to Print field is in the Automation page (Figure 75). 
In addition, the report in the same format can be printed for Lib. 
Search tab view by selecting Print Auto Report from the File menu. 
The top part of this page of this dialog box pertains to the automated 
printing of a search result. The format for the Auto Report is a sample 
spectrum at the top of a page followed by the spectra of a specified 
number of Hits in the Number of Hits to Print numeric entry box (2 by 
default). If the Include Spectrum Plot in Report checkbox is selected, 

there will be three spectra per page. Page one will have the query spectrum at the top followed by the first two Hits. 
Selecting the Draw Structures in Plots checkbox will result in the structure associated with a spectrum being printed 
in the plotted spectrum. 
If the Apply Maximum Spectrum Length checkbox is selected, a number can be entered for the maximum m/z value 
to appear on the spectrum abscissa. If peaks are present at higher m/z values, the abscissa will have a right-pointing 
arrowhead at its right end. When selected, the Return Focus to Caller Upon Completion checkbox will automatically 
cause a program that brought the NIST MS Search Program into focus. 
The printer specified by choosing it from the Print Setup dialog box displayed by selecting Print Setup … from the 
File menu (Main Menu) is the default. Some may want to set the printer as a device that produces a PDF file. If a series 
of spectra are to be searched, using a PDF printer can be problematic because the system stops to wait for the operator 
input of a file name. There is commercial software which allows for the automated incrementing of file names from one 
report to the next or will put all reports into the same file. There are some that or free and others have paid options. 
One program that does this is Win2PDF™ (https://www.win2pdf.com/)  

Limits page in the Library Search Options dialog box 
With the Apply Limits checkbox deselected, when a Match Factors is 
calculated, the only peaks considered are those above the lowest m/z 
value where ion current is observed in the library speculum or query 
spectrum, whichever is the higher. If the lowest m/z value of a library 
spectrum is high, a short range will be used in the calculation which could 
result in an erroneous Match Factor. Generally, the spectra in the 
NIST\EPA\NIH EI Library are complete spectra; however, some 
contributed spectra start the acquisition at m/z 35 or 50. Previous versions 
of MS Search had the Apply Limits checkbox deselected, by default. V.4.0 
has this attribute selected, by default. The Minimum m/z value is set 
equal to 1. The options in the dropdown list box for this selection are Off, 
equal to, and never greater than. The options for the Minimum 

 
Figure 75. Lib. Search Automation tab. 

https://www.win2pdf.com/
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Abundance selection are Off, Absolute value, and % of the minimum query abundance. Options for the Maximum 
m/z are On and Off. 
The function of the limits of the starting and ending m/z values of a Library spectrum Search and the lowest value of 
a mass spectral peak intensity that will be considered in a search can be set. An explanation of the limits that can be 
used to constrain a search may be found in the Help file by selecting the Help button on the Limits tab of the Library 
Search Options dialog box. 

Constraints page in the Library Search Options dialog box 

  

EI spectrum type Constraints Tandem spectrum type Constraints 

Selecting any checkbox in the list box window with splitter bar of the Constraint 
page will result in queries specific to that individual constraint being displayed in 
the lower part of this dialog box. (See Constraints page 46 for the Sequential 
Search in the discussion of the Other Search tab view.) This will also cause the 
Use Constraints checkbox to be selected. To the right of this checkbox is a 
Clear All button, which deselects all the previously selected constraints. The 
values enter are still present; however, because the Use Constraint checkbox 
is deselected, these values will not impact the Hit List display. To the right of 
the Clear All button is the number of constraints that have been selected. When 

constraints are used in a search, all the Hits that would have been found if constraints had not been used will still be 
found; however, only spectra that are within the limits of the constraints will appear in the Hit List. This can result in a 
Hit List with less than 100 Hits. The displayed dialog box when a library search is taking place will show that the search 
is constrained and what constraints are being used. 
RI (GC) page in the Library Search Options dialog box 

The functionality of this page in the Lib. Search Options dialog box has 
undergone significant changes with the release of v.4.0 of MS Search. 
The lower section, labeled Display Library Retention Indices for: 
allows for the selection of the display of the statistical RI value for any 
one of the three GC column types in the NIST GC Method/Retention 
Index Database, when RI is selected for the display settings in the Hit 
List window of the Lib. Search or Other Search tab views. If Semi-
Standard Non-Polar (e.g. DB-5) is selected and there is no value for 
this column type in the GC Method/RI Database, the estimated Artificial 
Intelligence Retention Index will be displayed. 

Selecting or deselecting the checkbox at the top of this page (preceding the Use Semi-Standard Non-Polar Retention 
Index for Score correction label) determines if a measured RI value provided for a SSNP column will be used in 
conjunction with the SSNP column statistical values in the GC Method/RI Database in the calculation of a Match 
Factor. If no statistical data is available for the Hit, the AIRI values will be used in determining the Match Factor of the  
queried spectrum. The displayed RI value in the Hit List of the Lib. Search tab view will be the SSNP statistical value 
(or AIRI value when not available) regardless of the selection in the Display Library Retention Indices for: area.  
The selection or deselection of the Use Semi-Standard Non-Polar Retention Index for Score correction checkbox 
has no impact on which of the three column types of RI statistics will be displayed in the Hit List of the Other Search 
tab view. If the Standard Non-Polar (e.g. DB1) or the Standard Polar (e.g. DB-WAX) is selected, and there is no 
statistical information in the GC Method/RI Database for the Hit, this field in the Hit List record will be blank. If Semi-
Standard Non-Polar (e.g. DB-5) is deselected, the statistical information from the GC Method/RI Database will be 
used. If there is no data, the AIRI value will be substituted. 
Nota Bene: Settings in this page have no impact on the LibRI field of the Hit List in the Chromatogram tab view. 
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Other Search tab view 
The second tab view, Other Search (Figure 76), is used to perform a MW (Nominal Mass), Exact Mass, MS/MS 
Precursor m/z (not available when the Spectrum Type is EI), Formula (elemental composition), CAS registry 
number, ID Number Search, NIST Number or Any Peaks, search when the EI, Tandem, or Any spectrum type is 
selected. If the Tandem or Any spectrum type is selected, another search can be performed; the MS/MS Precursor 
m/z search. This selection will only appear on the search menu (displayed by selecting the dropdown arrow on the 
list box just to the right of the button in the Button Bar) when the Tandem or Any spectrum type is selected. These 
searches are only preformed on mass spectra.  

The Any Peaks Search allows any NIST or user-library (or multiple libraries) to be queried one mass spectral peak at 
a time based on the m/z value and relative intensity and peak type (Normal, Loss, Rank, Maxmass, Exact Mass, 
AccurateMZ, or AccurateLoss). This search was originally developed for use with the NIH nominal mass library of 
12,500 compounds (one spectrum per compound) when its remote access was only available through voice-grade 
telephone lines, telephone modems, and teletype. This was before the deplanement of data systems. It continued use 
for integer and accurate m/z data has proved very useful. The Any Peaks Search was expanded in previous versions 
to allow for peaks with accurate m/z assignments to be searched against the NIST Tandem and user libraries. 

The NIST Number search can only be carried out on the NIST/EPA/NIH Main Library (mainlib), the Replicates 
Library (replib), the Tandem Libraries and the Retention Index Database (NIST RI). NIST Numbers establish 
consistency between spectra in different releases of the NIST MS Libraries and can be carried out on one or all these 
libraries at the same time. The ID Number Search can only be carried out on one library at a time and can be used 
with any of the NIST libraries or other libraries such as user-libraries. The MS/MS Precursor m/z Search works with 
the NIST Tandem libraries and user-libraries containing Tandem spectra. Many of searches can be performed against 
multiple libraries at a time (max. of 127), and different sets of libraries can be specified for each different Searches. 

 
Figure 76. Other Search tab as viewed for the EI Spectrum type of NIST 26. 

Searching List of CAS Registry numbers, NIST Numbers, or ID Numbers 
Figure 77 shows the tops of the CAS rn Search and NIST registry number Search dialog boxes and the ID number 
Search dialog box displayed in the Other Search tab view. The Mouse pointer can be placed on the button to the right 
of the text entry box where the values for these searches are entered. If that button is selected, a file Open dialog box 
is displayed pointing to the folder containing the MS Search Program and looking for a TXT file. If a TXT file containing 
a list of CAS#, without dashes (-), NIST#, or ID# in a column, it can be selected for the search of the list. 
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Figure 77. Tops of NIST No. and CASrn Search dialog boxes in the Other Search tab view. 

As shown in Figure 78, a feature introduced in v.2.2 of MS Search (NIST 14) was the display of columns showing not 
only the number of Synonyms, the number of Other (non-mass spectral) Databases in which the Hit can be found 
but also the retention index (RI), if available. The RI value shown is determined by settings in the Library Search 
Options dialog box, displayed from the Options menu of the Main Menu or by selecting the  button in the Lib. 
Search tab view. These column headers are available for the Hit List of searches performed in Lib. Search tab view. 
The display of these columns is controlled by the Hit List page of the Properties dialog box displayed by selecting the 
Properties option from the RMB menu displayed when the Mouse pointer is in a Hit List window of these two tab-
views. New in v.4.0 is the possibility to display the MW (nominal mass in the case of EI spectra) and Formula (elemental 
composition). 

For data when using the Tandem spectrum type, it is possible to add precursor type (Prec. Type), instrument type 
(Instr. Type), Energy, and modes (Mods) fields to the Hit List. 

 
Figure 78. Results of a Formula Search showing the number of Synonyms for the Hits, the number of Other 

Databases in which the Hits can be found, and the RI value (if present) columns. 
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A very important search carried out in the Other Search tab view is the Sequential Method Search. This is a wild card 
search which allows the user to customize the mass spectral and metadata included in the search. As an example, with 
the Sequential Method Search, the search can be limited to only spectra that comes from a specific contributor. 
The dialog box for a Sequential Search is different depending on the spectrum type (EI or Tandem) selected. The 
available selections are dependent on the selected Spectrum Type. The figure below shows what would be seen if 
the Any or Tandem (left) and EI (right) spectrum types were selected. 
The Options page of the Sequential Search dialog box of the Other Search tab view is the same for both spectrum 
types. It allows the specification of the libraries to be searched and the Max Num of Hits (6,000 or less). Libraries are 
selected in the same way as they are in the Libraries page of the Library Search Options dialog box of the Lib. 
Search tab view.  

  
Figure 79. Sequential Search dialog box for the EI Spectrum type (left) and Tandem Spectrum type (right). 

These selections are the same as the Constraints selection. 

Names tab view 
The third tab view, Names, is used for the NIST Incremental Name Search (Names). This view has two different 
appearances. One is for the search of NIST provided libraries (Figure 80 and Figure 81) and the other is for user-
libraries including those provided by third parties such as the Wiley Registry of Mass Spectral Data (Figure 82).  

The Names search can only be performed against one mass spectral library at a time. The library to be searched is 
selected by using the Names tab view’s dropdown list box next to the  button. If the  button (far left just below 
the Button Bar) is selected, the only allowed characters in the text entry field are the letters a–z. If the  button has 
NOT been selected, numbers as well as letters can be input. Names containing Greek alphabet characters can be 
pasted into the text entry field. Typed dashes, parentheses [( )] and other punctuation characters will not be accepted. 
All letters are entered as upper-case regardless of the input. Previous versions of MS Search allowed for a maximum 
of 18 characters. As of V.3.0, this was expanded to 250 characters. 

When an NIST Library is being searched (mainlib, replib, tandem_msms, etc.), the left side of the display is divided into 
two parts. The upper part is the alphabetical list of names. This is not only the primary name (mainlib name) but also 
all the synonyms associated with a spectrum.  

The Name search of both the NIST/EPA/NIH EI Library, the NIST Tandem Mass Spectral Library and user-libraries 
use not only the main name but also any names in the synonyms field. As an example, the mainlib compound name 
for acetylsalicylic acid is the common name Aspirin. This compound has 157 synonyms, and its spectrum can be 
displayed by entering any of these names including trade names such as Bayer. 

By default, the entered string represents the second name in the Hit List. That name is highlighted. Any name in the 
Hit List can be highlighted by placing the Mouse pointer on it and clicking the left Mouse button once. For NIST provided 
libraries, The upper part of the Hit List will continue to appear as before, only the highlighted spectrum is visible in the 
two windows to the right. The bar graph spectrum for that compound appears in the upper window on the right. This is 
by default. The display can be changed to three vertical Window, by selecting Change Splitter Orientation from the 
RMB menu. Another view can be displayed when clicking on the Change layout ( ) button in the Button Bar. The 
original layout can be restored by clicking on the Set default layout ( ) button. The lower window contains the 
spectrum metadata. Other display options can be found in the Names Search Properties 3-page dialog box displayed 
by selecting Properties from the RMB menu. 
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The Hit List window is divided into two parts when searching an NIST provided library, The bottom part contains all 
associated spectra with the selected spectrum in the top part. The first name in the list in the bottom part (spectrum) 
is the display of the highlighted spectrum in the top part of the Hit List window. This is followed by a list of one or more 
replicate(s) if there are multiple spectra for the compound. As each entry in the lower list is highlighted, the information 
in the right-side upper and lower windows will change. The highlight in the left-side upper window remains in its original 
position. 

Following the replicate(s) is structural replicate, isotope, which in the case of naphthalene are several examples of 
deuterated naphthalene. Following this in the list is the label (precursor + #) followed by the name of a derivatizing 
agent. These spectra will always be listed regardless of the settings in the Replicates dialog box displayed from 
Options on the Main Menu.  

If the NIST/EPA/NIH EI Library (mainlib) is being worked with, a good example would be to enter NAPHTHALENE. This 
compound has one mainlib spectrum (spectrum) and three replicate spectra (replicate 1, replicate 2, and replicate 3). 
Following that are three listings (structural replicate, isotope), each representing a different deuterated variant of 
naphthalene. 

For NIST Tandem Libraries, both accurate m/z value spectra (high res) and integer m/z spectra (low res) are grouped 
together for the purpose of the Incremental Name search (ht/lr NIST tandem). Once this Library has been selected, 
as the name is typed in the text entry box, the extended name will appear in the upper part of the Hit List. The lower 
part of the Hit List contains the individual product-ion spectra for the specified precursor ion. The listing begins with 
the precursor type ([M+H]+, [M-H]-, [M+2H]+, [M+H-C6H5CO2H]+, [M+Na]+, [M-H2O]+, etc.). The precursor type is 
followed by the instrument type (HCD, IT, QQQ, IT-FT, and QTOF). Next is the percent of Collision Enter value when 
applicable, and the m/z value of precursor ion to a single decimal place; i.e., P= 357.3 for the [2M+H]+ of the protonated 
dimer of 3-methy-5-phenylpentanol (MW 178 Da with an observed precursor-ion at m/z 357.2787 when measured using 
HCD). If the spectrum was measured at other an accurate m/z value, the listing will end with (LR). An example of a 
name search is shown below. 
 

 
Figure 80. Incremental Name Search Using NIST 26 EI Library. 

Nota Bene: The use of synonyms is also supported in user libraries. Thus, if a spectrum is given a synonym  
“Lab Book 4-PG-22”, then the data can be retrieved by that name using the Incremental Name search. Replicate, 
isotopic variant, and stereoisomeric spectra are not supported in the Incremental Name search of third-party and 
user-libraries. 
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Figure 81. Incremental Name Search Using NIST 26 Tandem Library. 

 

 
Figure 82. Incremental Name Search Using a Third-Party EI Library. 
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The Compare tab view 

  
Figure 83. Blank Compare tab view with Hit List (Query/Compare/Hits) option selected. 

The fourth tab view, Compare, has two modes of operation. These can be 
alternately chosen by using the Select Compare Mode selection from the 
Options menu displayed by selecting Options on the Main Menu of the Compare 
tab view. This selection is only available on the Option menu of the Main Menu 
of the Compare tab view. The default is Selected Spectra. When a selection is 
chosen in the Compare Mode dialog box, the current contents will be deleted. If 
the Hit List (Query/Compare/Hits) option is selected, a blank set of windows will be displayed as shown Figure 83. 

 

Figure 84. Blank Compare tab view with Selected Spectra option chosen. 
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If the Selected Spectra option is chosen in the Compare Mode dialog box, the Compare tab view will appear as 
shown Figure 84. Nearly every RMB menu in all the windows of all the tab views has a Send To\Compare List 
selection. This action can perform differently depending on where the spectrum/spectra is/are being sent from. The 
first time MS Search is started, the Compare tab view is blank, as shown in Figure 84. The Compare tab view will 
retain the contents and configuration present when the program is closed. Therefore, before sending spectra to the 
Compare tab view, it is best to select the Compare tab view and use the Clear selection from the RMB menu. This 
would be the time to change the mode in the Compare Mode dialog box, if desired. 

With the Compare Mode set to the default (Selected Spectra), after performing a library search in the Lib. Search 
tab view, the Compare tab view WILL NOT be brought into focus. Select several spectra for a comparison from the Hit 
List window of the Lib. Search tab view. Issue the RMB menu Send To\Compare List command. The focus will 

automatedly change to the Compare tab view and it will appear as shown 
in Figure 83 but populated. The top spectrum is the one just searched. Next, 
is the Compare window with four display options (Head-to-Tail (sometimes 
referred to as a butterfly display), Side-by-Side, Difference, or 
Subtraction). The lower section contains the spectra to be compared with 
the queried spectrum.  

Return the focus to the Lib. Search tab view, select a new set of spectra 
from the Hit List, and issue the Send To\Compare List command. The 
focus automatically changes to the Compare tab view, and the lower 
section now contains the just selected spectra for comparison with the 
queried spectrum, which is still in the top window. The maximum number of 
comparison spectra visible in the display is set in the Comparisons page 
of the Compare Tool Properties dialog box (Figure 85). The number of 
spectra available for comparison can exceed this number and are brought 
into focus via a scroll bar on the right side of the lower window.  

If the Lib. Search tab view Spec List Plot/Text information window has 
the Spec List tab selected, the spectrum in the top window of the Compare tab view may not necessarily be that 
spectrum. The spectrum displayed in the Query Spectrum window of the Compare tab view is that which generated 
the Hit List. 

When the Compare tab view comes into focus, the spectrum in the list of spectra is automatically compared to the 
spectrum in the Query Spectrum window. To compare another spectrum, put the Mouse pointer on the spectrum in 
the list and click the left Mouse button once. It may be necessary to use the scroll bar on the right side of the compare 
spectrum area to make the desire spectrum visible. 

Selecting Hit List (Query/Compare/Hits) in the Compare Mode dialog box will cause the Compare tab view to be 
that shown in Figure 83. The value in the box to the right of the Hit List (Query/Compare/Hits) label is the number of 
first Hits that will be sent to the spectra for comparison area. Now, when a search is performed in the Lib. Search tab 
view, these areas in the Compare tab view will be populated. The Compare tab view WILL NOT come into focus. To 
show the results, select the Compare tab at the bottom of the program’s display. Each time a library search is 
performed, the areas in the Compare tab view will be repopulated and the Compare tab view will not come into focus 
until selected. The first X Hits are displayed in the spectra for comparison area. 

In this mode, the Lib. Search tab view can be brought into focus after viewing the Compare tab view, one or more 
spectra selected from the Hit List window, and the RMB menu Send To\Compare List command issued. The 
Compare tab view will automatically come into focus with the additional spectrum/spectra selected from the Hit List 
replacing the existing spectra and appearing in the spectra for comparison area of the Compare tab view.  

Comparing selected spectra with queried spectrum: When the Compare tab view is in the configuration shown in 
Figure 83, the top window is a plot of the queried spectrum. The next window is the Compare window. This has four 
different display options: Head to Tail (butterfly), Side by Side, Difference, and Subtraction. The different displays 
are selected by placing the Mouse pointer on the labeled tab at the bottom of the Compare window and clicking the 
left Mouse button. The Head to Tail (butterfly) and Side by Side displays are self-explanatory. The Difference is a 
butterfly display showing peaks in one color pointing up that are exclusive to the queried spectrum and pointing down 
that are exclusive to selected spectrum from the spectra for comparison area. A third color is used to indicate peaks 
present in the spectra of both compounds. This can point up or down and their intensity is associated with the 
spectrum having the highest abundance with lower abundance subtracted. The Subtraction display is where all m/z 

 
Figure 85. Compare Tool Properties 
dialog box, Compare List page. 
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values and their intensities in the Hit spectrum are subtracted from the queried spectrum. Searching the defense may 
identify a compound whose mass spectrum exists in the data with that of the reported Hit.  

Spectra can be copied from any source in MS Search and pasted into the Queried Spectrum window or the window 
containing spectra to be compared to the quired spectrum of the Compare tab view. If the paste is done to the window 
containing spectra to be compared, the current Compare tab view will be replaced by the spectrum/spectra being 
pasted. The Compare and Queried Spectrum windows will no longer be visible. If a single spectrum is pasted to the 
Queried Spectrum window it will replace the contents. If an attempt is made to paste multiple spectra, only the first 
one will appear. 

Put the Mouse pointer on any spectrum display in any Plot or Text Information window or any Hits List or Spec List 
window of any tab view and display the RMB menu. Select Copy (NOT Copy Plot). Bring the Compare tab into focus. 
Put the Mouse pointer on the top of the Queried Spectrum window, display the RMB menu, and select Paste. This 
will replace the current displayed spectrum. The same actions WILL NOT replace the spectra in the spectra for 
comparison area. The only way to add spectra to the spectra for comparison area is to send them from the Hit List or 
Spec List using the RMB menu Send To\Compare List command. If an attempt to Paste spectra to the Compare tab 
view’s spectrum compare area is made, the exiting display will be replaced with a queue of spectral plots being sent. 
The Send To\Compare List RMB menu command issued from the Other Search, Names, Librarian, and 
Chromatogram tab views will replace with the selected spectra what is in the Compare tab view if it is configured as 
the Query/Compare/Hits view regardless of the selected mode of the Compare Mode dialog box. If the contents are 
that of the Selected Spectra view, the sent spectra are prepended to the list. As new spectra are sent, they will be 
prepended until the RMB menu Clear command is issued. 

By placing the Mouse pointer in either window contaminating text information in the Chromatogram tab view, the 
spectrum (Library Match or Deconvoluted) can be sent to the Compare tab view using the RMB menu Send 
To\Compare List command. Placing the Mouse pointer on one of the component indicators () in the Chromatogram 
window allows that deconvoluted spectrum to be sent using the same RMB menu command. One or more selected 
deconvoluted (only) spectra can be sent to the Compare tab view using this same RMU menu command from the 
Chromatogram tab view’s Chromatogram window. 

One important consideration in sending spectra from the Chromatogram tab view is the situation where spectra have 
been sent to the Compare tab view and then a sequent chromatographic file is processed. If spectra are sent to the 
Compare tab view without first using the RMB menu Clear command in the Compare tab view, the spectra from the 
new file will prepend to those already present.  

Regardless of the Compare tab’s view (Query/Compare/Hits or Selected Spectra) or the selected mode of the 
Compare Mode dialog box, spectra from the Chromatogram sent using the RMB menu Send To\Compare List 
command will overwrite the existing Query/Compare/Hits view and appear in the Selected Spectra view or prepend 
the contents of the existing Selected Spectra view. 

The Change Layout button ( ) on the Toolbar is inactive (grayed); however, the Set default layout button ( ) is 
not. If  button is selected when the Compare tab is in the Select Spectrum view, regardless the setting in the 
Compare Mode dialog box, the view will be changed to the Query/Compare/Hits view. The Query Spectrum and 
Compare windows will be blank and the spectra window will be blank. The spectra that were in the Selected Spectra 
view are now in the lower part of the display  

Random spectra can be compared in the Compare tab view. Select the Compare tab view. If the display is the 
Query/Compare/Hits view, change it to the Selected Spectrum view (Figure 84) using the Compare Mode dialog 
box displayed by selection Select Compare Mode from the Option menu of the Main Menu. Select the Clear command 
from the RMB menu. Select spectra from various tab views can be copied using the Copy command on the RMB 
menu. Bring the Compare tab view into focus and then issue the Paste command. Alternately, the Send To\Compare 
List command can be used after selecting the spectra. This process can be repeated several times. After all the spectra 
to be compared to a single spectrum have been collected, select that single spectrum and issue the RMB menu Copy 
command. Bring the Compare tab view into focus and select the  button. This will restore Query/Compare/Hits 
view. Place the Mouse pointer in the Query Spectrum window and issue the RMB menu Paste command. 
Comparisons can then be made by selecting spectra, one at a time, in the spectra for comparison area.  

There is no Change Splitter Orientation on the RMB menu when displayed from any of the windows. 

.  
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The Librarian tab view 

 
Figure 86. Librarian tab view Button Bar. 

The fifth tab view, Librarian, is used to deal with spectra that are in user-libraries or that are to be added to user-libraries 
or have been imported or searched. This tab view is also used to associate structures with measured spectra allowing 
the comparison of the structure and measured spectrum using the Mass Spec Interpreter program. The layout of this 
tab view is the same as the Other Search tab view, with the exception that the far-left window contains the Spec List 
rather than a Hit List. This is the same Spec List as displayed in the upper left window of the Lib. Search tab view.  

The Librarian tab view is the utility area for mass spectral libraries. This is used to build user libraries, copy spectra 
to text files for distribution, associate spectra with structures, and add information that may need to be associated 
with user-libraries. 

 
Figure 87. Spectrum Information dialog box with the Additional Info and Edit RI data dialog boxes overlaid. 



  

Page 94  NIST 26 MS Libraries and MS Search Program v.4.0  

The Librarian tab view allows for the editing or creating of spectra. This editing not only allows m/z intensity pairs to 
be edited, deleted, or added; but also allows CAS registry numbers, elemental compositions, structures, names, and 
synonyms to be edited, added, or deleted (structures cannot be deleted once associated with a spectrum; only 
exchanged).  

Nota Bene: The process of deleting a structure (not exchanging it for another structure) is somewhat 
convoluted. The spectrum with the structure must be edited (highlight the spectrum in the Spec List of the 
Librarian tab view, and then select the Edit button in the Button Bar) to assure the CAS# field is not 
populated. Next, export the spectrum using the Export button on the Button Bar. The nascent saved 
spectrum can then be imported, and when viewed, will no longer have a structure. A possible work around 
is to open a structure drawing program. Select the text tool and with Mouse pointer on the drawing palette, 
press the <space bar> three or four times. Highlight this area, The drawing program should indicate 
something is highlighted. Use the program’s command to send that which is selected to the Window’s 
Clipboard. Bring MS Search back into focus and highlight the spectrum if it is not already. Select the Edit 
button. On the right side of the Spectrum Information dialog box, next to the displayed structure, is a button 
labeled From Clipboard. Select it. The displayed structure will disappear and be replaced with the  icon. 
Select the Add to List button at the bottom of the dialog box and the edited spectrum will appear at the top 
of the Spec List. Select the spectrum to see there is no longer a structure associated. The Formula 
(elemental composition) will be displayed with the spectrum if that field was not depopulated during the 
editing. If that spectrum is exported to a text file and then imported back into MS Search, a structure will be 
associated with it, if the export had a populated CAS# field, and there is a spectrum with a structure and this 
CAS# in the NIST mainlib. 

In addition, detailed text information about an EI or Tandem (integer or accurate m/z) spectrum can be added using a 
predefined set of field titles (the Additional Info button on the Spectrum Information dialog box). The Edit function 
of the Librarian tab view also allows for the addition or editing of the Retention Index information for EI spectra (the 
Edit RI button). See Figure 87. 

It should be remembered that all NIST spectra are copyrighted and can be used only on a single computer, accessible 
by no more than one person at a time. If an NIST spectrum is added to a user-library, even though that spectrum and 
its Text Information has been edited, the user-library can only be used on the licensed computer. It cannot be shared 
with another computer. 

The Librarian tab view can be used to create and add spectra (a single spectrum or a group of spectra) to a text file. 
As of NIST 23, the default extension for text files is *.MSPEC. Prior versions used the extension *.MSP. This is a 
Microsoft extension that can cause problems when sending files by email. This file is readable by any text editor such 
as the Microsoft Notepad program. These text files DO NOT support structures. If you want to share spectra you have 
measured and associated structures with, they should be put into a user-library and then the user-library, which is a 
folder, should be put into a ZIP file for sharing. 

The position of the splitter bar dividing the Plot and Text Info windows can be changed by selecting Change Splitter 
Orientation on the RMB menu, displayed when the pointer is in either window. There are three alternat configuration 
available by clicking on the  button. The  button will return all displays to the default values. 

Zoom. Placing the Mouse pointer on a Plot window in any of tab views or the Compare window of the Lib. Search or 
Compare tab view, holding the left Mouse button down and dragging the Mouse pointer along a diagonal will result in 
drawing a zoom rectangle. After releasing the Mouse button, a zoomed spectrum will be displayed; the cursor will 
change to a magnifying glass. To return to the normal display, select Zoom Out from the RMB menu or double-click 
with the Mouse pointer in the window. All the windows with spectrum plots in the tab view will be zoom the same. 

Additional information on the Librarian tab is provided later in this manual under User-Libraries. 
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Chromatogram tab view 

 
Figure 88. Chromatogram tab view with the Any Spectrum Type selected, the Select Spectrum Type dialog 

box displayed when Select Spectrum Type is selected from the File menu, and the File menu displayed when 
EI and Tandem spectrum type have been selected from the Select Spectrum Type dialog box. 

The Chromatogram tab view is new to v.4.0 of MS Search provided with both the NIST\EPA\NIH Electron Ionization 
(EI) Mass Spectral Library and the NIST Tandem Library installations of NIST 26. This application requires a 64-bit 
computer using Microsoft® Windows®. This utility allows library search processing of full data files (GC/MS and 
LC-MS/MS), both low- and high-resolving power data. For GC/MS data files, the analysis employs an updated version 
of AMDIS (Automated Mass Spectral Deconvolution and Identification System). AMDIS was introduced with the 1998 
version of the NIST\EPA\NIH EI Library (NIST 98). Both nominal m/z value and high-resolving power GC/MS data can 
be processed. 

For LC-MS/MS (Dynamic Data Analysis, DDA) chromatogram, all MS2 spectra are searched against the NIST Tandem 
Library using newly developed software by the NIST Mass Spectrometry Data Center. MS1 data is processed using 
the XICanalyzer program. The XICanalyzer program identifies the chromatographic peak for each spectrum, which can 
then be viewed with the incorporated XIC Browser program. Individual MS2 spectra can be further analyzed using 
multiple tools provided with MS Search which allow for alternate search and display methods, such as the Hybrid 
Search to identify compounds not in the library. It is possible to save spectra into user-libraries using the tools in the 
Librarian tab view. This new utility (Chromatogram tab view) provides advanced spectral filtering to discard low 
quality, unidentifiable spectra that often make up a large portion of the acquired data. 

In the EI (or Any) Spectrum Type mode, the Open EI Highres Input Files allows the reading of Thermo Fisher 
GC-Orbitrap files (*.raw), mzData files (*.msdata), mzML (*.mzML), or netCDF (*.cdf). Integer resolution (lo-res) data 
files produced by several different manufacturers’ instruments or *.CDF files can be read. For LC-MS/MS data (when 
Tandem is selected in the Select Spectrum Type dialog box) the file types include the Thermo Fisher Orbitrap® (*.raw) 
mzML files (*.msML) and the Bruker's tims TOF instruments (*.tdf). Most chromatography/mass spectrometry 
instrument manufactures have utilities that will copy data from their proprietary format to one supported by the NIST 
software. If not, msconvert, which is part of ProteoWizard (free download from https://proteowizard.sourceforge.io/) 
can. 

https://proteowizard.sourceforge.io/
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Figure 89. Dialog boxes displayed when one of the three Analyze File types is selected from the File menu of 
the Chromatogram tab view.  

Each chromatogram file type (EI nominal m/z GC/MS, HiRes EI GC/MS, LC-MS/MS) will display a multipurpose dialog 
box. The libraries for the deconvoluted components to be searched against are selected by selecting the Libraries 
button. The Libraries dialog box is displayed. This dialog box is universal for all three types of data. It functions the 
same as the Libraries page in the Library Search Options dialog box displayed on the Lib. Search tab view. There 
is a section that displays Available libraries and one that list the libraries that will be searched (Included Libs:). 
Separate sets of Libraries can be selected for each type data to be processed. 

The first input line of the two EI (LowRes and HiRes) dialog box is to specify the type of analysis: Analysis with RI 
(retention index) Calibration; Generate RI Calibration File; Analyze with RI Estimation; and Analyze NO RI.  

If the Analysis with RI Calibration Analysis type is chosen, the first step is to generate an RI Calibration File. This EI 
GC/MS file should reflect the same resolving power as the data (LowRes or HiRes), be acquired using the same GC 
conditions, and contain data obtained on a mixture of sequential linear hydrocarbons. After the file is selected from the 
Select Data File dialog box and that dialog box closes, the Select LowRes (or HiRes) Input/Calibration File dialog 
box will remain displayed. Now select the OK button on the dialog box and the Calibration file will be generated, at 
which point the dialog box will close. The next step is to re-display the Select LowRes (or HiRes) Input/Calibration 
File dialog box the File menu on the Main Menu bar and select Analysis: Analyze w/RI Calibration File. Then, chose 
the Calibration File by selecting the button with … at the end of the entry filed to display the file Open dialog box. The 
Calibration file name will have the extension CAL, be in the same folder that contained the calibration data file and have 
the name of the folder. Next, choose the Input File. This is done in the same way as the Calibration file was chosen 
using the Input File box. 

There are several more steps that can be taken before the data file is 
analyses. Select the RI Settings button. This opens the Retention 
Index Score Correction (Semi-Standard Non-Polar Column) dialog 
box shown on the left. Deciding on the values for this dialog box may 
require some experimentation. Once set for a series of analyses, this 
dialog box may not have to be redisplayed. 

Another button on the Select LowRes (or HiRes) Input/Calibration File 
dialog box is labeled AMDIS Deconvolutions Settings which will display the dialog box shown on the lower right). The 
Combine scan is only relevant to data acquired at high-resolving power. The data acquisition rate of these instruments 
may result in multiple component-identifications for a single compound. By using a value of 2 or 3, this can be prevented, 
and it will speed the analysis. Another significant factor is the Scan direction. A lot of the data being used is in the 
netCDF format. Therefore, the scan direction is not known, Most 
transmission quadrupole mass spectrometers acquire data from low m/z 
to high m/z values. All Agilent quadruple instruments acquire from high 
m/z values to low m/z values. All Time-of-Flight and other pulsed type 
instruments, such as the Orbitrap, have no scan direction.  

The File selection on the Main Menu will have an option to reopen a 
processed data file, depending on the Spectrum Type selected 
(Tandem or EI). If Any has been selected, there are both Reopen EI 
Results and Reopen MS/MS Results selections. Processing can be 
lengthy. This feature can be time saving. The same is true for the Run 
in background  selecting in the Select Input File dialog box. Unless 
the Reload on startup  is selected, the processed file visible when 
MS Search is exited will not be displayed on restart. 
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After all settings in the Select Input File dialog box 
have been made, select the Ok button. If the Run 
in background  has been selected, the dialog 
box closes, and a Running Task label will appear 
in the Filter Bar. The focus may be changed to 
another tab view and other operations carried out. 
Once the file processing is complete, the Process 
result dialog box will be displayed. Selecting the 

Open button causes the focus to change to the Chromatogram tab view showing the results of the just processed file. 
Selecting Save closes the dialog box and leaves the focus on the current tab view. When the Chromatogram tab view 
is brought back into focus, the contents will be that of the just processed data file. 

If the Run in background  has NOT been selected, when the OK button is selected, the same label will appear in 
the Task Bar, but the focus cannot be changed to another tab view. A  icon appears and stays visible until processing 
is complete, at which point the contents of the Chromatogram tab view updates. 

Like the other tab views, the Chromatogram tab view has splitter bars. One horizontal splitter bar can divide the tab 
view into two horizontal windows. The top window has two vertical splitter bars. One separates the Chromatogram 
window from the Plot Deconvoluted/Library Match Compare window and the two Deconvoluted/Library Match 
Text Information windows, which are divided by a horizontal splitter bar (see Figure 88). There is a vertical splitter bar 
dividing the Hit List window and the Structure window, which make up the lower part of the display. Processing a 
chromatogram data file can result in a large amount of information which causes a need for a larger than normal vertical 
size of the Hit List window. This can be accommodated by sliding the vertical splitter bar between the two windows to 
the right, effectively closing the closing the Structure window. The structure of the library spectrum can be displayed 
using the Show Structure selection on View menu displayed by selecting View from the Main Menu. The 
Chromatogram tab view’s Structure window can be made visible using the  (Set default layout) button. This moves 
all splitter bars to their defaulter positions. 
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Spectral Analysis Utilities for NIST 26 
Automated Mass Spectral Deconvolution and Identification System (AMDIS) 
Included as a separate utility with the NIST\EPA\NIH Electron Ionization (EI) Library, AMDIS attempts to reconstruct 
mass spectra for individual components in arbitrarily complex GC/MS chromatograms; and if a target library is provided, 
AMDIS can directly identify target compounds. AMDIS is designed to find components that may be in very low 
concentrations, not even visible in the reconstructed total ion current (RTIC) chromatogram. AMDIS is especially useful 
when an RTIC chromatographic peak represents multiple components. Regardless of each component concentration, 
pure mass spectra are deconvoluted for analyses. AMDIS was developed by NIST under a contract from the Defense 
Threat Reduction Agency (DTRA), Department of Defense, for verifying of compliance with a major international treaty 
(Chemical Weapons Convention) as ratified by the United States Senate in 1997. To meet the rigorous requirements 
for this purpose, AMDIS was tested against more than 30,000 GC/MS data files accumulated by the EPA Contract 
Laboratory Program without a single false-positive for the target set of known chemical warfare agents. Although this 
level of reliability may not be required for all laboratories, this shows the degree to which the algorithms were originally 
tested. The algorithms have undergone modifications and are the backbone for the Chromatogram tab view of the 
NIST MS Search program v.4.0. AMDIS can also be used to identify individual non-target components in complex 
samples. It has been widely used in the flavors and fragrance industry, forensics, the study of natural products, and for 
the identification of metabolites from EI mass spectra. 
AMDIS has been designed to reconstruct “pure component” spectra from complex RTIC chromatograms even when 
components are present at trace levels. For this purpose, observed chromatographic behavior is used along with a 
range of noise-reduction methods. AMDIS is distributed with specialized libraries (environmental, flavor and fragrance, 
and drugs and toxins) that were derived from the NIST 02 MS EI Library. AMDIS has a range of other features including 
the ability to search the entire NIST\EPA\NIH EI MS Library with any of the spectra extracted from the original data 
file. It can also employ retention-index windows when identifying target compounds and can make use of internal and 
external standards maintained in separate libraries. A history list of selected performance standards is also maintained. 
AMDIS is installed by default in the c:\NIST26\AMDIS32 folder when the NIST\EPA\NIH EI Library is installation is 
carried out. This folder contains a file with the name AMDISMan.PDF, which is a program maula. AMDIS has an 
extensive interactive Help system. The manual can be accessed from an icon in the NIST 26 folder of the Windows 
Start menu. AMDIS can be started from a selection on the Tools menu of MS Search or from a button ( ) on the 
Tools Bar. There is also an AMDIS Search in the Windows Strat Menu 

The instruments that are supported in their native file format are: †  

Agilent ChemStation (GC-MS) and MS Engines 
Bruker DALTONICS GC-MS (*.MSF) 
Finnigan (GCQ, INCOS, ITDS, ITS-40, ITD-700/800, ITMS) 
Inficon (*.acq)  
JEOL/Shrader (*.lrp) 
Kratos Mach3 (*.run) 
Micromass (MassLynx, NT Formats) (RAW) 
mzXmL/mzData 
Perkin-Elmer TurboMass (RAW) and ITD-700 (*.ms) 
Shimadzu MS Files QP5000 and QP5050 (*.R##) 
Thermo Fisher Xcalibur (RAW) 
Varian (MS, SMS, XMS) 
 

In addition, the NetCDF format, which is supported by many manufacturers, is readable by AMDIS. Other formats will 
be added in future releases. Contact NIST for future information. 

A PowerPoint Presentation and a PDF file entitled “Instructions for using AMDIS with NIST MS Search” can be 
downloaded from https://chemdata.nist.gov/dokuwiki/doku.php?id=chemdata:amdis. Jim Little has AMDIS-use videos 
on his Website ( https://mzinterpretation.com/). 

 † The use of specific product and trade names does not indicate an endorsement by the National Institute of 
Standards and Technology. The specific file formats are supported to ensure that the data is transferred to 
AMDIS with no information loss. The specific formats and names are covered by the respective copyrights 
of the individual companies. 

  

https://chemdata.nist.gov/dokuwiki/doku.php?id=chemdata:amdis
https://mzinterpretation.com/
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MS Interpreter 
This tool was developed to aid NIST evaluators in their analysis of mass spectra. In one integrated program, it enables 
a variety of calculations on a mass spectrum, using a proposed chemical structure if available. Spectra and structures 
are associated in the spectral editing component of the Librarian tab view of the MS Search Program discussed in 
USER LIBRARIES section and APPENDIX 3 of this manual. MS Interpreter is activated for an individual spectrum 
with the Mouse pointer on a Plot or Text Information window or by highlighting the name or structure of a compound 
in a Hit List or the Spec List and selecting MS Interpreter on the Send To menu of the RMB menu. This action opens 
MS Interpreter with the spectrum and associated structure (Figure 90). MS Interpreter can also be opened from the 
Tools menu or the button ( ) on the Tool Bar. If a spectrum/structure has been opened in MS Interpreter and the 
program is closed and then reopened from either the Tools menu or the button on the Toolbar, the last contents will 
be displayed. If MS Interpreter is started by either of these two actions just after starting the Program, both the 
Structure window and the Spectrum window will be empty. Spectra can be imported from MSP files (text files 
containing spectra in the NIST MS Search format), JCAMP-DX, and SDF files. If the folder also contains a *.STB 
structure file that has the same name as the MSP file, that structure will be associated with a spectrum in MS 
Interpreter. When a structure/spectrum pair is Saved from the MS Interpreter File Menu, a single SDF file containing 
the spectrum and the structure is created. These can be opened in MS Interpreter but not MS Search. 

 
Figure 90. The main Window of MS Interpreter. The black lines indicate the peaks in the mass spectrum that 

the MS Interpreter can explain. The white lines indicate the ones it cannot.  
The Insert is the Isotope Calculator. 

Peaks in the spectrum originating as a logical fragment of the molecule (M+• or MH+) are marked at the top of the 
spectrum display; and corresponding fragments, derived from thermodynamic approximation, may be highlighted by 
clicking on one of these marks. The program also allows for keeping track of important neutral losses, both from the 
precursor or a derived ion and to find all possible formulas for any peak or neutral loss. Isotopic patterns for any cluster 
can be examined separately. These isotope clusters can be compared to theoretical predictions subject to several 
user-specified constraints. MS Interpreter is a separate program that also has an icon in the NIST Mass Spectral 
Database Start Menu folder. It has a detailed Help screen that can be called from the program by selecting Help on its 
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Menu Bar or by pressing the F1 key. Information about the control currently located under the Mouse pointer and 
possible user actions is displayed in the Status Bar located at the bottom of the program main Window. Placing the 
Mouse pointer in the mass spectrum display and clicking the right mouse button will result in a somewhat self-
explanatory RMB menu. Before using the program, explore this RMB menu (Figure 92). 
Selected ions on the plot of the mass spectrum can be sent to Formula Calculator and the Isotope Calculator using 
selections on this menu. A specific m/z value can be locked as the position from to display calculated losses. In addition, 
the Fragment options dialog box can be displayed (Figure 91). 

 
More detailed information can be obtained regarding the use of this utility by pressing the F1 key with the Mouse 
pointer in one of the Program windows. 

Exact masses of fragment ions 
The Structure view displays not only nominal m/z but also exact mass of the predicted fragment ion. 

Pasting a chemical structure into the Structure view 
• Copy a structure from a structure editor or MS Seach (Molfile format) into Windows Clipboard;  
• In MS Interpreter, click the Structure window Title Bar to activate it;  
• Click the Paste button (3rd in 2nd group of Button Bar) or select from the menu: Edit/Paste or press Ctrl-V. 

Pasting a mass spectrum or a chemical structure into Mass Spectrum view 
Contents of a file containing a mass spectrum or a structure or both (SDF file) may be pasted into the MS Interpreter. 

Pasting a peak list into the Mass Spectrum view 
• Copy a peak list into the Windows Clipboard; 
• In MS Interpreter, click Mass Spectrum Window to activate it; 
• Click Paste button or select from the menu: Edit/Paste, or press Ctrl-V. 

NOTES: 
• the peak list must be made out of m/z and intensity pairs separated by any of the following characters:  

space , ; : ( ) [ ] } | Tab 
• each line must contain one or more m/z and intensity pairs; 
• if at least one line contains an odd number of values, then the program reads only first two numbers (one 

peak) from each line; a warning is displayed; 
• all peaks must be in order of either ascending or descending m/z; 
• all m/z are rounded to the nearest integer by the MS Interpreter; 
• there is no need to normalize intensities to 999. 
• Structure/spectra pairs can be saved or open from SDF files by MS Interpreter; however, when you try to 

open these files in MS Search, only the structure will be imported. 

 
Figure 91. Fragment options dialog box. 

 
Figure 92. Menu displayed when the Right Mouse 
button is on the Plot portion of the MSI Program.  
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Pasting MSP, SDF, MOL, and JDX (JCAMP-DX) files from Windows Explorer 
• MSP, SDF, MOL, and JDX files may be copied from Windows Explorer and pasted into the Structure or Mass 

Spectrum view of MS Interpreter. 
• The name of the imported file appears on the MS Interpreter Title Bar and in the MRU (most recently used) list in 

the File menu. 
• The files of the same type may be dragged from the Windows Explorer and dropped into the same MS Interpreter 

views. In all cases, only the first spectrum and/or structure from the first selected file is/are imported. 

Copying calculated isotope envelope table from the Isotope Calculator into Windows 
Clipboard 
• Right-click any line in the Isotope Calculator table 
• Select Copy.  

This will copy into the Windows Clipboard a tab-delimited text, which is suitable for pasting into an MS Excel 
spreadsheet or text editor. The context menu and the text contain words “Default Isotope Table” or the name of the file 
from which a custom isotope composition was imported (refer to the following section). 

Using custom isotope composition table in Isotope Calculator and Formula Calculator 
• Open file MS_Interpreter_isotope_table_test_01.itbl in a plain text editor. This file is installed in the same folder as 

MS Interpreter, typically, c:\nist26\mssearch 
• Read the NOTES in the file 
• Edit the file and save it under another name 
• From MS Interpreter menu, select File/Import Isotope Table 
• In the Open Isotope File dialog box, select the newly created file and click the Open button. 
• To restore the original table, import file MS_Interpreter_isotope_table_default.itbl. The original table is restored 

automatically after both MS Interpreter and MS Search are shut down. 
• Every time a *.itbl file is imported, a *.itbl.log file is created or appended. This file contains the date, time, a full 

pathname of the .itbl file, and a list of differences (if any) between the current and the imported isotope table or a 
reason for the failure to import the new table. 

Selecting a Portion of the Structure for Mass Calculation (lasso function)  
You may drag the mouse around the displayed 
chemical structure to compute the mass of the selected 
substructure (highlighted in red). Put the Mouse pointer 
on a starting point in the Structure window. Hold down 
the left Mouse button as you drag the pointer around 
the portion of the structure you want to select until the 
pointer is back at its starting position (e.g., lasso the 
portion of the structure you are interested in). When the 
left Mouse button is released, information is updated 
and the Structure window shows the selected portion 
of the structure in red. The mass will also be shown on 
the spectrum. This need not correspond to an actual 
peak – predicted or observed (Figure 93). 
  

 
Figure 93. Screen showing the results of Lassoing a part 
of a structure (top) in the MS Interpreter display and the 

resulting change in the display bottom. The Formula 
Calculator is automatically updated. 
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Example Searches 
Library Spectrum and Structure Searches 
New in v.3.0 of MS Search was the ability to customize the program to the type of spectra being worked with. In v.4.0 
there are three modes which can be selected from the dialog box displayed when the Select Spectrum Type option is 
selected on the File menu. The selected mode determines the type of searches available.  

EI Tandem Any 
Identity Similarity Identity Similarity Identity Similarity 
EI Normal EI Hybrid MS/MS MS/MS in-EI EI Norm EI Hybrid 
HiRes/NoPre EI Simple HiRes/NoPre MS2 HYB MS/MS EI Simple 
 EINu Loss   HiRes/No EINu Loss 
     MSMS-in EI 
     MS2 HYB  

The selections in the Library Search Options dialog box (not shown) of 
the Lib. Search tab view will depend on the current mode based on 
spectrum type. As an example, the RI (GC) page on this dialog box is 
only present for the EI and Any spectrum types, and the MS/MS page is 
only present for the Tandem and Any spectrum types. The selections in 
the dropdown menus under Identity and Similarity Spectrum Search 
Type of this dialog box are different for the three spectrum types (as 
shown in the above table. To select the spectrum type, select File in the 
Main Menu. Select the Select Spectrum Type at the bottom of the File 
menu. This will display a dialog box (not shown) with three selections, 
each having a radio button. Select one, then select the OK button at the 
bottom-left of the dialog box. The spectrum type corresponding to the 
Library installed (EI or Tandem) is the default.  

The selected type of spectrum is shown in the MS Search Title Bar at 
the top of the display.  

MS Search can be used to find spectra that are the same or similar to 
that of an unidentified compound. This can be accomplished by importing 
the spectrum into the Spec List window of the Lib. Search tab view from 

a third-party mass spectral data analysis program, from a text file (*.MSP/MSPEC), or from such a file that is on the 
Windows Clipboard. Spectra are imported from a file using 
the dialog box shown in Figure 94. This dialog box is 
displayed after selecting Open on File of the Main Menu, 
highlighting a specific file in the displayed Choose file for 
spectra/structure import dialog box, and finally clicking 
on the Open button (Figure 95). It should be noted that the 
dialog used to import spectra has buttons that will display 
the Spectra Import Options or Library Search Options 
dialog box. 

Many instrument manufacturers (Agilent, PerkinElmer, 
Waters, LECO, Thermo Fisher and others) have utilities in 
their data analysis software which creates, files in the 
MSP/MSPEC format, starts the NIST MS Search 
Program, or brings it into focus, and sends the spectrum 
(or a group of spectra) to it which will automatically import 
them and run the search, if MS Search is so configured. 
Lacking this link in the manufacturer’s GC/MS software, 
some commercial systems can output a data file in the 
netCDF format. This file can be imported into AMDIS and 
spectra can be exported for automatic search directly to MS Search. MS Search can also import individual or groups 
of spectra in the IDX, SDF, KCF, MGF, DAT, PKL, mzXML, and mzData format. NEW in v.4.0, whole 
chromatographic/mass spectral (GC/MS and LC-MS/MS, DDA) data files can be processed in the Chromatogram tab 
view with the automatic searching of spectra (components) identified. 

 
Figure 94. The Library Search Options 
dialog box when Any is the selected 

Spectrum Type. 

 
Figure 95. File Selection dialog box with some of the 
available file types. MSP and JDX files are spectra, 

and MOL files are structures. 
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A spectrum can be created using the Spectrum Information dialog box displayed in the Librarian tab view by selecting 
the New button on the Button Bar to enter the m/z and intensity pairs that comprise a mass spectrum, along with a 
structure and metadata. This is described in more detail in the Librarian tab view section. 

Before attempting to execute a search of a spectrum, the details of the Library Search Options and Spectrum Import 
Options dialog boxes should be viewed and understood. Both of these dialog boxes can be displayed by selections 
from the Options menu displayed by selecting Options on the Main Menu. The Library Search Options dialog box 
can also be displayed by clicking on the in the Button Bar of the Lib. Search tab view. 

Spectral Import Options dialog box 
This dialog box (Figure 96) can be displayed by selecting Spectrum Import Options from the Options menu displayed 
by selecting Options on the Main Menu or the Import Options button on the Number of Spectra found: dialog box 
(Figure 94) to import spectra after selecting a file name from the Choose file for spectra/structure import dialog box 
(Figure 95) displayed when the File/Open command is given. The Spectrum Import Options dialog box is involved 
with the import of EI (nominal and accurate m/z) and tandem as well as spectra form techniques such as DESI/DART, 
and in-source CAD. Some sections are specific to a specific type of spectrum (EI or Tandem). If a section does not 
pertain to a spectrum type, it should be ignored. 

The upper right section of this dialog box, under the heading Tandem Spectrum Accuracy pertains only to spectra 
being imported that have the field header Precursor m/z. This field heading tells MS Search that the spectrum is to be 
imported with a precession greater than 1. The number of decimal places will be equal to that shown in the text entry 
box to the left of decimal places label. For a tandem quadrupole or a 3D QIT or 2D QIT MS/MS instrument the number 
should usually be set at 2; because the mass accuracy of these devices is 0.05 m/z units. The default number of 4 is 
satisfactory, the Q-TOF instrument; although larger values can be used, especially for an Orbitrap. 

If the value in the file from the instrument has fewer decimal places than specified in the dialog box, the low number of 
digits will be used. If the spectrum does not have a Precursor mz: field header or the value in it is invalid, such as a -
1, the spectrum will be imported as an integer value unless one of the two Accurate m/z spectrum type(s) is selected 
under the Spectra without precursor m/z valuer: (lower half of the dialog box) which will cause the radio button next 
to the EI (nominal m/z) label to be deselected. 

The two fields on the upper left of the Spectral Import Options 
dialog box are used to make mass defect corrections for integer 
m/z value data, which normally pertains to EI GC/MS data. It may 
be desirable to use this with LC-in-source CAD/single analyzer 
instruments when searching the spectra against one of the NIST 
LC-MS/MS libraries using the Identity, EI Normal search.  

The difference in the integer nominal mass and the exact mass of 
a nuclide is the mass defect. The most significant effect of mass 
defect is seen on the integer mass of hydrocarbons due to the 
mass defect of hydrogen. The integer mass of the 1H isotope, 
which is the nominal mass (most abundant natality occurring 
nuclide of an elemental) isotope, is 1. The exact mass of this 
isotope is 1.007825 (monoisotopic mass). The C50H100 
single-charge positive ion has a nominal mass (the sum of integer 
mass of the most abundant naturally occurring isotope of each 
element times the number of atoms of those elements) of 700, (50 
C × 12) + (100 H × 1). The integer value for C50H100 based on a 
calculation of the exact mass of each of these elements is 701 
(12.000000 × 50) + (100 × 1.007825) = 700.7825 (rounded). The 
mass defect for C50H100 is 0.7825, which is equal to about 100 
millimass units per 100 mass units. The NIST\EPA\NIH EI Library 
is based on nominal mass. The MS Search Program deals with 
only integer mass values when searching the NIST EI MS Library. 
Spectra are imported with integer m/z values; therefore, spectra 
recorded with observed values of m/z, which are not integers and 

have not been corrected for mass defect, must have a mass defect correction applied to be properly searched against 
the NIST EI MS Library or another EI library, which contains only nominal (integer) m/z values. 

The mass defect factor can be entered in the box Multiply m/z in imported spectra by. The factor for hydrocarbons 
based on a general formula of –(CH2)n– is 0.99888. When dealing with spectra that have significant mass contribution 

 
Figure 96. Spectral Import Options. Imported 

spectra integer m/z and no mass defect 
correction. 
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from multiple atoms of bromine (which has a significant negative mass defect), a different factor should be calculated 
(1.00087). In this case, it may be desirable to use the field preceded by “Add following term [value] to all m/z values 
before rounding”. 

Some GC-MSs have mass defect correction built into the data they store. An example is the Thermo Fisher quadrupole 
GC/MS. In this case use of EI Spectrum m/z Rounding section of this dialog box is not necessary; however, if no 
instrument correction on imported data is available and if compounds with a molecular mass >500 Da are being 
analyzed, using these settings is advised. 

The Adding spectra to Spec List section in the Spectrum Import Options dialog box allows the permanent 
specification of the action when importing spectra. Choosing Prepend will always add to the top of the current Spec 
List, Overwrite will always replace the current Spec List. Ask was the only option prior to version 2.2 of the search 
program. Some systems sending spectra to MS Search will specify to prepend or overwrite. If Ask is selected, the 
action specified by the sending software will prevail. The default is to prepend. 

Intensity threshold allows the removal of low intensity peaks from the spectrum as it is being imported. This can be 
done in terms of relative peak intensities – for example 0.1% would keep peaks to 1 part in 1000 of the base-peak. 
Absolute will simply remove data below a user specified threshold. The third selection controls the number of decimal 
places for ions with no precursor values such as accurate m/z EI data and in-source API data. 

There are three options under the section labeled Spectra without precursor ion m/z value: EI (nominal m/z), 
In-source, and Accurate m/z. The last two options are under the heading Accurate m/z spectrum type. If EI is 
selected, the data will be imported based as nominal m/z values. Some manufacturers’ instruments will report the m/z 
values of ions to the nearest 0.05 value. An example is the Agilent ChemStation Data Analysis software. If the 
instrument is configured to report these fractional values, they will be imported into Spec List as integers if the EI 
(nominal m/z) is selected. If it is desirable to have the fractional values imported, Accurate m/z should be selected in 
the Spectra without precursor ion m/z value are area; however, it is recommended to import these spectra as 
nominal m/z values. GC/MS instruments with high m/z accuracy data such as the Agilent GC-QTOF, the JEOL 
AccuTOF Alpha, The Thermo Fisher GC Orbitrap, and LECO Pegasus GC-HRT should have the data imported using 
the Accurate m/z setting. These data should be processed using the EI spectrum type. 

If Accurate m/z is selected, GC/MS and other accurate data, such as that from DART, will be imported as decimal 
values. For more details, select the Help button in the Spectrum Import Options dialog box. Spectra without precursor 
ion m/z values are assumed to be EI (nominal m/z) data by default but can be changed to be In-source/EI with 
accurate ion m/z spectra or Accurate m/z for accurate GC/MS data. The number of decimal places for 
In-source/accurate m/z is settable under the HiRes No Precursor Ion m/z label on mid-right side of the dialog box. In 
the case of LC-MS/MS data with a precursor ion (a specifically labeled header, Precursor mz:), the data are assumed 
to be accurate m/z and the section of the dialog box in the upper right under the heading Tandem Spectrum Accuracy 
is applicable for specifying the number of decimal places. 

Retention Index in input spectra are often not characterized by type of 
column (SSNP, SNP, POL, ANY or std., or Unspecified). If a particular 
column type is used and no header tag is input in the text file constituting 
the spectrum, it may be specified here. If the text file being imported has 
a Retention_index: field header followed by a number, that is not 

preceded by a column type tag, the column type can be specified by selecting one of the items in the above displayed 
dropdown menu (lower part of the Import Options dialog box). The information appears as shown on the right in the 
Text Information window for the spectrum. If there is a tag 
associated with the Retention_index: field header, that will be the 
displayed column type, regardless of the setting in this dropdown list 
box. This is important because as of v.4.0 of MS Search, Match 
Factors of Hit can only be constrained by RI values based on semi-standard non-polar columns. 

  GC Column Type Accepted Tags (case insensitive) 

1 Semi-standard non-polar s, db5, semi, SemiStandardNonPolar, ssnp, SemiStdNP  

2 Standard non-polar n, db1, nonpolar, snp, standard, StandardNonPolar, StdNP 

3 Standard polar p, pol, polar, sp, StandardPolar, stdp, StdP, StdPolar  

4 Any (n-alkane standard) a, all, AllColumnTypes, AnyColumnType, std, Any  

5 Unspecified u, un, uns, unspecified, User 
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If the tag following the Retention_index: field header is Any, the Text information window will contain that designated 
in the Import Options dialog box. If the tag is unspecified, the column type will be listed as Definition. 
The Include Synonyms checkbox should be selected if synonyms are included with the imported text files. Most 
spectra being added to the Spec List from files do not have synonyms. However, if the spectrum is from a text file 
created by a spectrum in an existing library that does have synonyms, it may have synonyms. 

Library Search Options dialog box 
Selecting Library Search Options on the Options menu, from 
any tab view, or selecting the Library Search Options button   
( ) on the Button Bar of the Lib. Search tab vie will display a 
multiple-page Library Search Options dialog box (Figure 97). 
The appearance and options of the dialog box are dependent 
on the Spectrum Type selected in the dialog box displayed 
when the Select Spectrum Type option is selected in the File 
menu (Main Menu). The MS/MS page does not appear if the 
spectrum type is EI, and the RI (GC) page does not appear in 
the spectrum. 
Different types of spectral comparison routines for choosing the 
best matching spectra are available. These are Spectrum Type 
specific. The routine to be used for a Spectrum Type is selected 
from the Library Search Options dialog box Search page. 

The two Spectrum Search Types on this dialog box are 
Identity and Similarity. These different Spectrum Search 
Types a 

nd their options are explained in the Help Screens for each of 
the Spectrum Types (topic Spectrum Search Type). 

It is generally believed that there is a spectrum of the unidentified compound (query) in one or more of the libraries 
being searched, an Identity Search is best used (EI Normal for EI spectrum type when using nominal m/z or accurate 
GC/MS data, and MS/MS for Tandem spectrum type using spectra with a specified precursor ion or HiRes 
NoPrecursor when using in-source spectra). If it is believed that there is no spectrum of the query in the libraries 
searched for reasons such as obtaining only low Match and Reverse Match factors for an Identity Search, a Similarity 
Search may yield better results. Although there are three options for a Similarity Search for the EI spectrum type, and 
essentially one selection for the Tandem spectrum type, it is recommended that the Hybrid Search be used (for both 
spectrum types) when it is believed there is no spectrum of the query compound present in the searched libraries. 
Introduced with v.2.3 of MS Search, these are particularly useful in this respect.3,4 

A feature that first appeared in v.3.0 is the Spectrum Scoring Options/Method (name changed from Spectrum 
Search Options in v.3.0) dropdown list box (shown on this page). There are three selections. This section also has the 
Compound Ubiquity Correction checkbox. This is a NEW feature in v.4.0 that is used to enhance the Match Factor 
of more common compounds, when selected. V.3.0 saw the retirement of the Penalize rare compounds option. This 
new feature is a much more sophisticated replacement. If the Hit has a high Compound Ubiquity Index (CUI), its 
Match Factor will be altered. It has been shown that “a CUI of 0 reduces the inherent likelihood of identification relative 
to a random compound in the library by nearly a factor of 10, whereas a value of 20 increases this likelihood by a factor 
of 10.” When dealing with an unknown spectrum and two Hits have almost identical Match Factors, the one with the 
higher CUI is the more likely candidate. As used in MS Search, the CUI is a citation index that reports the number of 
58 diverse non-mass spectral chemical collections containing the compound. This is described in the literature 
previously cited in this manual. Details of how this works are found in a previous citation in the manual. 

 
3 Arun S. Moorthy, , William E. Wallace, Anthony J. Kearsley,‡ Dmitrii V. Tchekhovskoi, and Stephen E. Stein “Combining 
Fragment-Ion and Neutral-Loss Matching during Mass Spectral Library Searching: A New General Purpose Algorithm Applicable to 
Illicit Drug Identification” Anal. Chem. 2017, 89, 13261−13268. 
4 Ivana Blaženović, Tobias Kind, Michael R. Sa, Jian Ji, Arpana Vaniya, Benjamin Wancewicz, Bryan S. Roberts, Hrvoje 
Torbašinović, Tack Lee, Sajjan S. Mehta, Megan R. Showalter, Hosook Song, Jessica Kwok1, Dieter Jahn, Jayoung Kim, Oliver 
Fiehn “Structure Annotation of all Mass Spectra in Untargeted Metabolomics” Anal. Chem. 2019, 91 (3) 2155-2162. 

 
Figure 97. Library Search Options Search page 

for an Identity EI Normal search in the Any 
Spectrum Type Mode. 
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There are a series of options under the label Spectrum Scoring 
Options/Method section. These are selectable through the dropdown list 
box next to the Method label. The first selection in the list is the search 
type most often used where all peaks in the sample spectrum and the 
library spectrum that are in a match are compared. The second option 

results in the display of the Hit List according to descending Reverse Match Factor (RMF). An RMF is a Match Factor 
(MF) calculated by disregarding any peaks in the sample mass spectrum that are not in the library mass spectrum. The 
third selection is displaying the Hit List in descending order of the Partial Spectrum Search (PSS) value. This is a 
Match Factor calculated disregarding any peaks in the library spectrum that are not in the sample spectrum. The PSS 
seach was new to v.3.0 of MS Search. The Impurity Tolerant Search was selectable as a checkbox for a Reverse 
Search in this dialog box of versions previous to v.3.0 (v2.4 and previous). 

In v.3.0 there was a selection for Match Ion Mode (Tandem) when any Spectrum Mode other than EI is selected. This 
selection has been moved to the MS/MS page (only visible on the Library Search Options dialog box when the 
spectrum type is Tandem). 

Following the Spectrum Search Options are the Presearch selections. These can be chosen by selecting the desired 
radio button. The Default presearch uses a series of presearch screenings to select the spectra which will be compared 
peak-by-peak in a Match Factor (Score) calculation. The Fast presearch is essentially the same as the Default, but 
selects a factor of three fewer spectra, on average. The Off selection has every spectrum in all the libraries being 
searched compared with the sample spectrum. This can be time consuming. This will result in a Hit List with 400 
compounds whereas the other two Presearch options produce a Hit List with a maximum of 100 compounds. 

The InChIKey selection restricts searches to spectra that have the appropriate InChIKey; therefore, it is a type of 
presearch and turns off the other three selections. This can be a full value or a beginning partial value. There will be a 
spectrum-by-spectrum search of the spectra meeting InChIKey criteria. 

Note the InChIKey presearch is used when the structure associated with the spectrum is known. It is a powerful filter 
that helps with multiple libraries. Existing User and third-party libraries must be indexed to use this feature. Indexing is 
accomplished from the Tools menu of the Main Menu. Details of the InChIKey presearch are found in the Help file. 

Other Options section on Search page of Library Search Options dialog box 

 
The checkboxes next to the Automation, Apply Limits, Use Constraints, and Use RI (NEW v.4.0 Only in EI spectrum 
mode) options are automatically selected or deselected based on actions taken in the Automation, Limits, 
Constraints, and RI (GC) pages of this dialog box. They can be selected or deselected this page. If they are not 
selected, it is a good idea to review the contents of the corresponding page before selecting one of them. This will 
prevent unwanted or confusing results. The Automation checkbox in the Search page is turned on an off by the 
selection/deselection of the Automatic Search On checkbox in the Automation page. The Auto Report checkbox is 
not automatically selected when the Automatic Search On checkbox is selected on the Automation page or 
Automation is selected on the Search page. If Auto Report is selected, whatever settings are in place in the upper 
section of the Automation page will be applied to the report automatically generated at the completions of each library 
search. The other items are self-explanatory if the tab with the appropriate label is made visible. The value in the 
Number of Hits to Print entry box sets the number of Hits that will be in in an Auto Report when executed from the 
File menu of the Main Menu. The format of these automatically printed reports is dictated by the Automation page of 
the Library Seach Options dialog box. This format is different from the one generated when the Print Report selection 
is executed from the File menu.  

Version 4.0 has two NEW selections in the Other Options section of the Search page of the Library Search Options 
dialog box is display for the EI spectrum type. These are Use RI and TMS mode. The Use RI checkbox which can be 
selected and deselected from the Search page is turned on and off by selecting/deselecting the Use Semi-Standard 
Non-Polar Colum Retention Index for Score corrections. 
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The TMS mode (EI only) selection has three options for compounds that have been derivatized with a trimethylsilyl 
reagent.: 1) Off - no filter; 2) TMS - for TMS derivatized samples - rejects compounds containing OH and NH with no 
TMS derivatization; 3) Non-TMS - for non-TMS derivatized runs - rejects all TMS derivatized compounds. This is a 
highly specific constraint.  

The Search page of the Library Search Options dialog box also has a Structure Similarity Search Options 
selection. This section has the Match Number of Rings checkbox. When selected, the search of compounds that have 
rings will be constrained to only spectra produced by compounds with a similar structure and the same number of rings 
as the spectrum being searched. The Show Homologues selection is self-explanatory. 

Different Libraries are used for a Structure search and a Spectrum Search. When the Libraries page of the Library 
Search Options dialog box is selected, a dropdown list box appears in the lower part. The selections made above are 
for either Spectrum searches or Structures searches. It is important to be aware that different libraries may be 
selected for these two types of searches, especially when working with both at the same time. Both pertain only to 
Structure Similarity Searches. Structural searches use different libraries than used by a Spectrum searches. See 
the Library page of this dialog box. 

When the OK button on any page of the Library Search Options dialog box is selected, the dialog box is closed. When 
this dialog box is next opened, it is opened with the page view present when it was closed. In addition to the OK button 
each page has a Help button that opens a contact sensitive Help page. Before initiating a search of a spectrum or 
performing a structure similarity search, each page in the Library Search Options dialog box should be viewed and 
understood. 

Hybrid Search 
As stated above, an Identity search is used when it is believed that a spectrum of the unidentified compound is in one 
or more of the searched libraries. A Similarity search is carried out when there is a high probability that there is not a 
spectrum of the unidentified compound in any of the libraries. The most powerful of these Similarity searches is the 
Hybrid Search which can be used with integer m/z value EI spectra and accurate m/z tandem spectra. 

Note Bene: The Hybrid Search (as one of the Similarity searches) has been available sinch the 
inception of the MS Search Program (even back to the DOS Versions of the 1980s); however, with the 
release of NIST 17 (v.2.3 MS Search, 2017) a radically changed program was introduced. This Hybrid 
Search should not be confused with the previous version. 

Note Been: Any library in the NIST MS Search format, with associated structures, can be used with the 
Hybrid Search. This search is not restricted to only NIST Libraries. Before using a non-NIST EI mass 
spectra libraries, it is best to subject each library to the Rebuild Structures Search Database, 
(RE)Index InChIKey, and (RE)Index Hybrid Search, all accessible from the Tools selection of the Main 
Menu. If a user/3rd-party Tandem Library is to be used, it should be processed with the (RE)Index Exact 
Mass Tool. The dialog box for each of these Tools’ processes has a labeled stating, “Libraries in upper 
case are probably up to date.” Unless first-hand knowledge is available, as in this case, the library should 
be processed. 

The NEW addition to the Hybrid Search for both EI and Tandem spectra of MS Search v.4.0 is the addition of the 
columns with the name dform (the number of atoms of the most common chemical elements added to or subtracted 
from the elemental composition of the found library spectrum’s structure), pctRelForm (relative frequency of 
occurrence in high scoring hybrid searches), and preForm (dForm added to the library chemical formula, resulting in 
the formula of the queried spectrum). Also NEW to the EI Hybrid Search when using the RI associated with the spectrum 
as an adjustment factor to the Match Factor are the Hit List column headers dRI (estimated change in RI for dForm) 
and ddRI (difference between RI value associated with the queried spectrum and the estimated value). These column 
headers must be selected in the Hit List page of the Library Search Properties dialog box displayed from the RMB 
menu in the Lib. Search tab view. Even if selected, these column headers only appear when a relevant search is 
performed. 

The following is an example of how valuable the Hybrid search is when there is no spectrum for an unidentified 
compound in any of the searched libraries. Both the EI Hybrid search and the MS/MS Hybrid search require the use 
of a precursor-ion value. When performing the MS/MS Hybrid search this requirement is easily met because the m/z 
value of the precursor is imported with the spectrum. In the EI Hybrid search, the m/z value of the molecular ion (M+•) 
is required. If the EI mass spectrum does not exhibit a molecular ion peak (which approximately 20% of the EI spectra 
in the NIST/EPA/NIH EI Library do not), then this value will have to be determined using chemical (CI), field (FI) 
ionization, photoionization (PI), by derivation, or as an educated guess. CI was used in the following example for m/z 
value of the M+•. MS Search will attempt to assign a value for the M+•; however, this value should be considered suspect. 
When performing an EI Hybrid Search, a value should be entered in the appropriate area (under the Precursor MW 
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label at the top) of the Search page of the Library Search Options dialog box. The checkbox next to the in spectrum 
label should NOT be selected. 

The figure on the next page shows the first Hit for a Similarity EI Simple search (top); the sample spectrum (middle); 
and the first Hit for a Similarity EI Hybrid search (bottom). The Hit List with the first few Hits are also shown. 

The EI Hybrid Search yields much more compelling results. The top 10 Hits are all fentanyls and the Hybrid Search 
Match Factors are all at levels above 940. The oM... column is the Match Factor obtained without application of the 
Hybrid Search algorithm. The most valuable additionally displayed column is the Del… (DeltaMass). This shows the 
difference between the m/z values of corresponding ions and in the sample spectrum and the Hybrid spectrum, allowing 
for speculation as to the structure difference. 

All the top 10 Hits being of fentanyl, or a fentanyl variant, is evidence that the unidentified compound is probably a 
Fentanyl variant that does not have a spectrum in the NIST/EP/NIH Library. fentanyl has an ethyl moiety (29 Da) 
attached to a carbonyl carbon atom. A cyclopropyl group (41 DA) is 12 Da greater in mass. If the structure for the 
cyclopropyl group variant is drawn, associated with the spectrum of the unidentified compound, and presented to MS 
Interpreter, the unambiguous identification is confirmed. 

 
Figure 98. EI Hybrid Search of Unidentified Substance searched against the NIST/EPA/NIH EI Library.  

The top panel shows the results of an EI Simple Similarity Search. The middle panel is the Raw Spectrum. 
The bottom Panel shows the results of the Hybrid Search. 

The first Hit of the EI Simple Similarity Search is for a fentanyl variant with a relatively good Match Factor and 
Reverse Match Factor; however, the difference in the m/z values of the two M+• confirms that there is no identification. 
There are several spectra in the Hit List of fentanyl variants, but Match Factors (and R Match Factors) are low, and 
the results are definitely unconvincing. 

The Delta Mass value is just a number. It can be positive (+) or negative (-). As stated above, for an EI mass spectrum 
this represents the difference in mass between the compound represented by the sample mass spectrum and the 
compound whose mass spectrum has been hybridized. In this example it is suggested that the Delta Mass of 12 is the 
difference between the mass of an ethyl group, Group/Element (1) on the model compound and a cyclopropyl group, 
Group/Element (2), on the compound that resulted in the sample spectrum. Users of the Hybrid Search have compiled 
a list of over 500 Delta Mass examples between 0 Da and 150 Da which are contained in DeltaMass_EI.pdf. Clicking 
on this link while holding the <ctrl> key down will open the file. Instructions for using the file are included. 

The source DeltaMass_EI.xlsx file is located in the C:\NIST26\MSSearch folder and can be used to add new examples. 

 



  

NIST 26 MS Libraries and Search Program v.4.0 Page 109 

 
Figure 99. Comparison of Sample Spectrum (top) and Hybrid Spectrum (bottom) blue and pink peaks.  

The gray peaks on the bottom spectrum belong to the Hit and are not part of the Hybrid.  
The Delta Mass is represented by the difference between the gray and pink peaks. 

 
Figure 100. The three structures represent unique fragments of the variant and are the rational for the 

unambiguous identification. 
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Figure 101. Hybrid search of EI accurate m/z value spectra Constrained by Retention Index. 

Constraining the Match Factor is based on a submitted RI value measured with a Semi-Standard Non-Polar (e.g. 
DB-5). The spectrum must have a line in the text file that is Retention Index: SemiStdNP=xxx (in iu). These will result 
in display of sections in the Text Information window that appears as: 

Experimental RI median±deviation (#data)  
Semi-standard non-polar: xxxx±N/A (1) 

This value is compared against the same SSNP Experimental value in the NIST\EPA\NIH\ Library if present. If there is 
no Experimental SSNP value for the compound, MS Search will use the AI predicted semi-standard non-polar 
retention index (n-alkane scale): value. Every compound in the NIST\EPA\NIH Library has an AI Retention Index 
value. 

 
Figure 102. The RI (GC) page in v.4.0 had major appearance and functionality changes 

See NOTE ON RECALLING Hybrid Search Results from HISTORY LIST on page 71. 
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The Search Menu (Select Search on Main Menu) 
The Other Search tab view options are: 

Option Description Tab View 

MW (Nominal Mass) Finds spectra in selected libraries of compounds having specified 
(nominal mass) molecular weight (excludes replib). 

Other Search 
 

Exact mass Finds spectra in selected libraries of compounds having an exact 
mass corresponding to specified accurate mass with a specified 
variance (excludes replib). 

Other Search 

MS/MS Precursor 
m/z 

Searches for Precursor m/z using precursor-ion mass, formula, m/z 
values within the uncertainty interval in MS/MS Libraries 
NOT LISTED when EI Spectrum Type is Selected 

Other Search 

Formula (Elemental 
Composition) 

Finds spectra in selected libraries of compounds with specified 
formula (excludes replib). 

Other Search 

Any Peaks Finds spectra in selected libraries based on user-specified peaks. Other Search 

Sequential Method Searches selected libraries using a set of constraints provided by 
the user. 

Other Search 

CAS Number Finds spectra of the compounds that have the entered CAS registry 
number. 

Other Search 

NIST Number Retrieves a spectrum with unique NIST Mass Spectrometry Data 
Center Archive ID number (in mainlib and replib only). 

Other Search 

ID Number Finds spectrum (or spectra) in selected library having entered ID 
number (or range of ID numbers). 

Other Search 

Names Allows entering a character string to display spectra beginning with 
name of a compound. 

Names 

 
These Search options (except for the Names search) are 
also displayed and may be selected from the dropdown 
list box at the top left side of the Other Search tab view 
(to the right from the binocular  button. Selecting the  

 button causes the currently displayed search in the 
dropdown list box dialog box to overlay the view. 

Each Search has its own dialog box. The tittle bar of each 
dialog box is labeled for a specific (Other) Search, where 

(Other) is the name of the search. When the MW (Nominal Mass), Formula, or Sequential Method search is selected, 
the dialog box opens to the Constraints page (Figure 103). This basically is the same Constraints page displayed 
from the Library Search Options dialog box of the Lib. Search tab view. Some items specific to an individual Other 
Search may not be available because they conflict with the specified search. The MW (Nominal Mass) and Formula 
searches’ dialog boxes have specific fields for entering a nominal mass or elemental composition, respectively. Certain 
constraints (lower window with scroll bar and names of constraints to the right of checkboxes) are not available and 
appear grayed. They cannot be selected: MW (Nominal Mass) and Exact Mass in the MW (Nominal Mass) Search 
dialog box and Element Values and Elements Present in the Formula Search dialog box. These three dialog boxes 
have two pages: Options and Constraints. The Options page allows for the selection of the libraries to be searched. 
Each Other Search can have its own unique set of libraries to be used. When performing an MW (Nominal Mass), 
Exact Madss, Formula, or CAS Number search of libraries, the replib is not a selectable library. Spectra in the replib 
will have these same properties as the corresponding spectrum in the mainlib, and they can be selected for display in 
the Hit List by selecting the ⊞ button to left of the Hit List # or by using the  button in the Button Bar to display all 
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replicates. The Options page for the MW (Nominal Mass) and Formula search will have the same entry field as the 
Constraints page and a Use Constraints checkbox. 

MW (Nominal Mas) search                                                Formula search                                                                      

The Options page for a Sequential search has the Use Constraints checkbox and a                                  box. The 
maximum number of Hits for most of the searches performed in this tab view is 6000. 
Regardless of the number of Hits specified for a Sequential or Any Peaks Search, all selected libraries will be 
searched; however, any Hits found in libraries after the maximum of Hits is reached, will not appear in the Hit List, but 
the number of Hits in the Hit List and the total number of Hit will appear in the MS Search Title Bar. 

 
If the conglomerate of the selected libraries for a search that has greater than 6000 potential Hits is attempt an error 
dialog box with an OK button will be display, saying Warning, too many similar spectra. Search may be incomplete. 
When the OK button is selected, the first 6,000 spectra will appear in the Hit List and only this number in the Hit List 
will appear in the Other Search tab view header.  

The CAS Number, NIST Number, and ID Number searches have only a single page dialog box. The Exact Mass, 
MS/MS Precursor, and Any Peaks searches have three-page dialog boxes. The top page has a name related to the 
search. The other two pages are labeled Libraries and Constraints. The selection of the libraries is made in the 
Libraries page. When these searches are first selected, they open to the top page with the name of the search rather 
than the Constraints page. The Libraries and Optional pages display the number of spectra in a specific number of 
libraries above the top window list the available libraries to the left of an Available label. Below the Include Libs: window 
in the lower part of the dialog box is the number of spectra in a specific number of selected libraries. 

When a constraint is selected in the Constraints window of the Constraints page, the Use Constraints checkbox will 
be automatically selected. The Other Searches that allow constraints (MW (Nominal Mass), Exact Mass, MS/MS 
Precursor m/z. Formula, Any Peaks, and Sequential Method) will have a corresponding Use Constraints checkbox 
on the Optional or Libraries page that will mimic the box on the Constraints page. All of the Constraints pages have 
a Clear All button, which when selected will deselect all the selected constraints, and a Selected: label followed by the 
numeric value of the selected constraints. When a constraint is deselected, it will no longer be a part of a search; 
however, all the settings will remain. If selected and the settings are not changed, the current setting will be used. 

When a constraint is selected, the appearance of Constraints page changes to allow entry of specifics for the individual 
constraint below the Constraints window. 

As described earlier, text files containing single column list of CAS registry, NIST or ID numbers can be search by 
entering the name and path of the file in the area normally use for entry of a single number. This file can be selected 
from an Open dialog box displayed by selecting the          button to the right of the entry field. The files should have the 
extension TXT and be a simple ASCII file. 

 

 
Figure 103. Formula Search dialog box with Use 

Constraints selected and a Tag in Comments 
entered to yield only spectra contributed by  

Carl Djerassi. 

 
Figure 104. Options tab of the Sequential Method 

Search dialog box showing that a maximum of 
100 Hits will be displayed. 
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Any Peaks search in the Other Search  
Select Any Peak from the Search menu or the dropdown list 
box next to the binocular  button on the Button Bar. This 
will display the Any Peaks Search dialog box (Figure 105) 
Select the Libraries page. Highlight the mainlib and replib and 
select the Add button. This will show these two libraries in the 
Includes Libs: window. Select the Peaks page. 

Select the “m/z” entry field (located below the m/z dropdown 
list box). The blinking vertical text cursor will now appear in the 
m/z field. Normal is displayed in Type field. Enter 149. This 
moves the cursor to the From field. Enter 75. This moves the 
cursor to the To field. Enter 100. This will enter the peak with 
its type, m/z value, and intensity range into the window on the 
lower left. The window on the lower right with column headers 
of Peaks and Hit will have 1 in the Peaks column and a 
number based on the selected libraries in the Hits field. The 
cursor is now back in the m/z field. 

Select the down arrow for the Peak Type label to display a 
dropdown list box. Select Loss. This will cause the cursor to 
reappear in the m/z field. Loss will be displayed in the Type 
field. The first peak entered is an observed peak in the mass 
spectrum, and it is possible that it is the base peak. This peak is considered to be a normal mass spectral peak. The 
second peak being entered represents an ion formed by a loss from the molecular ion. Enter 0. Enter 1. Enter 25. The 
retrieved spectra must have a peak representing the molecular ion peak that exhibits an intensity between 1% and 25% 
of full scale. This reduces the number of spectra in the that match the two entered criteria. 

In the Peak Type dropdown list box select Maxmass. This is a peak that has the m/z value of the most significant high 
mass peak in your spectrum. Retrieved spectra will contain a peak at this m/z value within the specified abundance 
range and no significantly larger peaks at higher m/z values are present in the spectrum. Enter 390 for the m/z value, 
1 for the from value, and 25 for the to value. 

The fourth ion type is Rank. Order of peak in relative abundance from the largest (Rank 1) to the 16th (Rank 16). The 
base peak is the largest peak in the spectrum. The Rank constraint can be used like the classic 8-peak Index data. 
The from and to values are not percent intensities, but a Rank from 1 to 16. 

The Any Peaks search can be constrained using the Constraints page. The Any Peaks search can be used for NIST 
Libraries and user-libraries like the Wiley Registry if Mass Spectral Data. 

Any Peaks search for Exact Mass, Accurate M/Z, and Accurate Loss 
The Any Peaks search can also perform searches on Exact Mass, 
Accurate M/Z (an m/z value adjusted for the electron mass 
(0.000548579909 Da) assuming a singly charged positive ion) or a 
fragment ion’s Formula (elemental composition).  

However, this search mode only works on the NIST libraries; it will not 
function on user libraries even if the user library has been indexed by 
exact mass. The exact mass indexing of the user libraries is done 
through the Tools/(Re)Index. Exact Mass only indexes the precursor 
or molecular ion based on the formula. The abundance range is from 
0 to 100% of the base peak where 0% means abundance <5 for a 
base peak intensity of 999. Only monoisotopic peaks may be 
searched. 

Figure 106 shows the Any Peaks Search dialog box set to accept an 
accurate mass value with variance. Remember that the “Exact Mass” 
Any Peaks Search is only valid for monoisotopic peaks (all atoms of 
all elements in the ion represented by the peak are the most abundant 
isotopes). Do not try to enter values for peaks that contain higher 
mass isotope of chlorine (37Cl), bromine (80Br), or other elements. An 
accurate mass (Mass), an m/z value (adjusted for electron mass), or 
an elemental composition (Formula) can be entered.  

 
Figure 106. Peaks tab of the Any Peaks 

search dialog box showing the selection 
of Accurate/Exact Mass. 

 

Figure 105. Peaks tab of the Any Peaks search 
dialog box showing the selection of the four 

different types of peaks and ranges. 
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The uncertainty can be in millimass units (mmu) or parts-per-million (ppm). If this field is left blank, an uncertainty of 
0.5 less than the last digit entered for the mass is assumed. In this case the uncertainty is always a 0.5 value, e.g., the 
uncertainty for 120.00 is ±0.005 and 120.000 is ±0.0005.  

To enter a chemical formula, select formula in the 
dropdown list box above the first entry field (this is 
possible only if “Exact Mass” type has been selected.) If 
the “Uncertainty” field is left blank, the accuracy of 
searched mass is the same as the accuracy of the mass 
saved in the library. It is very rare that the exact mass of 
two different elemental compositions is the same; 
therefore, there is a high probability that only the spectra 
where the peak was interpreted with the same elemental 
composition will be found. Molecular ion peaks in the 
mass spectrum will give very good results when used for 
the Any Peaks Search Exact Mass option; however, 
caution must be taken when using the accurate mass of 
fragment ions. The exact mass values in the NIST DB are 
calculated from the elemental compositions of ions 
predicted by MS Interpreter where peaks are present in 
the mass spectrum. More than one exact mass may be 
saved in a library for a peak in a mass spectrum of a 
compound. For instance, both CO and C2H4 may be 
assigned to the same peak with m/z 28. Searching for 
these two “Formulae” would produce a number of Hits 
containing both peaks. These Hits correspond to mass 
spectra where the peak at m/z 28 was ambiguously 
interpreted. The Any Peaks criteria can be used in the 
Sequential Method Search or as a constraint with a MW 
(Nominal Mass), Exact Mass, Formula Search or with 
a Spectrum Search; however, the “Exact Mass” Peak 
type is not available for these searches. When Peaks is 
used as a Constraint, relative intensity can be specified. 
In this case, the subsequent peaks have intensities 
relative to the first peak. Thus, if the first peak has an 
intensity between 50 and 100% of base, the second peak can be specified to have an intensity of between 40 and 
200% of the first peak. This is especially important when using SIM (selected ion monitoring) searches and wanting to 
understand the rates of false positives identifications. Radio buttons appear at the bottom of the Peaks Constraints 
dialog box to switch back and forth between “Absolute” and “Relative” (first Peak is Special!). 
  

 
Figure 107. Any Peaks Search dialog box, 

showing an entry of an accurate mass value with 
variances. Note the position of the splitter bar. 



  

Page 116  NIST 26 MS Libraries and MS Search Program v.4.0  

Exact Mass Search 
Exact Mass Search can be used directly to search the NIST libraries. In addition, Exact Mass (alternately with nominal 
mass) can be used as a Constraint in User Spectra Searches (Lib. Search tab), Any Peaks Search, and Sequential 
Search (Other Search tab).  

NOTE – THE EXACT MASS CONSTRAINT IS FOR MOLECULAR OR PRECURSOR-ION MASS  

Select Exact Mass from the dropdown list box on the upper left of the 
Other Search tab. The three-tab dialog box shown in Figure 108 will 
be displayed. The exact mass value to be searched is entered into the 
“Search value” field on the Accurate Precursor Mass Search tab of 
the dialog box. The “Type” of the value is selected from the dropdown 
list box next to the “Search value” field. All the fields in the dialog box 
are explained in detail by selecting the Help button in the dialog box. 
The Libraries Page allows the selection of the libraries to be searched. 
Like the MW (Nominal Mass) Search and the Formula Search, the 
NIST 20 replib is not available for searching. The Constraints tab 
allows the Exact Mass Search to be constrained by name fragment, 
Tags in the “Comments/ Contributor” field, elements present, and 
element values. In addition, the formula or the formula for the neutral 
loss can be entered. In this case, the program will calculate the exact 
mass and use the uncertainty (if provided).  

The Exact Mass Search is not restricted to the NIST/EPA/NIH 
Libraries; however, user or other non-NIST libraries must first be 
indexed by the exact mass. Select Tools from the Main Menu and then 
select (Re)Index Exact Mass. This will result in a dialog box being 
displayed (Figure 109). The time to index a library will depend on the 
size of the library. All NIST 23 Libraries are already indexed by the 
exact mass. 

After the desired libraries have been indexed (this must be done only 
once), an Exact Mass Search or another Search using Exact Mass 
as a Constraint can be carried out. 
  

 
Figure 108. Exact Mass Search dialog 

box. 

 
Figure 109. Dialog box to allow for 

indexing mass spectral libraries according 
to exact mass. 
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Search by Name - Browse 
The data in a library can be searched or browsed using the incremental name search (the Names tab view). As a name 
is entered, the program finds the next name that fits all the text typed to that point. The names search works over not 
only the primary name but all synonyms. This means that common names for chemicals can be quickly searched. 
Some common compounds have a very large number of synonyms. Once the name is found, highlight the desired 
name, and the display in the Plot/Text and Plot Windows will be refreshed with the appropriate display for the 
compound. 

Use the Mouse pointer to place the blinking vertical text cursor in the “Name” field at the top of the Name Search tab. 
To search for the mass spectrum of a plant growth regulator, GIBBERELLIN A9, begin typing the name. Stop after 
entering each letter. After the letter N has been typed, the 13th name in the Hit List window is the target. Names may 
also be pasted from the Windows Clipboard into the “Name” field by simultaneously pressing keys Shift and Insert or 
using the RMB menu Paste selection. 

NOTE: This feature can be used in a user library to give synonyms such as “LabBook05-Pg6” or more simply “B05-
P06”, this allows the data to be quickly found by reference to the original experiment. 

Sequential Method 
This method allows every spectrum in the selected libraries to be subjected to a created search criterion. The criteria 
that are set in the Constraints section govern the Hit List returned. In this search method, it is possible to use not only 
absolute but also only relative intensities of peaks. This can be an important tool for examining the risk of false positives 
when using SIM searches. 

In the example shown in Figure 110, the peak at 109 is 
allowed to be present in a range of 1 to 100% of the base 
peak. The subsequent peaks (158 and 63) are sought as a 
fraction of the 109-peak, regardless of its intensity. If the peak 
with m/z 109 is 15% of the intensity of the base peak and the 
peak with m/z 158 is 5% of the intensity of the base peak (i.e., 
33% of the 109) it would be accepted. This kind of analysis 
can give important insights into the risk of false positive 
matches when using SIM (selected ion monitoring) in GC/MS 
experiments. 
In SIM the entire spectrum is not seen so the relative 
intensities of the ions observed are the only data that can be 
extracted from the data file. 
NOTE: All the other methods of searching are also present in 
the Sequential Method. The elements search can also be 
interesting if the number of compounds in all the libraries that 
have at least one mercury atom in the molecule needs to be 
determined. On a modern computer with a large amount of 
memory these searches do not need to take very long. 
Typically any sequential search will be faster for subsequent 
similar searches because much of the data file will be cached 
in the computer memory.  
 

   
Figure 110. Sequential Search dialog box 

showing the use of Any Peaks in a Relative 
mode. 
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Basis for Interpretation of the Library Search Results 
When an Identity Search of an EI mass spectrum resulting from an unidentified compound (Spectrum Library 
Search) is performed, the results will be associated with three numbers for each spectrum shown in the Hit List (by 
default) and one value for the search. These three numbers are: 1) a Match Factor for the spectrum of the unidentified 
compound and the library spectrum (direct match of peak m/z values and relative intensities), 2) a match factor for the 
spectrum of the unidentified compound and the library spectrum ignoring any peaks in the spectrum of the unidentified 
compound that are not in the library spectrum (Reverse Match), and 3) a Probability value (column headings in the 
Lib. Search Hit List: Match, R. Match and Prob. (%), respectively). The first two numbers are straightforward. Each 
is derived from a modified cosine of the angle between the spectra (normalized dot product). A perfect match results in 
a value of 999; spectra with no peaks in common result in a value of 0.  

As a general guide, 900 or greater is an excellent match; 800–900, a good match; 700–800, a fair match. Less than 
600 is a very poor match. However, spectrum of unidentified compounds with many peaks will tend to yield lower 
Match Factors than similar spectra with fewer peaks. The Prob. (%) value and the value for the search (InLib, located 
in the lower right corner of the Hit List window and on the Title Bar of the Lib. Search tab) require more explanation.  

The Prob. (%) value for a Hit is derived if the compound is represented by a spectrum in the libraries searched. It 
employs only the differences between adjacent Hits in the Hit List to get the relative probability that any Hit in the Hit 
List is correct. This value is derived from an analysis of the results of searching the NIST/EPA/NIH Main Library with 
a set of replicate spectra (given in the Replicates Library). The relative probability of each of the Hits requires only the 
difference values because the total probability of the compound being in the searched libraries is assumed to be one. 
The other factor (InLib) is a measure of the probability of the compound being in the searched libraries. This value is 
also derived from the same set of replicate spectral searches. In this case, the correct compound was ignored in the 
Hit List; and the difference between the Hit List, with and without the correct compound, is parameterized. The 
parameters are the maximum value of the match and the largest single difference among the top 20 Hits. If the first Hit 
has a high Match Factor (>900) and the next Hit has a Match Factor of 800 or less, the probability of the compound 
being correctly identified is very large and the probability of the compound being in the searched library is large (the 
number of “Hits vs. their Match Factors” is displayed in the Hit Histogram window located just above the Hit List, 
see Figure 21). 

Like all statistical results, these probability calculations rely on the data sampled. For example, if a compound that has 
very few similar mass spectra will be identified in a more definitive way (a higher Probability and InLib value). Using 
examples from the Replicates Library and searching the Main Library using a compound like 'folpet', will result in a 
high probability for the first Hit and a high InLib value. In contrast, if replicates of 'cyclohexanol' are searched, the 
results will be much lower Prob. (%) and InLib values; and, in some cases, the best Hit is not even the correct 
compound. This reflects the fact that there are very few compounds that have mass spectra similar to 'folpet'; but there 
are a number of compounds that have very similar mass spectra to 'cyclohexanol', and the ability of any search system 
to distinguish between these similar spectra is limited. In many cases, the best that the search can do is to provide a 
class of compounds that have similar mass spectra and, usually, similar structures. 

The values of the InLib parameter are meant as guideposts. Generally, any positive value is acceptable. Values greater 
than approximately 300 usually mean that the spectrum is nearly unique. Negative values below 200 are generally a 
warning that the spectrum is not identified. Note that negative values will occur when there are many compounds with 
similar spectra. In these cases, the difference between the Match Factors for different spectra is very small, and the 
search cannot be assured of providing the correct unique answer. Usually in these cases, especially when Match 
Factors are high, it will provide very good guidance on the structure of the molecule. 

For a complete discussion of the methods used in assessing the probabilities, see Stein, S.E. “Estimating Probabilities 
of Correct Identification from Results of Mass Spectral Library Searches” J. Am. Soc. Mass Spectrom. 1994, 5, 
316 – 323. 

Substructure Information 
The Substructure Information utility is used in the evaluation of a Hit List using the NIST/EPA/NIH Mass Spectral 
Library because each spectrum is indexed by the substructures that make up the structure of the compound that 
resulted in the spectrum. Substructures are functional groups like carbonyls, methoxys, methyl ester moieties, etc.; the 
number of rings and double bonds; and heteroatoms also are considered to be substructures. 
The Substructure Information is most useful when the Hit List is the result of one of the four Similarity Searches 
(EI Hybrid, EI Simple, Neutral Loss, MS/MS in EI, or MS/MS Hybrid). This utility is called from the Main Menu’s 
Tools menu. 
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Similarity Searches are carried out when it is believed that a spectrum of the unidentified compound is not in any of 
the searched libraries. Spectra like the searched spectrum make up the Hit List. There is no Prob column in the Hit 
List and an InLib value is not determined. Not only is the utility useful in determining the structure of an unidentified 
compound based on its EI mass spectrum, but it has also proved to be very informative in the analysis of collision-
induced dissociation (CID) spectra obtained from ions produced by soft ionization LC/MS techniques such as APCI, 
APPI, and electrospray. This use is described in more detail below. 
The Substructure Information dialog box (Figure 111) has the 
name of the spectrum that was used to create the Hit List displayed 
at the top. Just below the Name of Unknown field in this dialog box 
is the “Chlorine/Bromine information” field, which gives the 
probabilities and numbers of atoms of chlorine and/or bromine 
present (useful regardless of the method by which the spectrum was 
obtained). The result of molecular weight estimation from the Hit List 
is presented on the right side of the dialog box (useful for EI spectra, 
especially when no molecular ion peak is observed). There are two 
windows below this in an area labeled Substructure information: 
Prob. Present and Prob. Absent. These two windows contain a list 
of abbreviations for the substructures preceded by a number, which 
is the percent probability for the presence or absence of the 
substructure. If one of the abbreviations is not understood, highlight 
it by using the Mouse and a detailed explanation appears at the 
bottom of the Substructural information area.  
Just below the molecular weight information is the Set of 
Substructures in use window with a list box and a Customize 
button. The list box displays all the substructures in the current set.  
The Customize button, when selected, displays the Customized set of Structures dialog box (Figure 112). his dialog 
box is used to create a subset of the substructures to be identified. The list of all possible substructures is displayed in 
the Full set of structures window. The list of substructures included in the present file is shown in the Customized 

set window. The first time a customized list is created, both windows will 
contain the same list. Substructures may be omitted from the Customized 
set window or added from the Full set of structures window. Either action 
occurs on the structures highlighted by Mouse action in the window by 
selecting the appropriate button  Omit  or  Add . The usual Windows 
conventions for selecting multiple items apply. After selecting the first 
substructure of the list, hold down the Shift key while selecting the last 
substructure. This will select all substructures between the first and last. 
Multiple noncontiguous substructures can be selected by holding down the 
Ctrl key while selecting each desired substructure. 

The Save and Open buttons allow the saving and retrieving of customized 
substructure sets. A temporary set is created by making modifications to the 
Customized set window and selecting the OK button. This dialog box, as 
well as the Substructure Information dialog box, has a Help button, which 
displays a context-sensitive Help screen. 

The algorithms used in the substructure identification are described in the 
Help screen. They are based on developments at NIST (Stein, S.E., 
“Chemical Substructure Identification by Mass Spectral Library Searching” J. 
Am. Soc. Mass Spectrum. 1995, 6, 644–655).  

 

 
Figure 111. Compound Identification with 

Substructure Information of CID 
Spectrum. 

 

Figure 112. Customized Set of 
Structures dialog box. 
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Example Use of Substructure Info in Determining Structure 
of Unidentified Compounds Using CID 
The mass spectrum (Figure 113) of a compound with the structure shown inserted in the spectrum was obtained using 
collision-induced dissociation (CID) on a protonated molecule with m/z 248 (Spectrum Type: Tandem). An EI in 
MS/MS Similarity Search was performed against the NIST 26 mainlib with m/z 248 designated as being the precursor 
ion. This type of search is provided to allow for the use of the vast amount of information in the EI Library with spectra 
that are produced by LC/MS CID. The EI in MS/MS Similarly Search has been optimized for this purpose. The resulting 
Hit List was evaluated using the Substructure Identification utility. Based on this evaluation, it was determined that 
there was a 90% probability that the compound contained one or more atoms of oxygen; a 90% probability that there 
was a carbonyl group; an 89% probability that there was a heterocyclic ring; and an 88% probability that there was an 
aromatic ring; but it also revealed a 99% probability that there was not a phenyl carbonyl or a methoxy phenyl group, 
and a 90% probability that there was not a heterocyclic ring that contained oxygen. Remember, it is just as important 
to know what is absent as it is to know what is present. The evaluation revealed that there was an 89% probability that 
there were one or more atoms of nitrogen and an 86% probability that there was a heterocyclic ring with an atom of 
nitrogen. Continued evaluation of the Prob. Present and Prob. Absent windows in the Substructure Identification 
dialog box revealed other possible substructures to be present and eliminated others by their high-absence 
probabilities. 

This particular use of the MS/MS in EI Similarity Search in conjunction with the Substructure Identification has not 
been extensively tested by NIST; however, anecdotal evidence has shown this to be an effective combination and 
should be considered when trying to determine the structure of an unidentified compound using CID data. In the 
example cited above, if the unidentified compound was believed to be a metabolite of some known substances, the 
information gained from this technique could well result in identification. 

 
Figure 113. Mass spectrum obtained by CID of ion with m/z 248 and structure. 
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Use with Instrument Data Systems & Third-Party Data 
Analysis Software 
The features described in the AUTOMATION section of this manual were implemented to aid the use of the NIST MS 
Search Program with proprietary mass spectral data systems. 

Location of the NIST MS Search Program 
It may be necessary to determine the location of the NIST MS Search Program files and the location of the NIST MS 
Search working directory. These can be found in the [NISTMS] section of the WIN.INI file located in the %windir% 
directory. Below is a typical example of this section: 

[NISTMS] 
Path32=C:\NIST26\MSSEARCH\ 
WorkDir32=C:\NIST26\MSSEARCH\ 
Amdis32Path=C:\NIST26\AMDIS32\ 
AmdisMSPath=C:\NIST26\AMDIS32\ 

The string beyond “Path32=” is the path to MS Search Program folder (location of the executable files); the string 
beyond “WorkDir32=” is the path to the MS Search Program working directory (location of the history, Hits, etc.). Two 
other items refer to AMDIS and its connection to the MS Search Program. 

Cases have been reported where the connection between MS Search and a third-party data analysis system was 
rendered nonfunctional when this [NISTMS] area of the win.ini file referred to more than one location for various 
versions of the NIST MS Search Program. 

Implementation 
If the mass spectrometry data system being used is capable of exporting spectra to the NIST format (described in the 
User Libraries section of this manual) and a Windows program can be executed from within the data system, this 
feature is available. Implementation of this feature has been provided by some manufacturers on their data systems. 
The command string used to start or bring into focus the NIST MS Search Program for Windows is: 

C:\NIST26\MSSEARCH\NISTMS$.EXE<space>/instrument 

assuming the program is in the C:\NIST26\MSSEARCH directory; if it is in some other directory, make the 
appropriate substitution. 

Two locator files are required to use the automation features: 
1. The first locator file must be in the MS Search Program working directory, have the name AUTOIMP.MSD, and 

contain the text string describing the name and location of the second locator file. For example: 

C:\MYMSDS\FILESPEC.FIL 

where: C:\MYMSDS is the folder where the file, FILSPEC.FIL, resides. 

This file can be created with any text editor. 

2. The second locator file is created each time a spectrum or spectra is/are saved to a separate file to be imported by 
the MS Search Program. This second locator file contains the text string that describes the name and location of 
the text file containing the spectrum (or spectra) in the NIST Text file format described later. It is possible to state 
whether the spectra currently in the NIST MS Search Program Spec List window are to be added to or replaced 
by the automatic import. An example of the contents of the second locator file is: 

C:\MYMSDS\DATA\DATAFILE.TXT<space>OVERWRITE or APPEND 

where: C:\MYMSDS\DATA\DATAFILE.TXT is the full pathname of the file containing the spectra, and one 
of the words OVERWRITE or APPEND is the instruction as to how the spectra are added to the Spec List 
Window. To enable switching the focus back from the MS Search Program, the second line containing 
main window handle numbers of the data system application may be added (see Figure 114 for details). 

This second locator file is deleted each time the NIST MS Search Program is brought into focus and spectra are 
imported. Figure 114 illustrates the implementation. The upper part of each box contains a file name; the bottom 
part is the contents of the file. Black arrows show logical connections between the files. 
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Figure 114. The Implementation of Use with a Data System. 

NIST MS Search (nistms$.exe) Command Line Options 
Option How it works 

/INSTRUMENT Normal search. Imports and optionally searches spectra (Figure 114 for details on the 
implementation), activates MS Search Window, activates switch back button. 

/INSTRUMENT /PAR=2 Background search. Imports and optionally searches spectra (Figure 114 for details 
on the implementation), does not activate MS Search Window (in fact, it is disabled 
during the search), writes Hit Lists into file SRCRESLT.TXT; when the search is 
complete creates file SRCREADY.TXT as a signal that SRCRESLT.TXT is ready. 
Both files are created in the MS Search work directory. Number of Hits is determined 
by the “Number of Hits to Print” in the Automation tab (Figure 75). 

/PAR=4 Start logging. Appends Hit Lists of Spectrum and Structure Searches to the file 
NISTLOG.TXT located in the MS Search work directory. Number of Hits is 
determined by the “Number of Hits to Print” in the Automation tab (Figure 75). 

/PAR=8 Ends logging. Stops appending Hit Lists to the file NISTLOG.TXT. 

/MOL=“<full pathname>” Imports chemical structure from a Molfile or SDfile. If SDfile contains more than one 
Molfile, only the first one will be imported. See section USE WITH THIRD-PARTY 
DRAWING PROGRAMS for details. 

SEE APPENDIX 1 for instructions on the Creation of AUTOIMP.MSD. 

file c:\nist26\mssearch\autoimp.msd 

c:\mymsds\filespec.fil 

file c:\mymsds\filespec.fil 

c:\mymsds\data\datafile.txt APPEND 

10 724 

file c:\mymsds\data\datafile.txt 

name:Scan 833 

num:118 

26   1697 

27   28119 

28   4730 

second 
locator file 

file containing spectra  

first locator file 

Command line for initiating import of spectra into the MS Search Program: 
    C:\NIST26\MSSEARCH\NISTMS$.EXE /instrument 

 Calculation of the calling program main window handle numbers: 

hWnd = A02D4(hexadecimal) = HiWord × 2
16

 + LoWord = 

10 × 2
16

 + 724 (decimal), that is, HiWord = 10, LoWord = 724  

(See the second line in c:\mymsds\filespec.fil; the numbers here are for example only; in each run your 
application may have a different main window handle.) 
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Use with Third-Party Drawing Programs 
There is a Structure Search command. If a structure is in the Spec List window of the Lib. Search tab or a structure 
is associated with a spectrum, this structure can be searched to retrieve spectra of all compounds with similar structures 
by selecting the Structure Search button (second button from the left) with the structure highlighted in the Spec List 
window or by use of the Right Mouse button (RMB) menu with the Mouse pointer on the spectrum containing a structure. 

 
When the NIST MS Search Program saves a structure to the Windows Clipboard using the Right Mouse button menu 
command Copy Structure to Clipboard, the structure is copied to the Windows Clipboard and a file in Molfile format 
named Clipboard.MOL is written to the NIST MS Search Program directory (by default, C:\NIST26\MSSearch). Other 
programs can either use the structure as it appears on the Windows Clipboard or this file for structure importation. 
Structures saved to the Windows Clipboard may be accepted in the MS Search Program Librarian Spectrum 
Information dialog box if its Clipboard Struct button is not grayed. Some drawing programs need to be told how to 
save a structure in the Windows Clipboard. For example, in ISIS/Draw (MDL Information Systems, Inc.), it is necessary 
to select Copy Mol/Rxnfile to the Clipboard checkbox in Options/Settings/General tab of that program. 
If an application is associated with files that have a .MOL extension, then the structure may be sent to that application 
by selecting in the RMB menu Send To and Default Structure Editor. 
If a spectrum containing a chemical structure is selected, the RMB menu command Send to will result in a Send to 
menu that can have up to three additional structure editor items. These Send to menu items are a function of the first 
three lines in a text file AUTOIMP.STR located in the NIST MS Search Program working directory (the WorkDir32 item 
in [NISTMS] section of the WIN.INI file). Each line should contain three double-quoted strings separated by spaces: 

1) A program name as it appears in the Send to menu 
2) Program executable and path 
3) Program startup parameters. %1 will be replaced by the mol file name. 

The following is an example of the contents of an AUTOIMP.STR file: 
"ChemSite" "C:\MolSuite\ChemSite\ChemSite.exe" "%1" 
"ISIS Draw" "D:\ISIS Draw\IDraw32.exe" "%1" 
"ACD/ChemSketch" "C:\acd800\chemsk.exe" "%1" 

The last line of the above example results in ACD lab ChemSketch starting with the contents of clipboard.mol file being 
imported when ChemSketch opens.  

When a program that is to be interactive with the NIST MS Search Program is installed, it must UPDATE or CREATE 
the AUTOIMP.STR file, or the AUTOIMP.STR file must be edited by the user before the third-party program will appear 
on and function from the Send to menu. 

See APPENDIX 1 for instructions on the creation of AUTOIMP.STR. 

A third-party program can call the NIST MS Search Program by issuing the command: 

C:\NIST26\MSSEARCH\NISTMS$.EXE /MOL=<molfile> 

assuming the NIST MS Search Program is in the C:\NIST20\MSSEARCH directory; if it is in some 
other directory, make the appropriate substitution (see Location of the NIST MS Search Program 
above) 

where <molfile> is a full pathname of the MOL file. If there is a space in the name (e.g., example c:\program 
files\a.mol), the name should be double quoted: 

C:\NIST26\MSSEARCH\NISTMS$.EXE /MOL="c:\program files\a .mol" 

A third-party program can obtain the path to NISTMS$.EXE from Path32 in the [NISTMS] section of WIN.INI (see 
Location of the NIST MS Search Program in the USE WITH INSTRUMENT DATA SYSTEMS section above). 
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User-Libraries 
The NIST MS Search program’s Librarian tab view can create user-libraries to search against. These can be libraries 
of EI or Tandem spectra (integer and accurate m/z value). Accurate m/z value user-libraries of in-source CAD or open-
air desorption ionization spectra, using techniques such as DART or DESI, can also be created within the Librarian 
tab view. Once an integer m/z value user-library is created, it can be used as is. It can also be updated by adding or 
editing existing entries using the Librarian tab view editing tools. The accurate m/z user-libraries are created using the 
tools in the Librarian tab view; however, before they are used, these user-libraries must be reindexed using the 
Lib2NIST program. When an accurate m/z spectrum user-library is edited in the Librarian tab view, it must then be 
reindexed using the Lib2NIST program. The process of reindexing an accurate m/z user-library can be found on the 
NIST website at https://chemdata.nist.gov. Up to 127 total libraries can be installed in MS Search. This includes the 
NIST provided libraries and the user-libraries. 

Libraries, including the libraries provided with NIST 26 are searchable at the same time by various search routines in 
MS Search. EI user-libraries may be searched in conjunction with the NIST/EPA/NIH Mass Spectral Main (mainlib) 
and/or Replicates (replib) Libraries, or they may be searched separately. MS Search allows for the searching of 
combinations of libraries in any order. The inclusion of libraries and their order of search can be set from the Libraries 
or Options tab of the various Search dialog boxes (see Figure 96 as an example). When searches of unknown spectra 
are performed, the search order is not an issue. The Hit List is ordered (by default) according to Match Factor or 
Score values (unless otherwise specified) regardless of what library the Hit is in. 

The user-libraries are easy to create and 
maintain. It may be desirable to create them using 
specific sets of spectra from the NIST/EPA/NIH 
Main or Replicates Library. Any spectrum in the 
Spec List can be added to a user-library. Any 
spectrum in the Hit List of the Lib. Search tab, 
Other Search tab, or Names tab, a Plot window, 
Text Info window, or Subtraction window in the 
Compare window of the Lib. Search or the 
Compare tab views can be copied to the Spec List 
window by selecting Spec List on the Send to 
menu from the Right Mouse Button (RMB) menu. 
The size of a user-library is limited to 65,535 spectra. 

The MS Search Program can read user-submitted spectra in the JCAMP, U.S. EPA, or NIST Text file formats as well 
as formats of files submitted by various instrument manufacturer’s mass spectrometry data systems.  

User-libraries are maintained as folders in the same 
folder as the NIST provided libraries (also folders). The 
name given to the user-library is the name of the folder 
contacting the library. This folder will contain library-files 
and indices constituting the user-library. The spectra 
and compound information are put into records through 
the Librarian tab or by using Lib2NIST along with an 
msp/mspec or an sdf file. 
The spectra and compound information can originate in a 
text file in the NIST Text file format described in the NIST 
TEXT FORMAT of INDIVIDUAL SPECTRA section of 
this manual or directly imported from AMDIS. Spectra can 
be edited by selecting the Edit Spectrum button in the 
Librarian tab Button Bar (Figure 115). This will display 
the Spectrum Information dialog box (Figure 116). This 
dialog box can be used to add structures to user spectra 
from the clipboard, add identification information such as 
CAS numbers or synonyms and to add comments. In 
addition, the RI value for the spectrum can be either 
added or edited. 
  

 

Figure 116. Spectrum Information dialog box 
displayed in the Librarian tab view. 

 

Figure 115. Librarian Button Bar. 

https://chemdata.nist.gov/
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A highlighted spectrum with nothing more than a Name:, a Field header titled Num Paks on the line following Name:, 
followed by the m/z-intensity pairs equaling to the number in the Num Peaks field appears in the Spectrum 
Information dialog box when the ed button is selected from the Button Bar. Usually, the first step to creating a potential 
entry for a user-library is to associate a structure from the Windows Clipboard or an SDF file. If a structure in the Mole 
file format has been put on the Windows Clipboard, the button on the lower right of the dialog box labeled From 
Clipboard will be available. Selecting this button will cause the structure to appear in the window to the left replacing 
the  icon. The next step is to enter the Formula and Mol Weight. This MUST BE Done by selecting the From 
structure button next to the text entry input box just below the Formula label in the Spectrum Information dialog box 
(top left of Figure 116). This is necessary to have the proper indexing for the user-library. The Name field in the dialog 
box can be edited and a CAS Number added. 

Once all editing of the spectrum is completed, if it is a spectrum currently not in a user-library, select the button at the 
bottom of the dialog labeled Add to List or Replace. If the Replace button is selected, the entry in that position of the 
Spec List is replaced and the spectrum will have an ‘E’ as the second entry from the left of the line for the spectrum. If 
the spectrum is from an existing library and has been sent to the Spec List by the RMB menu Send To command, the 
entry will have the first two letters of the library name of origin following the Spec List entry number. When the Replace 
button is selected the edited spectrum replaces what is in the Spec List and the spectrum on the library of origin. The 
edited spectrum replacing a previous spectrum will have the same ID number in the library as did the original spectrum. 
If the Add to List button is selected, the edited spectrum is prepended to the Spec List and assigned Spec List number 
1. If the Add to List button is selected, the edited spectrum is prepended to the Spec List and assigned Spec List 
number 1 and the original spectrum with it Spec List number remains in the List. If the spectrum is from an existing 
library, it also remains on the Spec List in its original position and is unchanged in the user-library. 

If the Add to Library button is selected, the Chose library to save to dialog box is display with a list of libraries displayed 
in a window with a slider bar on the right side. All libraries are listed except for those provided by NIST. NIST libraries 
cannot have spectra added, deleted or edited. 

A new spectrum can be created using the New spectrum button () in the Librarian tab Button Bar (Figure 115). A 
spectrum in the Spec List of the Librarian tab view that is listed as being in a user-library can be deleted by selecting 
the Delete from library button (). This results in a dialog box display asking the action to be confirmed. The entry is 
deleted from the user-library, the Spec List of the Librarian tab view, and the Hit List where it originated from. The 
user-library is reindexed to reflect the number of spectra it contains. 

The manufacturer of a specific mass spectrometer’s data system should be consulted to see if there is file compatibility. 
Instructions on building user libraries are included in the Librarian tab view’s Spectrum Information dialog box’s Help 
screen by selecting the Help button in the dialog box. 

There are four more buttons seen on the Librarian tab view’s Button Bar as seen in Figure 115: Add to library, Move 
to library, Delete library, and Create library. If the Add to library or Move to library button is selected, a new 
user-library name can be entered rather selection from one of the user-libraries listed, and that new library will be 
created. Using the Delete library button is a draconian action. Selecting this button results in a warring dialog box 
asking for confirmation of the action about to be taken. If confirmed, the dialog box closes and the Choose library to 
delete dialog box is displayed. When OK button is selected, all spectra associated with the deleted user-library are 
remove from all displays in MS Search and the folder constituting the user library is deleted. None of the NIST Libraries 
can be deleted using this feature. WARNING! Some third-party mass spectral libraries providers will set their user-
libraries to Real Only. These libraries will appear in the list of libraries that can be deleted and will be deleted.  

When user-libraries are created or spectra are added using the Librarian tab view, they are indexed for Exact Mass, 
the Hybrid-17 Search, InChIKey, RI and Derivatives, The structure Search Database is not built/rebuilt. After initially 
building a new user-library or adding a spectrum to an existing user-library, the Rebuild Structure Search Database 
must be run from the Tools menu accessible from the Main Menu. 

There are two buttons on the Spectrum Information dialog box: Edit RI and Additional Info. A dialog box is displayed 
after clicking on Additional Info button, a Spectrum Info dialog box is displayed with 30 Field title label that will appear 
on a spectrum when content is present for the individual label. Select one of the labels. This will cause area to the right 
to be highlighted. Select the highlighted area. This results in the highlight area changing to a text entry box. Put the 
Mouse pointer in this text entry and type a string of any other length. Select another label and repair the process. Once 
all the desired labels have text entered, select the OK button at the bottom of the dialog box. This causes the Spectrum 
Info dialog box to close. The Spectrum Information dialog box (edited spectrum) will still be displayed. When the 
Spectrum Information dialog box is closed using one of the various options (Add to library, Add to List, or Replace) 
and the edited spectrum is displayed, these new Field headers, with their contents, will appear. Most of the Field 
Headers are related to spectra in Tandem user-libraries; however, it is possible some have relevance to EI spectra. 



  

Page 128  NIST 26 MS Libraries and MS Search Program v.4.0  

Selecting the Edit RI button results in the display of the Edit Retention Index value(s) dialog box being displayed 
(Figure 117). This dialog has a dropdown list box allowing the selection of the column type: Specified standard column 
type(s); Any column type (n-alkane standard); or Unspecified column standard. Selecting a specific column type 
makes available text entry boxes. RI values from the Chromatogram tab view are Semi-standard non-polar. 

Currently the only value that has meaning relative to a spectrum 
search is Specified standard column types (Semi-standard 
non-polar (e.g. DB-5). Values for the other fields can be added 
manually. If specific formatting is present in a *.MSP or *.MSPEC 
file, the Specified standard column types (Standard non-
polar (e.g. DB-1) and Standard polar (e.g. DB-WAX) will be 
populated. This formatting is explained in the next section (NIST 
Text Format of Individual Spectra). 

Non-standard Field 
headers for the Text 
Information in user-
library spectra can be available using the “Tags in the “Comments” field” 
feature of MS Search. A Tag is the name of a Field heading that will be 
displayed with the spectrum in the Text Information window Spec List or 
Hit List spectrum and can optionally appear in the line below the Plot of the 
spectrum. Text is designated as a Tag in the “Comments” field of a user 
library spectrum if it consists of the Field title (a line of characters without 
spaces) followed by an = (equals sign). Following the = is the contents of 
Field. This can be a line of characters without spaces, a number, or a text 
string enclosed in quotation marks (" "). For example, the following may be 
entered in the “Comments” field of the Spectrum Information dialog box of 
a user-library spectrum: 

Structures were prepared using SoftShell ChemWindow Version 6.0 Contributor="University of the 
Pacific Mass Spectrometry Facility" Instrument="Agilent 5975 Inert XL MSD w/7890 GC" 
Tune="Standard Spec w/PFTBA" ScanRange=35-400 GC_column="30 m x 250 µm with 0.3 µm film 
thickness of BD-5" OvenTemp="50 C 5 min to 250 C @ 5 C/min" Synthesized="Matt Curtis". 

As shown in Figure 119, the information preceding each equals sign (=) will be displayed as a Field title in the Text 
Information window of the spectrum and can optionally be displayed with the Plot window of the spectrum. The 
information following the equals sign (=) will appear following the Field header. Entry of Field contents (string) must 
conform to the rules above. For this display to appear, the Field titles must be registered in the Display comment field 
options dialog box shown in Figure 118 (called from the Comment field options selection of the Options menu. 
When the Tags have been entered in the Comment field options dialog box, they will not be displayed in the 
“Comments” field of the Text Information window. 

When a search is performed of a user library that contains Tags (Field titles), it is possible to constrain that search 
based on the Tag (Field title) and the partial or whole contents of the Tag (Field title). More specific details on the use 
of Tags as Constraints are in MS Search Program Help file. 

Importance of user-libraries 
If mass spectral data is to be shared, the spectrum should have a structure associated with it. The best way to share a 
single spectrum or multiple spectra is via a user-library. Once the user-library has been prepared, use a ZIP program 
to convert it to a ZIP file and send it. 

Warning 
Spectra provided in NIST Libraries can put into user-libraries. These libraries CANNOT be shared with anyone else. 
If a user-library containing an NIST spectrum is distributed to someone who does not have a license for that version 
of the library, the violation is the same as if a copy of the library was distributed. Rather than distributing an NIST 
spectrum, it is better to measure the spectrum and distribute it. 

When building a user library, it is very easy to associate a structure with a spectrum by assigning a CAS registry number 
that is in an NIST Library that has an associated spectrum. If that user -library is distributed and the receiver does not 
have that NIST Library, no structure will be displayed. Copy the structure from the NIST Library to the windows 
Clipboard and then associate it with the measured spectrum. 

 

Figure 117. Edit GC Retention Index value. 

 

Figure 118. Display comment field 
options dialog box. 
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Figure 119. Example of custom field titles with custom content added to a user library spectrum using Tags. 

Graphic is from an earlier version of MS Search. 
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NIST Text Format of Individual Spectra 
The NIST Text file (*msp; *.mspec; *.txt) format is simple. A file can contain as many spectra as desired. Each spectrum 
must start with the Field title Name:. There must be something in this field for the spectrum to be imported (e.g., the 
data file name and the scan number of the spectrum source). The next required Field title is Num Peaks:. The contents 
of this field must be the number of m/z value-intensity pairs that make up the spectrum. Optional fields with the titles of 
Comments:, Formula:, MW:, Synon:, and CAS#: can be between the Name: and Num Peaks: fields. Additional field 
titles are recognized by MS Search for different types of spectra such as those in Tandem user-libraries. These are 
described in the MS Search Help file. 

When a spectrum is saved to a text file from the NIST/EPA/NIH Main or Replicates Library, it will also contain fields 
with the names NIST#:, InChIKey:, ExactMass: and DB#:. The field with the name NIST#: is on the same line as the 
CAS#: field and separated by a semicolon (;). DB# is same as the ID# displayed in the Spectrum Text Window. The 
file format does accurate retention index data. This is explained in more detail in the following section. The 
m/z value-intensity list begins on the line following the line with the Field title Num Peaks:. The lines of the 
mass/intensity list have no Field title. Tandem mass spectra contain other filed headers, the one mandatory is 
Precursor mz:. 

When a file is created with all the allowable fields, each Field title should be on a separate line. Use the following format. 
The format for each spectrum in a text file usable by the Program should be as follows: 
Line 1: NAME:  Molecule   (Required, up to 511 characters) 
Line 2: COMMENT:  Run 23, 8/8/88  (Optional, up to 1023 characters) 
Line 3: FORMULA:  C6H6  (Optional, up to 23 characters) 
Line 4: MW:  78  (Optional) 
If the spectrum submitted to Library spectrum Search contains a CAS registry number with its appropriate prefix 
(CAS: ), the display of the spectrum in the Plot, Compare, and Structure Windows will have the structure of the 
compound with that CAS registry number if present in the NIST/EPA/NIH Main Library. 
Line 5: CAS:  71-43-2   (Optional) 
Line 6: SYNON:  Chemical name synonym   (Optional, may be repeated) 
 
The actual mass spectral data (number of peaks in the spectrum) may begin on the next line. It does not actually matter 
what line this is, as long as it precedes the line that starts the mass/intensity pair data. The VERY NEXT line and 
subsequent lines MUST contain the paired mass/intensity values. 
Line 7:  Num Peaks:  18 (This prefix and the exact number of mass/intensity pairs is required.) 
Line 8: 26 430; 27 340; 28 40; 37 480; 38 611; 39 1411; 49 300; 50 1792; 
Line 9: 51 2052; 52 1962; 63 340; 73 160; 74 480; 75 180;  
… 
Line n: 76 721; 77 1401; 78 9806; 79 651; 
The peaks need not be normalized, and the m/z values need not be ordered. The exact spacing and delimiters used 
for the m/z-intensity pairs are unimportant. For example, the peaks above could equally be presented as: 

(26,430),(27,340),(28,40),(37,480),(38,611),(39,1411), 
(49,300),(75,180),(50,1792),(51,2052),(52,1962),(63,340), 
(73,160),(74,480),(75,180),(76,721),(77,1401),(78,9806),(79,651) 

or each m/z-intensity pair could be on an individual line. The following characters are accepted as delimiters (except 
“|”): |space|tab|,|;|:|(|)|[|]|}| 

The file can be given any valid file name; however, it is best to use the extension “MSP or MSPEC”. These are the 
recognized default extension in the MS Search Program when user-library spectra are to be imported. 

Several examples of NIST text format mass spectral files are installed together with the MS Search Program, namely 
SAMPLIB.MSP, UNKNOWN.MSP, and USERDEMO.MSP. 

To get a better prospective of file format, use Export button from the Librarian tab view’s Button Bar to write one or 
more spectra to a file from the NIST EI and Tandem Libraries; then, open these files with Windows Notepad. 
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Import and Export of Retention Indices with a Spectrum 
Retention index (RI) format was designed to provide compatibility with existing EI libraries and import of a mass 
spectrum into NIST MS Search. 
In general, each RI value must have GC Column Type associated with it. Currently, there are three specific Column 
Types (1-3 in the table below) and two other (4-5) column types. RI of these two column types can be compared with 
any selected specific Column Type: 

 Column Type Accepted Tags (case insensitive) 

1 Semi-standard non-polar s, db5, semi, SemiStandardNonPolar, ssnp, SemiStdNP  

2 Standard non-polar n, db1, nonpolar, snp, standard, StandardNonPolar, StdNP 

3 Standard polar p, pol, polar, sp, StandardPolar, stdp, StdP, StdPolar  

4 Any (n-alkane standard) a, all, AllColumnTypes, AnyColumnType, std, Any  

5 Unspecified u, un, uns, unspecified, User 
 
When importing or adding a spectrum with RI of Unspecified column type to a library, there is an option of changing RI 
column type to any of the three specific Column Types or a line with the value for Any column type or the value for the 
User column type. NIST EI Spectra which have RI values are exported into a single line in the MSP format as shown 
below. 

RI Export with a Spectrum in an MSP or JCAMP file 
A compound may have up to three RI values of different specific Column Types : 

Retention_index: SemiStdNP=654/11/226 StdNP=654/7/286 StdPolar=957/17/131 

or 
Retention_index: Any=1000 

or 
Retention_index: User=2059 

Slash-delimited numerical values following Accepted Tags are 
Experimental RI median/deviation/number of datapoints  
In NIST MS Search Spectrum Text Information window, RI values of the first example (Benzene) are displayed as: 

Experimental RI median±deviation (#data)  
Semi-standard non-polar: 654±11 (226) 
Standard non-polar:      654±7 (286) 
Polar:                   957±17 (131) 

 
Other Unspecified RI values possibly present in the Comment (see the next section) are left unchanged in the exported 
spectrum. 

Single RI value1, if available, is exported into a JCAMP file as 
##$RETENTION INDEX=654 

RI Import with a Spectrum in an MSP or JCAMP file 
Legacy MSP file formats allow saving several possibly different RI values of Unspecified column type, which may 
contradict each other. NIST MS Search picks up only one of them according to the priority rules described below. 

 
1 If RI values of multiple specified Column Types are associated with a spectrum, then RI of the first available column type in the 
following sequence is output into a JCAMP file: 

• Semi-Standard Non-Polar  

• Standard Non-Polar  

• Standard Polar  
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If the last out of all lines starting with Retention_index: or RI: or Synon: $:29 in an MSP file has format 
described in the previous section with possibly different Accepted Tags, then contents of this line are used as input.  
Otherwise, there may be up to 4 untagged RI value locations/formats of Unspecified column type. They are described 
in the following table (n is the RI value): 

Priority Format Location 
Highest |RI:n Last occurrence in comment 
 RI=n Last occurrence in comment 
 RI:n Last occurrence in comment 

Lowest 

Retention_index:n or 
Retention_index=n or 
RI:n or 
RI=n or 
Synon: $:29n 

Last occurrence in MSP file 

 
RI value imported from a JCAMP file always has Unspecified column type. 
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APPENDIX 1: Creating AUTOIMP Files for NIST MS Search 
It may be necessary to create AUTOIMP.MSD as the primary locator file used for the importation of spectra or structures 
from third-party mass spectral data systems and/or AUTOIMP.STR for interaction between the MS Search Program 
and third-party structure drawing programs. These files may be created using Notepad with certain versions of Microsoft 
Windows. 

In most cases where MS Search is being installed on a computer containing a data analysis that links with MS Search, 
the MS Search Installation will create the AUTOIMP.MSD file. Some data analysis systems that link with MS Search 
are written such that when their software tries to send a spectrum to MS Search, the program looks to where MS Search 
is installed to determine if there is an AUTOIMP.MSD file in the folder. If there is, the send program will write the 
secondary locator file in the location specified in the existing AUTOIMP.MSD file. If an AUTOIMP.MSD file does not 
exist, the sending software will automatically create one in the appropriate MS Search folder. 

If Microsoft Notepad is used, the default extension is .TXT (Text Document) even though AUTOIMP.MSD or 
AUTOIMP.STR has been entered in the “File name:” field. The default settings for Windows File Explorer will not show 
this .TXT extension. The file will not work unless the .TXT extension is removed. The file can be renamed by highlighting 
the file in Windows Explorer and selecting Rename from the File menu. 

When saving the file using Save As option, this problem may be completely avoided by selecting All Files in the Save 
as type dropdown list box (Figure 120). In this case, the file will be saved with the extension provided in the “File name:” 
field (see the Save As dialog box shown below). 

When saving the file using the Notepad Save As option, also make sure the ANSI Encoding is selected (in some 
versions of Windows, the Encoding option is not present). 

After File name, Save as type, and Encoding are set correctly, select the Save button. 

 
Figure 120. Save As dialog box displayed within Windows Notepad. 
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APPENDIX 2: Using the NIST MS Search Program with 
ChemStation 
The NIST MS Search Program has been supported through several versions of the HP/Agilent Technologies 
ChemStation. In the recent versions of the ChemStation for GC/MS, both the NIST Output and the AMDIS options will 
appear on the Spectrum menu of the Data Analysis software when using the Enhanced Quantitation, Standard 
Quantitation, or Gasoline mode; and on the Lib. menu when using the Environmental mode, if the appropriate macros 
have been installed. The NIST/EPA/NIH MS Library (NIST 20) setup will install the two required macros along with 
additional macros that will allow for greater flexibility with the ChemStation software. 

It is possible to use the ChemStation double-click option on a displayed spectrum to send that spectrum to the NIST 
MS Search Program Spec List Window, bringing the MS Search Program into focus. If the appropriate options 
(including Automation, see Figure 73 and Figure 75) have been set in the NIST MS Search Program, then, after the 
spectrum is automatically prepended to the Spec List Window, it will be searched. 

If using the Enhanced Quantitation mode on any version of ChemStation, the setup will automatically add four new 
options to the Spectrum menu (PBM Quick Search, NIST Search, Multiple Lib PBM Search, and Set Default 
Search Engine). Each of these menu options is explained below. If these options are to be added to other modes of 
the ChemStation software, see the MENU_MOD document file on the NIST MS Search Program installation CD ROM 
in the \support.cs directory. This document is also available after installing NIST 23 MS Library by selecting 

ChemStation Menu Modification from the NIST Mass Spectral 
Database program folder. 

Some older versions of ChemStation will have ASCII Output as opposed 
to NIST Output, the Spectrum menu, or the Lib. menu found on the 
Environmental mode. Selecting either the NIST Output or ASCII Output 
results in the display of the Options for NIST Library Search dialog box 
with six radio button options and OK and Cancel buttons. The Macro 
NISTINT.MAC must be installed in the HPCHEM\MSEXE or 
MSDCHEM\MSEXE directory for these menu selections to be displayed. 

When all the necessary macros have been installed in the ChemStation 
MSEXE directory and the modifications have been made to the 
ChemStation macros, the following options will be available from the 
ChemStation Spectrum menu (Figure 121): 

The PBM Quick Search (PBMSrch.mac) performs the normal 
ChemStation PBM search of the currently displayed spectrum. 

The NIST Search (NISTSrch.mac) passes the currently displayed mass 
spectrum to the NIST MS Search Program. The spectrum will be 
prepended to the NIST MS Search Program Spec List Window. If the 
NIST MS Search Program is configured to search automatically, then 
the search will be started when the spectrum is passed to the NIST MS 
Search Program. Otherwise, double click on any spectrum in the Spec 
List Window located in the Lib. Search tab to start a search. 

The Multiple Lib PBM Search (LS.mac) performs a ChemStation PBM Search using up to three different libraries 
(all of which have to be specified using the dialog box displayed by selecting the Select Library option on the Search 
menu). The top 20 Hits from each library will be displayed in order of decreasing match quality. 

Set Default Search Engine (SWITCH.MAC) displays a dialog box that allows the selection of the default library search 
to be evoked when double clicking the RMB menu on the currently displayed spectrum. The NIST MS Search is the 
default until another search type is set as the default. 
NIST Output (NISTINT.mac) displays a self-explanatory dialog box that allows for the use of the NIST MS Search 
Program in a number of different ways and the copying of ChemStation user libraries as NIST MS Search Program 
user libraries. 
AMDIS (AMDIS.mac) loads AMDIS with the data file currently being viewed with the ChemStation Data Analysis directly 
into AMDIS for analysis. Once in AMDIS, select Run to perform the analysis.  
The Lib2NIST converter program will be installed along with the NIST MS Search Program. This program allows mass 
spectral libraries that have been created using the internal utilities of the ChemStation software (including structures) 
and other mass spectral libraries to be copied to the NIST user libraries format that can be employed by the NIST MS 
Search Program. This utility is evoked as an option from the Options for NIST Library Search dialog box displayed 

 
Figure 121. Spectrum Menu as 

displayed in ChemStation Enhanced 
data analysis.  
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by selecting the Copy ChemStation Lib to NIST Format radio button and then selecting the OK button or by selecting 
the Lib2NIST icon in the NIST Mass Spectral Database program folder. 
An additional macro is found on the NIST MS Search Program installation disk, AUTONIST.MAC. This macro is to be 
incorporated into automated sequences. It automatically selects spectra based on the autointegration of the current 
data file and switches to the NIST MS Search Program where the spectra are automatically imported into the Spec 
List Window. If the proper settings have been made in the Program, these spectra are searched, and the focus 
returned to the HP MS software. These features can only be utilized with G1034C, Version C.3.00.00 or later of 
ChemStation. 

Additional Information Regarding Modes Other Than Enhanced Quantitation 
During the installation of the NIST/EPA/NIH MS Library (NIST 26), if the NIST MS Search Program has been selected 
as the default search engine for ChemStation, each time a spectrum is double clicked, the displayed spectrum will be 
prepended in the NIST MS Search Program Spec List Window. The NIST MS Search Program will be brought into 
focus regardless of the data analysis mode (Enhanced Quantitation, Standard Quantitation, Gasoline, or 
Environmental). One of the other above-referenced search methods can be changed to by selecting the ChemStation 
Default Search Mode icon in the NIST Mass Spectral Database program folder. 
MODIFICATION OF MACROS IS NOT NECESSARY TO SWITCH FROM THE NIST MS SEARCH PROGRAM AS 
THE DEFAULT SEARCH METHOD FOR THE DOUBLE-CLICK FEATURE OF THE ChemStation. 

HP_NIST MACRO (NISTINT.MAC) 
When NIST Output is selected from the Spectrum menu of the MS ChemStation or ASCII Output from the Lib menu 
of the Environmental software, the Options For NIST Library Search dialog box is displayed (Figure 122). This dialog 
box consists of six options and OK and Cancel buttons. Each option has a radio button next to it, used to select an 

option. Selecting the OK button results in execution of the option. 
In the Options For NIST Library Search dialog box, select the desired item and 
click OK. If any of the first three options are executed, the dialog box will be 
redisplayed. 
Each time one of the top four menu selections is executed, the file HPNIST.TXT 
is created in the ChemStation HPCHEM or MSCHEM directory. This file contains 
the name and location of the text file that contains the saved spectra in the NIST 
format. The HPNIST.TXT file is deleted every time the NIST MS Search Program 
is brought into focus, and spectra are automatically imported into the top of the 
NIST MS Search Program Spec List Window. 
At the same time, the HPNIST.TXT, the second locator file, is created, a text file 
named TEMPSPEC.MSP containing one or more spectra is created or appended. 
The text file is located in the ChemStation directory HPCHEM or MSDCHEM. This 
text file will remain there until it is overwritten or removed manually. 
When the NIST MS Search Program comes into focus, the spectra that have 

been saved in the ChemStation software are automatically copied to the Spec List Window. If spectra are already in 
the Spec List Window, a prompt to Prepend or Overwrite the current contents will be displayed. If Prepend is selected, 
the new spectra are added to the top of the Spec List Window (prepended). If Cancel is selected, the automatic import 
will be aborted. However, the HPNIST.TXT file may be deleted even in the case of an abort. If the options of Automatic 
Search On and Return Focus to Caller upon Completion have been selected in the Automation dialog box, 
selecting Cancel returns the focus to the ChemStation software. 

Menu “Options for NIST Library Search” 
The Create Integrated Spectra File option runs the ChemStation Autointegrate routine on the displayed chromatogram 
and creates the text file containing the spectra that represent the apex of each chromatographic peak. 
The Create File with Spectrum in X option creates a text file that contains the spectrum that is in X of the ChemStation 
Stack display. This is where background-subtracted and averaged spectra will be found. This is the currently displayed 
spectrum. 
The Append File with Spectrum in X option appends the spectrum in X of the Stack display to the existing text file. If 
a text file does not exist, one will be created. 
The Create\Search Integd. Spect. File option creates a text file that contains spectra representing the tops of each 
chromatographic peak and either starts or switches to the NIST MS Search Program where the spectra are 

 
Figure 122. Result of selecting 

NIST Output from the 
Spectrum menu. 
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automatically imported into the Spec List Window. If Automatic Search On in the NIST MS Search Program 
Automation dialog box has been selected, each spectrum will be searched. The results are optionally printed, and the 
results of each search are stored in the Hit List History. If Return Focus to Caller upon Completion has been selected 
in the Automation dialog box, then after the last spectrum is searched and printed, the focus will be returned to the 
ChemStation software. If spectra are already in the NIST MS Search Program Spec List Window, the 
Append/Overwrite/Cancel query will be displayed. 
The Toggle to NIST Library Program option either starts the NIST MS Search Program or switches to it if it is already 
running. The ChemStation software can be redisplayed by holding down the <Alt> key and pressing the <Tab> key, or 
the NIST Program Switch To Caller button can be selected. The NIST MS Search Program can be brought back into 
focus by using the <Alt><Tab> command or by selecting the Toggle option from the Options For NIST Library Search 
dialog box. 
The Copy ChemStation Lib to NIST Format option is described in APPENDIX 3. 

AUTONIST Macro 
This is a non-interactive macro that can be executed using the command line instruction: 

MACRO “AUTONIST.MAC”, go 
or from within the Method. Every Method directory contains a file DEUSER.MAC. Edit this file to contain the string: 

MACRO “AUTONIST.MAC”, go. 
This File is in the \SUPPORT.HP directory of the CD ROM and must be copied to the \HPCHEM\MSEXE directory. 
When the Method is run, the AUTONIST Macro will execute. The chromatogram is autointegrated, and the spectra 
representing the top of each chromatographic peak are stored in a text file. The focus is then switched to the NIST MS 
Search Program. The spectra are imported into the Program Spec List Window. If spectra are already in the Spec 
List Window, they will be overwritten.  
If Automatic Search On and Return Focus to Caller upon Completion have been selected in the NIST MS Search 
Program Automation dialog box, the spectra will automatically be searched. After the last spectrum is searched, the 
focus is returned to the HP MS software. For this macro to function properly, it will be necessary to have selected the 
above two options in the Automation dialog box. 
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APPENDIX 3: Copy ChemStation and Other Libraries to NIST 
User Library Format 
This is a separate program called by selecting the Lib2NIST Converter icon on the NIST Mass Spectral Database 
program folder. This program allows mass spectral libraries in a variety of formats (along with structures or structures 
in separate files) to be selected and copied to the NIST user library format. For all 32-bit Windows (Windows NT, 
Windows 98/Me/2000/XP/Vista/Windows 7, 8, 8.1) and Windows 64-bit platforms, the Lib2NIST converter program 
replaces the HP2NIST program that was provided with previous versions of the NIST MS Search Program. The use 
of the HP2NIST program is described at the end of this section. Another feature of the Lib2NIST program is the ability 
to take user libraries that were developed by using versions 1.5 through 1.7 of the NIST MS Search Program and copy 
them into a format fully compatible with the current version of the NIST MS Search Program. 

 
Figure 123. Opening display of Lib2NIST program. When started, the Lib2NIST converter program displays a 

file dialog box overlaid on the program screen. 

Select the library to be copied and then click on the Open button (Figure 123). The dropdown arrow will also allow for 
selecting from a variety of JCAMP formats. More than a single library can be selected in this dialog box by using the 
standard Windows multiple file selection techniques. 

 
Figure 124. Lib2NIST converter program display. 
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The selected libraries will now be listed in the Input Libraries or Text 
Files window of the Program display (Figure 124). 
The NIST Library and Output locations can be changed by selecting 
the appropriate button located to the right of the two fields. This will 
result in the display of the Browse for Folder dialog box (Figure 125). 
Select the desired directory (folder) and then click on the OK button to 
change the location. 
The Define Subset button will display a dialog box that allows for the 
choice of a range of input spectra ID or CAS numbers. The Use 
subset checkbox is grayed unless an entry has been made in the 
Define Subset dialog box (Figure 126). 
After making any desired entries in the Define Subset dialog box, 
select the OK button to return to the Program main display.  

 
 
 

The Options button on the Program display will display the 
dialog box shown above in Figure 127. This allows for the entry 
of mass defect corrections to be applied to m/z values of 
imported spectra and whether to: 1) include synonyms from the 
source file, 2) retain the ID numbers (or sequence numbers) 
from the source library or file2, 3) calculate molecular weights 
(nominal mass) from formula, and 4) create or convert MS/MS 
and/or In-source libraries3. 

Select the libraries to be converted in the Input Libraries or 
Text Files window of the Program display, make sure the 
Output Format is selected correctly, and then click on the 
Convert button. The selected libraries will then be converted 
and placed in the specified output directory. Advanced 
features of Lib2NIST are explained in the file CMDLINE.pdf 
installed with the Lib2NIST. Transliteration rules of extended 
ASCII characters are listed in the ASCII text file 
HPTRANS.TBL and may be modified in this file by the user. 
 

 
2 "MS/MS Spectra only" option disables "Keep IDs unchanged". To override this, use command line option /KeepIDs=YES 

3 In most cases, the "2008 MS Search compatible" option should be turned OFF. This option is intended only for saving MS/MS 
spectra into a MSP text file in a format, which is compatible with old versions of MS Search. MS/MS or In-source HiRes libraries 
created with this option have obsolete format unsuitable for reliable searching of high resolution spectra. 

 
Figure 125. Browse for Folder dialog box. 

 
Figure 126. Define Subset dialog box.  

 
Figure 127. Options dialog box display. 
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APPENDIX 4: Using the NIST MS Search Program with 
Thermo Fisher Scientific Xcalibur Software: 
(Qual Browser & FreeStyle) 
The Thermo Fisher Scientific Xcalibur software uses the NIST MS Dynamic Library (dll) as a library search engine. A 
copy of the NIST MS Search Program and AMDIS may be provided with a copy of the Xcalibur software. The 
NIST/EPA/NIH Mass Spectral Library may be optionally provided by Thermo Fisher Scientific. The NIST Tandem 
Library is installed on all Thermo Fisher MS/MS instruments. 
To add the NIST/EPA/NIH Mass Spectral Libraries to the Xcalibur software, run the NIST 26 MS Library setup. If it 
locates the following NIST MS Search Program and the AMDIS directories: 

C:\Program Files\NISTMS\MSSEARCH 
C:\Program Files\NISTMS\AMDIS32 

then let the setup install NIST 26 in these directories. The NIST 26 MS Library will then be properly installed along with 
any necessary program updates. 
More recent versions of the Xcalibur software detect and use NIST MS Search installed in another directory (for 
example, c:\nist20\mssearch) and the NIST/EPA/NIH Mass Spectral Library using means explained in the USE WITH 
INSTRUMENT DATA SYSTEMS section of this manual. 
Exporting MS/MS spectra to NIST MS Search transfers both the mass spectrum and the precursor m/z values. 
It should be noted that the Qual Browser of Xcalibur exports only integer m/z values NOT accurate m/z values. Upon 
release of NIST 23, the only Thermo Fisher program capable of exporting accurate mass data from Xcalibur acquired 
spectra is the program FreeStyle. 
 

 
Figure 128. Exporting a Spectrum to NIST MS Search. 

 

 
Figure 129. Exporting a Spectrum to NIST MS Search from Xcalibur FreeStyle. 
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APPENDIX 5: Search Algorithms 
There are two general ways that the NIST MS Search Program can retrieve library spectra that resemble the submitted 
spectrum. They are the Identity Search and the Similarity Search. An Identity Search is designed to find exact 
matches of the compound that produced the submitted spectrum and therefore presumes that the unidentified 
compound is represented in the reference library. Only experimental variability prevents a perfect match. The Similarity 
Search is optimized to find similar compounds and is intended for use when a compound cannot be identified by the 
Identity Search (it is probably not in the library).  

Screening 
For the sole purpose of achieving rapid retrieval rates before actually comparing spectra, modern search algorithms 
first identify a subset of library spectra with important features in common with the spectrum of an unidentified 
compound. While this can vastly reduce search times, it can also screen out the correct spectrum. When this occurs, 
the correct retrieval cannot appear in the Hit List. Because of unavoidable blind spots in simple algorithms, even a 
closely matching spectrum can be excluded. This is probably the most serious failure of any mass spectral search 
system.  

A variety of filtering algorithms for Identity searching were tested in an effort to avoid throwing away correct matches 
without sacrificing performance. These algorithms were tested using the 12,592 spectra that comprised an older version 
of the NIST/EPA/NIH Selected Replicates Library. The best performing algorithm used “a ranked peaks in common” 
logic similar to that incorporated in existing data systems. This finds library spectra with the largest number of peaks in 
common with the spectrum of the unidentified compound consistent with a required minimum number of identified 
spectra. Tests showed this minimum number to be about 50. This procedure retrieved 95% of the matching compounds 
(5% of matching compounds were lost). By scaling peaks by their m/z values, a 98% success rate was achieved at the 
same search speed. This is the screening logic of the Quick Identity Search option. By combining results using several 
screening criteria, a 99.4% success rate was achieved with a modest reduction in search speed. At this level, virtually 
all correct matches that were screened out were very dissimilar to the spectrum of the unidentified compound and 
would have produced low Match Factors. Both peak scaling and merging of multiple screening results are used in the 
Identity Search (EI Normal). A more detailed description follows. 

Peak Scaling: The determination of the largest peaks in a spectrum was made after first multiplying the 
abundance of each peak by the square of its m/z value. The most intense peak in the scaled spectrum of the 
unidentified compound is compared against the eight most intense peaks in scaled library spectra. The second 
most intense peak in the scaled spectrum of the unidentified compound is then compared against the nine 
most intense peaks in the library spectra. This is repeated in decreasing order of intensity of peaks in the 
scaled spectrum of the unidentified compound until the eighth most intense peaks are compared against the 
16 most intense peaks in the scaled library spectra. This is the only screening procedure applied in Identity 
Search (EI Quick). 

Merged Subsets: Since the use of any single set of peak specifications was found to fail for certain classes 
of spectra, results of multiple sets of peak specifications were merged to reduce this problem. After extensive 
optimization studies, four separate peak specifications were selected. The first of these specifications is 
described above for the Identity Search (EI Quick). The others were: 

1) The fourteen largest peaks in the scaled spectrum of the unidentified compound were matched against the 
fourteen largest peaks in the scaled library spectra. 

2) The six largest peaks in the original (non-scaled) spectrum were matched against the six largest peaks in 
the original library spectra. 

3) The five largest peaks along with the “maximum mass” peak in both the unidentified compound spectrum 
and the library spectrum were matched. 

The screening algorithms for the Similarity Search are similar to the Normal Identity Search except that scaling and 
maximum mass peaks are not used. When neutral loss peaks are used in the Hybrid Searches and Neutral Loss 
Search, neutral loss peaks are used in place of conventional peaks. For neutral loss peaks, abundances in library 
spectra are required to be within a factor of four of the abundances of corresponding spectra of the unidentified 
compounds (peak ranking and scaling are not used). 
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Search 
A mass spectrum can be represented as a row vector composed of the ordered peak intensities. It can also be 
considered to represent a single point in a multidimensional hyperspace defined by the m/z variables. Each of the 
intensities in the row vector represents the value of the coordinate of the spectral point along the individual mass axis 
in this hyperspace. If two spectra being compared are identical with respect to all the mass intensity pairs, their point 
representations in this hyperspace will coincide. If these spectra are very similar, their point representations will be 
close to one another. The Match Factor, which provides a sense of spectral similarity, may be regarded as the inverse 
of distance of the two-point representations when each spectral vector has unit length. 
The Dot-Product mass spectral search algorithm, which uses the cosine of the angle between the unidentified 
compound and library spectral vectors, has been optimized by scaling peaks using the square root of their abundance. 
For the Identity Search, peaks were weighted by the square of their m/z value, and a second term was added that 
compares ratios of adjacent peaks in library and the unidentified compound spectra. Its contribution was weighted so 
that it increases in importance as the proportion of common peaks increases. The only difference in the application of 
this algorithm to the Identity Search and Similarity Search is that m/z weighting is used only in the former. This 
defines the search algorithm used for both the Similarity and the Identity Searches in the Program. 
For additional information, see Stein, S.E. “Optimization and Testing of Mass Spectral Library Search Algorithms for 
Compound Identification” J. Am. Soc. Mass Spectrom. 1994, 5, 859–865. 
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APPENDIX 6: Syntax for Some Constraints in Searches 
Syntax of Name Fragments Constraint 
Applies to: all searches 
Max. length: 39 characters 
First release: 2000 
 

This “Name Constraint” field can contain up to eight name fragments. 
The name fragments are searched for in the compound main chemical name and in other names (synonyms). 
 

The following examples explain the conditions when the name constraint is satisfied (spaces around && and !! are 
optional): 

"COCA && INE": at least one name contains both "COCA" and "INE" 
"COCA && !! INE": at least one name contains "COCA" and doesn't contain "INE" 
"COCA !! INE": at least one name contains "COCA"; no name contains "INE" 

Syntax of Tags in Comment Constraint 
 
Applies to: all searches 
Max. length: 1023 characters 
First release: 2006 
 
General 
All information in NIST Peptide libraries is represented by the Tag=value convention. Typically, the “Peptide spectrum 
comment” field may contain the following items separated by spaces: 

Tag=string 
Tag="string" 
Tag=number 
 
Spaces may be inside a string only if the string is in double quotes. In older libraries, an unquoted string may also have 
space(s) inside a pair of parentheses (  ). Spaces are not permitted inside any Tag or next to the equal sign. 
“Comment” fields in older libraries may also contain Tag not accompanied by the equal sign and string. 
All Tag, string, substring, and word comparisons are described on the next page (ignore case). 
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Entering Tags in Comment Constraint 
Items in the “Tags in Comment” constraint field should be separated by spaces and/or linefeed characters. Unlike 
spectra comments, spaces next to the equal sign (as well as >, <, >=, <=, and :) are allowed inside the items. 

Spectra returned must satisfy all entered constraints. 
 

Examples 

 Item Comments of the output spectra must have 

1 "consensus" A Tag or a space-delimited string consensus  

2 Parent 6 letter sequence parent anywhere in the Comment 

3 fullname=”r.lecvk.c/2” Exactly this Tag=string:: Fullname=R.LECVK.C/2 

4 fullname=lec String following Fullname= contains sequence LEC 

5 Mods : ICAT_cl_hi String following Mods= contains word1) ICAT_cl_hi 

 The following rules apply to strings that are numbers 

6 Diffmod=6.8 String following Diffmod= begins with number 6.8, for example, 
Diffmod=6.8/8 or Diffmod=6.8 

7 Diffmod=5.1:6.8 String following Diffmod= begins with number between 5.1 and 6.8, 
for example, Diffmod=6.8/8 or Diffmod=6.8 

8 Diffmod > 6.8 

Diffmod >= 6.8 

Diffmod < 6.8 

Diffmod <= 6.8 

Diffmod= followed by a number greater than 6.8 

Diffmod= followed by a number not less than 6.8 

Diffmod= followed by a number less than 6.8 

Diffmod= followed by a number not greater than 6.8 
1) word is a string delimited by any character but a letter, a digit, or an underscore “_”; 

If word contains spaces or equal sign it should be entered in quotes. 

 

To reverse the meaning of constraints 1–5 (that is, change to “spectra must not have”), enter caret (^) as the 
first letter: 

1 ^"consensus" Tag consensus is not present 

2 ^parent Substring parent is not present 

3 fullname=^"r.lecvk.c/2" String tagged fullname is not exactly r.lecvk.c/2 

4 fullname=^lec String tagged fullname does not have substring lec 

5 Mods : ^ICAT_cl_hi String tagged Mods does not have word ICAT_cl_hi 
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More formal description 
 Item Comments of the output spectra must have 

1 "Tag" Exactly this Tag is present in the comment, possibly not followed 
by the equal sign 

2 Substring this substring anywhere in the comment 

3a Tag="string " exactly this string tagged with this Tag= 

3b Tag="" This Tag has no string or its string is “”  

4 Tag=substring this substring in the string tagged with this Tag= 

5a Tag : word exactly this word inside string tagged with this Tag= 

5b Tag : "word" exactly this word inside string tagged with this Tag= 

6 Tag=number tagged string = number or string begins with number 

7 Tag=number:number tagged string number inside the given range 

8a Tag >= number The number in the string less or equal to number 

8b Tag > number The number in the string less than the number 

8c Tag <= number The number in the string greater or equal to number 

8d Tag < number The number in the string greater than the number 

 

NOTES:  

• Inside an item, spaces are allowed next to signs =, >, <, >=, <=, or :. These signs as well as Tag and string or 
number or word may be located on separate lines. 

• If a Tag created contains characters = or < or > or : then use double quotes to search for such a tag, for example, 
"<Tag>"="string ". 

• substring in rows 2 and 4 may not contain characters < > = :. 
• To search for a substring that may be interpreted as a number, for example, 1.23e5, use Tag==1.12e5 or 

Tag=="1.12e5" instead of Tag=1.12e5 
• To reverse the meaning of constraints 1–2 (that is, change to “spectra must not have”), insert caret (^) in front of 

the "Tag" or substring 
• To reverse the meaning of constraints 3–8 (that is, change to “spectra must not have”), insert caret (^) in front of 

the right-hand side expression. 
• To use caret (^) as the first character of a substring enter Tag == "^substring". 
• In 3-8, Tag may be replaced with Tag? In this case the spectrum is accepted not only if the condition(s), described 

in the above table are satisfied but also if Tag is missing.  
 

Example of a multi-item constraint: The following items 

Replicate   - Line 2, substring 
RT >= 11.2   - Line 8a, number is greater or equal 
Sample = "yeast_Nature_CAM" - Line 3a, Tag=”string” 
Datfile = 011599.dat  - Line 4, Tag=substring 

 

fit the following “Comment” field: 

Replicate RT=11.220m Sample="yeast_Nature_CAM" Datfile="F011599.dat" 
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More formal description of reversed constraints 
 Item Comments of the output spectra must have 

1a ^"Tag" Exactly this Tag is not present in the comment 

1b ~"Tag" Some of the tags are not exactly this Tag 

2a ^substring this substring is not anywhere in the comment 

2b ~substring this substring is not anywhere in the comment 

3a ^Tag="string" all tags but this Tag have exactly this string 

3b ~Tag="string" some tags but not this Tag have exactly this string 

3c ^Tag=^"string" all tags but this Tag haven’t exactly this string 

3d ~Tag=^"string" some tags but not this Tag haven’t exactly this string 

3e Tag=^"string" this Tag has no string or its string differs from string 

3f Tag=^"" this Tag has a non-empty string 

3g all=^"string" Each of the tagged strings has not exactly this string 

3h Some="string" some tagged strings have exactly this string 

 

Items 4–8 from the previous section (1.2.2) may be given reversed meaning in the same way as 3a–3f. 

Reserved expression all= is same as  ^""=  and  ^= 
Reserved expression some= is same as  ~""=  and  ~= 

To address a tag named all or some put it in quotes, for example: 
 "all"=string  "some"=string 

Quoting tags allows searching for exact combination of tags, for example 
“Single Tryptic_simple Parent”=358.07   or “Charge=2 Scan”=82 

Tag?=^whatever  is considered found if either Tag=^whatever has been found or Tag is not present. 
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Tags in Comment Constraint for MS/MS Text Information  
Text information displayed for NIST 26 MS/MS Library mass spectra has special tagged text fields, for example: 

MSn pathway: [M+H-H2O]+=>311.4 
Precursor type: [311.4]+ 
Spectrum type: MS3 
Precursor m/z: 375.2894, 311.4 
Instrument type: IT/ion trap 
Instrument: Thermo Finnigan Elite Orbitrap 
Sample inlet: direct flow injection 
Ionization: ESI 
Collision gas: He 
Collision energy: 35% 
Ion mode: P 
NOTES: Consensus spectrum; Acetonitrile/Water/Formic acid; Vial_ID=1741 
InChIKey: KXGVEGMKQFWNSR-UHFFFAOYSA-N 

Beginning with NIST MS Search Program v.2.2, Tags in Comment Constraint allows searching of these tagged fields. 
Special tags are to be used for this purpose.  
To enter such a special tag, type dollar sign ($) immediately followed by the tag displayed in the spectrum text 
information, omitting spaces. Slashes, dashes, underscores in the tag may be omitted or added. Tags differing only in 
CAS, CAS#, or CASNO at the end of the tag are equivalent. The special tag and search string are not case sensitive. 

The syntax is almost the same as the one described above for Tags in Comment Constraint. 
Below are several examples. 

To search for Enter into the Tags in Comment Constraint 

precursor m/z in range* 374.9–375.4 $Precursor_m/z=374.9:375.4 

Instrument type containing word IT $Instrument_type:IT 

the exact Instrument name $Instrument="Micromass quattro" 

spectra that have any Related CAS# entry $Related_CAS 

spectra that have no Collision energy entry ^$CollisionEnergy 

* NOTE: MS3 spectrum with text information “Precursor m/z: 375.2894, 311.4” also will be found. That is, for MSn (n>2) 
spectra, the first precursor m/z (corresponding to MS2) will be found. 

List of all acceptable special tags 
$aux 
$charge 
$collision_energy 
$collision_gas 
$compound_type 
$cone_voltage 
$inchikey 
$in-source_voltage 
$instrument 
$instrument_type 
$ion_formula 

$ion_mode 
$ion_mw 
$ion_name 
$ionization 
$known_impurity 
$mass_range 
$maximum_intensity 
$msn_pathway 
$notes 
$peptide_mods 
$peptide_sequence 

$precursor_m/z 
$precursor_type 
$pressure 
$related_cas# 
$retention_index 
$ri 
$salt 
$salt/mix_cas# 
$sample_inlet 
$special_fragmentation 
$spectrum_type 

Special tags inside parentheses are considered identical:  
($aux  $notes)  ($in-source_voltage  $cone_voltage)  ($retention_index  $ri) 

Some of these tags may be found in other NIST 26 EI Libraries, for example, $related_cas#, $inchikey.  
See also MS Search Help topic “Spectrum Text Information”. 
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MS/MS Instrument Type Constraint 
This feature will only work with MS/MS Libraries created using NIST 23, or later, or similarly formatted user libraries. 

It affects only MS/MS spectra (that is, spectra which have precursor m/z value); therefore, it ignores all EI spectra, 
which means applying this constraint to a search of the EI Library does not affect the Hit List. 

This constraint has seven options (checkboxes) that may be combined to produce a Hit List containing such spectra 
that each spectrum fits one of the selected Instrument Types.  

The “Instrument type” field in a MS/MS mass spectrum text information is interpreted in the following way: 

Instrument type checkbox “Instrument type” field in MS/MS mass spectrum  

Ion Trap “IT/ion trap” or “QQIT” or “QqLIT” 

Q-TOF “Q-TOF” 

Ion Trap + FT “IT-FT/ion trap with FTMS” 

HCD “HCD” 

Triple quadrupole “QqQ” 

Other any other than the above five instrument types 

Unspecified No instrument type specified 

 

Selecting all seven would select all mass spectra (the same as if the constraint is disabled). 
The version of Lib2NIST included in NIST 23 or a later version is needed to produce such a library because the 
instrument type is saved in the NIST 23 Tandem mass spectrum record as a new binary field; therefore, this constraint 
would not work with the NIST 08 Tandem Library or even the NIST Peptide Libraries created with the previous 
version of Lib2NIST.  
In the case of NIST 11 or NIST 12 MS/MS libraries, Q-TOF checkbox would work as Q-TOF and HCD checkboxes 
selected together, HCD and Ion Trap + FT would not find any spectra although 737 HCD spectra are present in each 
of NIST 11 and NIST 12 MS/MS library. However, HCD spectra in these libraries may be found by entering Tags in 
Comment constraint $Instrument_type=HCD or Name Fragment constraint $:06HCD 
See Read Me Lib2NIST (Lib2NIST.TXT or Readme_Lib2NIST.txt) for more details on rebuilding MS/MS library. 
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APPENDIX 7: Contributing EI Mass Spectra to the 
NIST/EPA/NIH Mass Spectral Library 
Users of the NIST MS Search Program are invited to submit mass spectra for inclusion in the NIST/EPA/NIH Mass 
Spectral Library. Descriptions of both ideal and minimum acceptable data are provided below. Please provide data 
that is as close to the ideal as convenient. 

Characteristic Ideal Minimum Acceptable 

Substance Pure compounds (single GC component) of 
confidently known structure that are 
commercially important occur in the 
environment, or are a natural product 
(including analytically useful derivatives) 

Any single chemical compound whose 
identity is confidently known 

Method Acquired by GC/MS at an ionization energy 
of 70 eV under conditions such that isotope 
ratios are not distorted and ions above the 
molecular ion are absent and processed 
using AMDIS or other deconvolution 
software 

Acquired at an electron ionization of not 
less than 20 eV under conditions such 
that isotope ratios are not grossly 
distorted and significant ions above the 
molecular ion are absent; significant 
background subtracted 

Requested Information: 

Contributor Contributor’s name and/or institution (as it is 
to appear with the spectrum) 

Contributor’s name and/or institution (as 
it is to appear with the spectrum) 

Chemical name  Chemical name (preferably in Chemical 
Abstracts or IUPAC format) 

Chemical name (or structure) 

Chemical Abstracts 
Registry Number 

Chemical Abstracts Registry Number - 

Chemical structure Chemical structure (in MOL/SDF file format) Chemical structure (or name) 

Synonyms Alternative names (trade names, trivial 
names, etc. 

- 

Mass spectrum Mass spectrum (unit m/z resolution or 
better) with all observed nominal masses 
from no higher than m/z 12 to above the 
molecular ion with intensities of 0.1 % or 
greater and intensity in electronic format 
(preferably as an NIST/EPA/NIH user 
library). Ions at half-mass should be kept in 
the spectrum and rounded down to the 
nearest mass. 

Mass spectrum (unit mass resolution) 
with all observed nominal masses 
beginning no higher than one-third the 
molecular mass to above the molecular 
ion with intensities of 2.0%. Ions at half-
mass should be kept in the spectrum 
and rounded down to the nearest mass. 

Instrument type Instrument type (magnetic sector, linear 
quadrupole, TOF, etc.) 

Instrument type (magnetic sector, linear 
quadrupole, TOF, etc.) 

Instrument model Instrument manufacturer and model name - 

Ion source temperature Ion source temperature (°C) - 

Inlet Inlet (GC, probe, etc.) and inlet temperature 
(of probe, reservoir, etc.) 

- 

Retention index Kováts Retention Index (with the 
commercial name of the GC phase or, if not 
available, whether the phase is polar or non-
polar) 

- 

Impurities Note masses not belonging to the 
compound and their origin, if known. 

Note masses not belonging to the 
compound, if known. 
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APPENDIX 8: Support Contacts 
In our continuing commitment to quality, the NIST Mass Spectrometry Data Center is always looking to improve the 
quality of our Mass Spectral Libraries and programs for accessing them. Comments or questions about the quality of 
either or other Standard Reference Databases available from the NIST Standard Reference Data Program should be 
made by contacting: 

 
Mass Spectrometry Data Center 
Biomolecular Measurement Division 645.04 
National Institute of Standards and Technology 
100 Bureau Drive, Mail Stop 8362 
Gaithersburg, MD 20899 
email: massspec@nist.gov 
website: https://chemdata.nist.gov/ 

 

NIST provides updates and enhancements to the NIST Mass Spectral Search 
Program, MS Interpreter and AMDIS. They can be downloaded from 
https://chemdata.nist.gov/  
 

https://chemdata.nist.gov/
https://chemdata.nist.gov/
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